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I have noticed that there are several accounts whose friendlists appear “hidden,” I asked them if they have any possibility to toggle it on/off anywhere in settings yet there is no option for it. This majorly affected individuals based in the United Kingdom from what I have gathered. [I have also tried disabling all extensions, checked on mobile browser
etc., this is hidden for everyone on any device] Thank you in advance! 7 Likes I looked through some stuff and this seems to be intentional? MustHideConnections feature that’s enabled for everyone in the UK Returns “Granted” for users without friends lists extraParameters is just encoded base64 vs a user with a friends list returns “Denied”
“Granted”: Roblox KILLA Twofacee is one of the millions creating and exploring the endless possibilities of Roblox. Join KILLA Twofacee on Roblox and explore together!Follow to join me v Buy my ugc: /store ... Roblox zlaitor is one of the millions creating and exploring the endless possibilities of Roblox. Join zlaitor on Roblox and explore together!hi
im vivi 5 Likes great, yet another update to make moderating games harder. good luck finding exploiter affiliates out there, devs... not that you should be looking for exploiter affiliates on someone’s friends list, but you can still use the api to get a list of friends 1 Like It would be nice for this post to be acknowledged and/or explained, as now I'm
wondering why I'm unable to see the friends of my friends and why I have been forced into having a hidden friend list? 1 Like I recently noticed if you block someone, the other party no longer is able to view your friendslist at all and looking up gives a “No Results Found” error. I also heard that it gets hidden for random users too Also this bug report
has been closed so it won’t be acknowledged probably 3 Likes Wouldn’t that be against the point? Unless they are only trying to prevent public visibility but still give access to APIs This is most likely the UK Online Safety Act: Children are not visible in other users’ connection lists; Children’s connection lists are not visible to other users; Instead of
just hiding x user, it hides them all as it makes it obvs what user is under 13 1 Like I asked support about this and it is indeed to do with laws + privacy requirements. Now I am wondering if these will ever come out as settings for all users, because they gave me steps on settings that do not exist? (¥*Unless these settings are exclusive to users in the
United Kingdom.) (this was before I told them I do not see the settings, which led to the first image attached) 1 Like Floo d: The Roblox support agent might be accidentally leaking a oncoming feature... the “Friends & Contacts” tab is really empty at the moment so it would make sense if it gets added there: /privacy/FriendsAndContacts Either way
this bug might be intended according to Roblox Support and this bug report has been closed 1 Like Last year at RDC, we announced an ambitious project to power the creation of immersive 3D objects and scenes in Roblox. Today, we are excited to launch Cube 3D, a 1.8B parameter foundation model for 3D creation trained on 1.5M 3D assets—
including the beta of its first capability, text-to-3D mesh generation, also known as the Mesh Generation API. Roblox Cube, our core generative Al system, will underpin many of the Al tools we will develop in the years to come, including scene-generation tools in the future. Learn more about the technical details of our model (GitHub) (Technical
Report). Expanding Creative Possibilities with 3D Generation Since launching Assistant to everyone using Studio, we’ve seen creators make experiences more efficiently with personalized help, script and texture generation, and more — and now, we’re ready to take things a step further with 3D generation. Using our Cube 3D model, we’re providing
you new tools to make 3D creation more efficient. Think of generative Al as your copilot helping you iterate prototypes and concept art or props quickly, so you can focus on the creative, meaningful side of world-building. The creative decisions are always yours; generative Al is simply there when you want it. Beyond aiding your creation, our mesh
generation API also lets your users create personalized items in-experience in real time, unlocking higher engagement. In feedback sessions with creators, some of the novel use cases shared include the ability for a user to customize a room in their own style, or allowing a user to generate a custom reward at the end of a quest. In-experience
generative Al opens the door to a new wave of creativity for millions of Roblox users, making gameplay even more personalized and interactive. Currently, there are two ways to leverage 3D generation: In Experience APIs: In experiences where the Mesh Generation API is enabled, users can quickly generate unique in-experience items and props with
a simple text prompt. For example, they can describe objects like “brown leather moto jacket” and see it come to life. Assistant in Studio: With Assistant in Studio, you can easily create a mesh and texture object in seconds with the “/generate” prompt. For example, if you are building a race track scene, you could type “/generate a motorcycle” and
have the object created in seconds and ready to be placed into an experience. The Mesh Generation API can take text input and generate single 3D mesh and texture objects. You and your users can bring to life 3D objects in seconds with just a few text prompts. The demo below illustrates how you can allow your users to generate a single object like
pink sunglasses within an experience: /secure-uploads/uploads/original/5X/2/1/0/b/210b0fa53c3e43de832e724c38569d9cb112a61d.mp4 We built this Cube 3D Play Experience for you to test out generative creation. In this experience, all the assets except the buildings are built using Cube 3D. We also created a Mesh Generation Template for creators
as a reference API implementation. You can go to experience details and click on the “...” to edit it in Studio. How to Enable the Mesh Generation API For the full API documentation, please make sure to explore the docs here: Mesh Generation API | Documentation - Roblox Creator Hub Enabling Mesh Generation API in-experience: To enable this
feature you need to enable Editable Mesh / Editable Image APIs by going to Studio File > Game Settings > Security and selecting the following: Enabling Mesh Generation API for Assistant in Studio: Important Safety Measures We facilitate creation with safety at the forefront. All 3D generated outputs are proactively moderated by Roblox’s Al safety
systems to ensure the content complies with our Community Standards. Our safety tools can surface any policy violations quickly and help determine what is safe and appropriate to publish in an experience. For 3D object generation in experiences, developers will not be held responsible for potentially violative output if they have not actively
attempted to violate our policies, which includes keeping output visible only to the user that generated it. When using Assistant, creators remain responsible for all of their creations, including 3D generated output, and how they are used in their experience. To avoid consequences for violating Roblox’s policies, creators should ensure all experience
components align with our Community Standards. Open-Sourcing the Cube 3D Foundational Model We’re open-sourcing Cube 3D for research and academic usage so anyone in the industry can experiment, fine-tune or train it on their own data to suit their needs. We are making the model weights and inference code available under an OpenRAIL
license. This resource is accessible outside of Roblox through GitHub / Hugging Face. What’s Next Later this year, Cube 3D will not only take inputs from text, but also images. It will also extend to scene generation and understanding, going beyond placing objects into a scene to understanding the context and relationships between objects. With this
understanding of objects and scenes, we’ll be able to serve users the experiences they’re most interested in and augment scenes by adding objects in context that is consistent with the rest of the scene. For example, in an experience with a forest scene, you could ask to replace all the lush green leaves on the trees with fall foliage to indicate the
season changing. These generative tools react to your requests, helping you rapidly create, adapt, and scale your experiences. Share Your Feedback We’re excited to see what you and your users create using this beta for the Mesh Generation API. We expect the output of the Cube 3D model to get better over time as we continually work to improve
output quality and add more ways to control mesh resolution. Please use this form to share your planned generative Al use cases, which additional features you’d find most beneficial, and any additional thoughts that could help shape the future of 3D generation. Your feedback will directly contribute to refining and enhancing our models. FAQs
Currently, assets generated in-experience do not persist outside of the experience, are not added to a user’s inventory and will not be listed in Marketplace. However, assets generated in Studio via Assistant are added to a creator’s inventory and accessible via Studio’s Toolbox. We expect the Cube 3D model capabilities to improve over time; however,
at launch there are some limitations we want to acknowledge as follows: Developers and their users will only be able to generate single objects. We are working on making both part and scene generation available next. The object scale will require user manipulation to get to the desired size. There is no cost. However, during this beta release, each
experience is currently limited to 5 generations per minute. When this limit is reached, an error message that the developer can customize will be returned to the user. As we get started during the beta, the usage limits are low. In the future, this rate limit will be adjusted to account for concurrent users. The model for 3D generation is trained on
1.5M 3D assets that utilize a combination of licensed and publicly available datasets, as well as the free data assets that are available in our Creator Store. It does not include experience data. We have a responsibility to build tools that reduce the barrier to creation while also respecting the intellectual property rights of all creators. The creator data
used to train the Cube 3D model is part of our Al data sharing program, which allows creators to control their preferences with respect to how their data is used. We also implement output filters to reduce the likelihood that Cube 3D generates content that is similar to copyrighted works. Finally, Rights Manager allows creators to report content they
believe is copyright infringing and file a removal request. We are continually refining our approach to minimize any IP-infringing content that may be generated from our Al models. At Roblox we aim to provide artists and content creators with new tools that expand and augment their capabilities. For example, the mesh generation tools introduced
today may help creators rapidly iterate on ideas and explore more concepts (i.e., generate initial versions of assets for concepting and ideation) or quickly populate experiences with set dressing or background objects, allowing them to focus their skillset on creating the most important assets for their experiences. We also believe in using Al tools to
expand access to a wider community of potential creators that have unique ideas for experiences to create and stories to tell. Overall, we believe Al-based tools will provide new opportunities for both novice creators and highly skilled artists to focus on their creative vision. The unique perspective, storytelling ability, and sense of aesthetics of our
creators are essential for crafting the most compelling and engaging content on the Roblox platform. 165 Likes This topic was automatically opened after 10 minutes. You will use the Al and you will be happy about it. Open-sourcing it is a good step in the right direction though, how powerful of a rig do I need to run the model locally? 40 Likes
Continuing the discussion from [Beta] Cube 3D Generation Tools and APIs for Creators: Karun: currently limited to 5 generations per minute. HOW? Where are the resources for this coming from?! I'm genuinely Impressed by how this is free. 40 Likes I don’t think 3d artists have to worry given the current quality of generated models. Still impressive
though. Very cool. 46 Likes Karun: However, during this beta release, each experience is currently limited to 5 generations per minute. This is INSANE. When texture/image generation was introduced, it was limited to like 5 uses a month. Isn’t this going to be expensive for Roblox in the long term? 17 Likes That update seems interesting. I am a solo
developer and not a 3D modeler and I will largely benefict from a such feature for small things. Like, let’s say, you want to add some details in your game and add junk: use this and you’ll get a sufficently good mesh. Otherwisely, is it necessary to upload the mesh? I didn’t see it being mentioned in this topic. Anyway, that’s a very interesting project. I
will try generating a shape and show the result in some time. EDIT: Karun: To enable this feature you need to enable Editable Mesh / Editable Image APIs by going to Studio File > Game Settings > Security and selecting the following: Aww, come on! This is somewhat blocked behind ID verification. EDIT 2: Look at my more recent answer. Not that
good infact. 8 Likes With all this push for Al, are you going to be making sure all this AI content is properly labeled? If not, Spain would like a strong word 54 Likes Karun: However, assets generated in Studio via Assistant are added to a creator’s inventory and accessible via Studio’s Toolbox. Are these assets added to your inventory automatically? If
so, will your account be moderated for it? 10 Likes The mesh quality and consistency is surprising! It would be nice if the texture quality was improved as it can hide bad geometry sometimes, and it is what kind of breaks the final result at the moment. For simple objects this works neat! For complex objects it is limited by the 10k triangle limit /mesh
(I assume) and the fact that the whole object needs to be 1 mesh 6 Likes crazyInsaneEven11111: Are these assets added to your inventory automatically? Karun: Currently, assets generated in-experience do not persist outside of the experience, are not added to a user’s inventory and will not be listed in Marketplace. However, assets generated in
Studio via Assistant are added to a creator’s inventory and accessible via Studio’s Toolbox. Just quoting it for you. It shouldn’t automatically upload it, it will stay in the experience and will probably generate a uploading prompt when you publish your experience. 4 Likes It’s not too bad mesh wise, but the textures are definitely not decent... good start,
though I don’t know of a [good] use for it... Prompts were: “Realistic police challenger”, “easter bunny with a basket of chocolate”, “police officer”, & “realistic oak tree” Bonus Edit: tried “titanic” & “spongebob”: why does spongebob have a belly button... 45 Likes Not even 15 prompts in and it’s giving me a sonic the hedgehog mesh slightly squished,
despite that not being even remotely close what I asked for... 27 Likes personally i think there’s better features to spend development time on but oh well 50 Likes Amazing use of ai for development!! Keep on doing these! Also, please work on moderation though. there are a lot of better things you can add like gpu access, Ui blur, motion blur etc.
Please make ROBLOX better 4 Likes If Al ends up being the future other engines will have to catch up with Roblox, they are really betting on this 2 Likes As an artist, I feel some such way about this feature; regardless, this is incredible, and the fact it can create textures as well is amazing. I am not sure about the application of this API, but it is very
cool! Hopefully the generation limit is increased as time goes on. 4 Likes Very interesting, I've generated some basic shapes such as swords and planes and the mesh looked decent. But the texturing needs to be worked on. I am excited to see how this turns out after a few years. (for some controversy) I fully support Roblox stepping into AI and
innovating. Many people seem to whine about Al, but remember that you can use this in your projects for free, from Roblox. Why not take advantage of it? Once textures are fully figured out, with more customization and accuracy, I believe this will become a go-to for many developers. I will always commission experienced devs because Al won’t
replace their quality, but this is a massive deal for many developers who don’t mind. I am very happy with how Roblox has been going recently, massive updates for developers, and as an active developer on the platform I am very happy to see these changes. 6 Likes I think this Al model is way too overfitted to certain types of data. I prompted it to
create a “Dragon head”, and it gave me a near 1:1 copy of Roblox’s classic dragon heads. Al output: The items it nearly 1:1 cloned: Roblox Customize your avatar with the Brinsop of the Black Heart and millions of other items. Mix & match this hat with other items to create an avatar that is unique to you! Roblox Customize your avatar with the
Chrysophylax and millions of other items. Mix & match this hat with other items to create an avatar that is unique to you! Roblox Customize your avatar with the Aer Draco and millions of other items. Mix & match this hat with other items to create an avatar that is unique to you! Roblox Customize your avatar with the Smaug and millions of other
items. Mix & match this hat with other items to create an avatar that is unique to you! 12 Likes Wonderful 12 Likes Page 2 the moderation seems to be a bit goofy? I was testing out generating animals and noticed they were at 10K triangles minimum so I wanted to get it to make a low poly and apparently that is against . Turns out doing “/generate
pig” fails but doing “/generate a pig” works fine. This seems to have gone crazy now I can hardly generate anything without it saying it is a violation 8 Likes Uhm, it might be a bit too easy to bypass IP. When you for example type speedy blue hedgehog, it works. The model might need some fine tuning 24 Likes arxy: image296x552 49.3 KB Wh... it
generated nearly the exact same sword for me. 7 Likes Our cat models are almost the same 1:1 replica, very creative 8 Likes Wtf? so does it just generate the same models for everyone or something? That’s crazy 3 Likes I'll be very honest and open with my opinion here. Usually I am not into the Al related stuff, especially since most of them only
seem to be made to attract more share holders, which I understand (I have no huge problem with that since it doesn’t directly affect me in a bad way). But this is impressive and considering the fact that using this tool is completely free breaks my mind. I want to thank the team who worked on this huge tool, I will definitely use this. I also don’t think
there is any other platform or engine which has a free to use api that generates objects. Edit: After some rough testing, none and I mean really none of the Ai generated meshes where good enough to be used for something. There is always some weird error occurring with the models it generates: Not following prompt, missing textures, very low
quality, very weird looking mesh. In general it just looks like made by Ai 100% of the time. Welp I take back what I previously said 3 Likes So excited for the future of slop on the platform! This is certainly a great change to promote low quality, rushed, and soulless content! Hey at least the bottom line will improve with literal babies being able to
generate full games in the near-ish future. “Jokes” aside, it would be nice if you guys spent a fraction of the effort you are putting into Al features into other parts of the platform, like making Studio not constantly bug out, crash, etc. Or releasing genre sorting in a reasonable timeframe. Or properly moderating UGC. The technology is impressive, but
that’s all the good things I have to say about it. 38 Likes This is a nice feature and all of that but aren’t there other things to be spending your time working on apart from Al driven things? To me it seems like many of the things in the other posts would be receiving much more positive feedback if they were made into a real thing in studio than things
like this. This is basically another feature that nobody will be using on Roblox as it seems really unoptimized and really just unusable in a real game. I'll use Doors and Pressure as an example since they both have the same “Roblox” or “Low Poly” style in them. Bigger game developers like this aren’t going to use stuff like this at all for their games as
opposed to something like higher range on lights or lighting upgrades or possibly things like Sky updates / QOL changes. (I don’t know how things work at Roblox over there but personally I would prioritize stuff like this as it’ll receive much more positive feedback from the developers who make this platforms popularity possible.) You would think that
they’d be prioritizing stuff like this already but unfortunately that isn’t the case as 3D bad mesh optimization tools release before stuff like this. Adding onto this actually if instead of working on stuff like this they worked on figuring out a way to upgrade their engine entirely and finish making things like Volumetric clouds, Dynamic Skies, Better
particle systems, Possibly volumetric fog or something like that, larger range of lights, and possibly even light bouncing I bet they’d have already figured out a way to do at least 1 of these things even if it’s in Beta still and not officially released. (Short Version): AI Mesh generator really bad optimization came before other better features that bigger
developers would actually use in their games that make this platform possible. Really unfortunate. 6 Likes Can’t get enough of that sweet, sweet Al garbage. “High fidelity kokiri emerald from ocarina of time” was the prompt and it made me an emerald stewie Edit: tried another one. The prompt was “spaceship with wings and four rear-mounted

was all the feedback given over all the recent announcements just discarded without any mention??? 9 Likes +1 While I'm not against Al being used as a tool to speed up minimal processes in your workflow, the way this is promoted incentivizes the idea that you don’t need proficiency or even an attempt at certain skills to make a complete game, even
if it isn’t the initial goal, it undoubtedly will end up promoting laziness 22 Likes this is what the engineers have been doing instead of adding texture filtering to meshparts, want pixelated meshparts? TOO BAD. WELCOME OUR 9999TH NEW AI TOOL THAT NEEDS UR ID FOR GOD’S SAKE! 17 Likes I'd love to like a new Studio addition. I really,
really don’t like this. It sucks the creativity and process out of making something, and eliminates hard work in turn for a quick and dirty result and eliminates another step in learning something along the way. It's promoting laziness and eliminating creativity and boiling it down to a text prompt. What ROBLOX needs is more things curated to modern
technologies that aren’t AI. Something new for people to play with that isn’t hinging on Al technology barely presentable in its current state from how early on it is. No Al. No prompts. Look at other game engines, other games, anything. Shaders, visual effects, filters, just something new to play with. Texture artists and 3D modellers have been
begging for base features to be incorporated into existing technology to no avail, leading to dozens of workarounds for features like EmissiveMaps and transparent MaterialVariants. The overhauls to ParticleSystems and more additions to SurfaceAppearance tinting was a step in the right direction, giving more tools to artists to figure out how to use
them and translate their ideas into ROBLOX more seamlessly, even small. People aren’t going to use this as concepting, and will only be using this to fill in for real skill using Blender, for example. There’s hundreds of free tools and tutorials showing you complex and simple ways to work around not having money or little knowledge of a program.
Please promote creativity instead of a means to an end. I sound like a broken record for these things, but my frustrations stem deep into the program. I'm for innovation. Not for Al generation. 28 Likes If this unironically requires an ID im gonna crash out right here on the spot 7 Likes so weird and strict... Mesh Texture Pixel Art cant have a good
pixel gun remake on roblox so might aswell make the 9999th ai feature 4 Likes this option can only be enabled by people who are id verified your welcome 5 Likes That’s my biggest worry. If the Al makes something tos violating, are we blamed for that? 5 Likes Broken Spawn: If this unironically requires an ID im gonna crash out right here on the
spot Fun fact: It does. Look at my older reply: Vikko151: karunamat9ta: To enable this feature you need to enable Editable Mesh / Editable Image APIs by going to Studio File > Game Settings > Security and selecting the following: Aww, come on! This is somewhat blocked behind ID verification. That was so obvious... 4 Likes Page 3 I feel like the
only games that will make any real use of this are the ones that were already low effort cash grab slop that were already using Al “art” in their dev product popups Though I'm biased against gen Al stuff so ig that’s just me 9 Likes Am i part of the Cat Gang too? 6 Likes Nobody is going to remember this thing exists in a week, we have bigger issues
with ID verification. This is not one of them. 4 Likes no clue why it marked my previous post as a reply, probably was gonna say somthing else to the person i replied to and forgot anyways, don’t think that’s how a hand works... 2 Likes I am mourning the tens upon tens of thousands of engineering hours that were completely wasted on designing and
creating this thing when those hours could have been spent on literally anything useful. Think of all the awesome anything we could have gotten in its place. Think of all the anything. 39 Likes super good point here, texture interpolation is really needed in this environment where Roblox automatically compresses any textures it has funnels into it
alongside the fact it mutilates any pixel art at a higher resolution when it could just be fixed with a button 4 Likes Who locks a feature meant to help a mass amount of developers behind an ID? I wasn’t even gonna comment because I would probably actually use this feature once in a while, but there always has to be a dumb as hell ID block for every
feature that’s useful to developers. What encourages you to spend time making ts??? I could probably go online right now and search “mesh generator free” and do the same damn thing. All you're doing with this is inconveniencing developers that want to use this directly from studio while simultaneously limiting who can even use the feature
significantly. Waste of resources. What even is your goal? What are you trying to gain from creating this? More people who verify using their ID? I don’t even expect a response at this point with how the recent announcements have been going but this feature 100% does not need to be locked behind an ID. 3 Likes prompt: frog 5 Likes Bringing Studio
and the client to Linux is a waste of time and resources but this isn’t 12 Likes You honestly don’t even need to spend 10 seconds on the UGC Accessories tab before finding a rug with a woman wearing a shirt with her breasts showing. No like really you can quite literally just go on accessories and see. THIS was approved by moderation. There’s no
way something like this could even be bypassed when the thumbnail LITERALLY shows it. (This is censored by the way). Just goes to show how bad UGC moderation really is yet they’'re over here spending their time creating Al generation. 12 Likes no admin will answer the prayer of having texture filtering so have fun asking for it btw 1 Like i've
already prayed to the developers for emissivemaps long enough i can’t take another hit 3 Likes Mesh generator before even the basic conventional ability to view the triangle count of a singular Mesh FYI 5 Likes Correct, but I highly doubt that this is the last we’ll ever see of the AI Generation features on this platform. I'm guessing next we’ll have Al-
Generated object placing as shown a few years ago which I'm surprised hasn’t even been added yet. 4 Likes Karun: This resource is accessible outside of Roblox through GitHub / Hugging Face . Adding on to my last reply, keep in mind this is accessible for free outside of Roblox (and I think open-sourced), so 99% sure they’re PURPOSEFULLY
inconveniencing people who want to use it directly from Roblox without ID verification. 1 Like Im predicting that the answer is indeed yes, looking at past examples of features that automatically upload assets under your name... will the moderation robots spare us if its Al generated you wouldn’t remove your own kind would you guys 2 Likes No
thanks, we don’t really need it. i will never forget what they took from us 24 Likes middle aged men somewhere in the united states thinking “money well spent” as they see more “Al” plastered all over the new roblox features 13 Likes new update: ai anims oh hell nah i gave them an idea 2 Likes Page 4 so amazing btw 4 Likes the bottom of this
unicorn looks so disturbing 2 Likes kostis: the bottom of this unicorn looks so disturbing Because Lamarr the headcrab and unicorn both got a r in them, so Roblox decided to put them together. Just kidding, those are the average errors of use of Al in creativity: well, at least it creates problems! since we’re all sharing characters: I'll take creepy
copyrighted characters with no clothes on and/or messed up whatever you want to call them for 500 Alex. for the record, cinderella has her rear showing under the dress [without texture of course, but still] [and the other half of her arm is attached to her leqg...] 8 Likes Broken Spawn: kalet14: This is a nice feature and all of that but aren’t there other
things to be spending your time working on apart from AI driven things? This is all I want to know. Why was all the feedback given over all the recent announcements just discarded without any mention??? Different teams work at Roblox—different individuals and different jobs. The Research article Roblox put out linked by the OP shows it’s by the
“Foundation Al Group at Roblox.” It’s their whole job to work on Al-generated software and whatnot. The not taking in -or at least responding to- feedback is a different issue. It seems to be up to the individuals on how much feedback they take in and how they act upon that. Well, it might be based on their managers (PM) to an extent, but yeah. Edit:
just wanted to add that the OP has a history of actually replying to people to an extent from 2020 to 2023. I'd assume they’ve moved to different teams throughout the years. Also, the feedback for Al products though in opposition to the products being worked on- they’re not going to be listened to. The development of Al in a software company like
Roblox is there, and it’s growing. We can’t stop that. It’s a thing of if we don’t, someone else will. to an extent. There’s also the whole Metaverse vision -recently on the down-low- from the CEO which plays a role. 5 Likes Tried to mess with this a bit, and got a somewhat ok result: 1 Like On this, I feel like the whole ID verification thing is for legal
safety when using it on Roblox. Like COPPA laws and whatnot about collecting user data for certain ages. You’d be feeding their model -if using it on Roblox- by using it from what it looks like. That and trying to control the amount of users who use it. I guess someone could always make a plugin or something because it’s open source and go from
there. 2 Likes Spooky. some progress has been made, but this isn’t more convincing (to me, an end-user with zero technical knowledge on AI) than models that were being shown off over a year ago. The improvements to textures are neat but the topology is very obviously lacking in both visual quality and optimization. Many objects in the demo were
genuinely unsettling to look at or at the very least would be immersion breaking in any game. Releasing this now as a public beta seems premature at best. I'm all for lowering barriers of entry to making games, something roblox has been great for. But the utility/benefits promised here with Cube are still unproven and I worry about selling a toolset
like this especially to an audience of new developers. There are also concerns about Al and climate change. Could we ever expect information regarding the environmental impact of these tools? 1 Like I have multiple questions: Does this feature require ID verification? If so, why is roblox seemingly trying to obfuscate this information? Are they aware
of all the complaints behind the abundance of ID locked features? I swear they have been at least somewhat upfront with if a feature requires it or not, mentioning it somewhere on the update post How can roblox afford all these Al tools, and why aren’t they improving their platform instead? How come roblox is focusing on random Al features,
instead of just fixing the moderation system and optimizing the engine? (this is kinda the same as the previous one, but all the topbar and TextChatService hackery roblox has done is just stealing a big chunk of performance, which just sucks for low spec devices) I would love to have all those questions answered Reditect: On this, I feel like the whole
ID verification thing is for legal safety when using it on Roblox. Like COPPA laws and whatnot about collecting user data for certain ages. You’d be feeding their model -if using it on Roblox- by using it from what it looks like. Yet users can turn on data collection for games (and forced to have it for creator store scripts) without ID verification? Also,
doesn’t that only count for personalized information? 2 Likes Didn’t know that; good to know. To the 2nd thing, probably. I feel like it’d be extra work to require verification (maybe just one if-statement?), so there’s gotta be a reason. 1 Like Yea this definetely needs more work. 6 Likes what was the prompt to even come up with this were you trying to
generate a bloxidi toilet 2 Likes vintage toilet to be more exact. The fact that it did this is quite... Interesting 2 Likes The 3D models look really good, but the textures aren’t very high quality . 2 Likes Very much appreciate Roblox open-sourcing this, really hope Roblox continues in this direction! 1 Like It’s actually not that horrible I spoke too soon 7
Likes bloody hell this is the worst beta feature i’'ve ever seen, the fact you guys think that this visual representation of a migraine is even close to worthy of being released to the public is insane and really shows your priorities of putting ai garbage over literally anything else and i’m seriously disappointed it is 7am and my day is already ruined 15
Likes Well, this is a pretty good feature, but it definitely needs some additional years of training. It is not even close to being usable as it is now. 1 Like Page 5 This is amazing! I am so excited for the next APIs! Seems fun. I don’t really look at this as a serious competitor to 3D artists but I also don’t think it has to be. If you wanted perfection or high
quality then it’s always best to do it yourself, but tools like this which depend on a specially trained system are solid resources for indie developers on a low budget and cannot afford to hire a 3D artist for a few meshes, or for novice developers who don’t have the expertise, or developers that do not have the time to invest into learning another area of
development. Logically there’s not a lot of reason - potential IP infringement aside - to hate on this. It’s free to access, free to use commercially, doesn’t require a lot of time investment on your part, and it’s open source which allows other parties to reuse or even contribute to the tool. seems not really accurate, my first prompt was “bugatti bolide”
and it gave me a chiron and my second prompt was “koenigsegg jesko absolut” and it gave me the body of a chiron with a cursed texture 1 Like I appreciate the transparent sourcing of training data, but it’s hard to see how this technology won’t be detrimental to the platform in the long run. The stated goal is to achieve full-scene generation with
interactive, high-fidelity elements. My fear is that young creators will increasingly rely on this to interpret their creative vision and orchestrate their ideas. I see this as a transition to passive creation, where individual style falls by the wayside. When you start from a functionally complete output, you're faced with fewer decisions and opportunities to
learn & grow. I'd argue that it’s much better to encounter ambiguities in the creative process because it leads you to make meaningful and deliberate iterations. 6 Likes Finally. No more spending money hiring 3d artists who take 2 weeks making a project when I can just generate it within seconds. Taylor Swift. For some reason she has a beard. 1
Like The models aren’t “professional quality,” but, most developers and players won’t care. I'm just afraid that the generated assets will be considered “good enough” by many developers and they’ll move on to the rest of their experience without bothering to consult a human for cleanup. There are a lot of funny generations being posted in the
replies, but I'm sure that with some phrase tweaking and patience, you can get something usable. Spooce: My fear is that young creators will increasingly rely on this to interpret their creative vision and orchestrate their ideas. A much more succinct way to put it, yes. 1 Like I love this tech but please please please, make Al assisted creation on the
studio side first class! Every single new Al feature on Roblox is a complete start to finish black box with any sort of mid-phase user control bolted on as an afterthought, if it exists at all. We are developers. None of this Al tech works for us for real game dev applications right out of an untunable black box. Every step of the generation process should
be available for us to export and tweak and re-inject back into the generation pipeline. These textures are often simply atrocious, but there’s no first class way for us export them and adjust them. There’s even PBR generation in there somewhere, but this is not accessible to us! There are intermediate images or preview/seed images generated for
some things in Roblox’s Al pipelines, but there’s no way for us to use our own, or modify what Roblox generates to correct errors. This makes all of this tech unusably rigid and frustrating to use. Al assisted creation is the future of game dev moreso than entirely Al generated creation. With this model, Roblox has enough of a portfolio of Al tech to
satisfy. Let’s aim some of these engineers at making these demo technologies actually useful for gamedev. 9 Likes Person at the beach. 3 Likes 100% agree, it will become an unused tool because as of now the models it produces are clearly Al-made, which players don’t really like, and it doesn’t have the “cartoony” high contrast aesthetic that would
bring players that don’t mind Al either. I wonder when will focusing on Al backfire to all of the companies that try to push it as hard as they can just because it has “AI"”’ in it. 1 Like //devforum-uploads.s3.dualstack.us-east-2.amazonaws.com/uploads/original/5X/8/5/1/f/851fdc5b2e51625¢169c17639f8e3b6fecbh9db7b.mp4 A duck on wheels a bat
drinking cola a zombie with bat wings an icecream pizza an ice cream gun a glass spaceship a cat eating a burger (lol) a chicken eating a pizza this is a great tool when given reasonable prompts 9 Likes this ai is so cursed 3 Likes Roblox do you know that amount of editable meshes are limited to 7? I prompted it with “steak”. 0/10 13 Likes Aw man,
I've just been learning 3D modeling for over 5 years and I'm already being replaced! The robots are taking over!!! Hah, just kidding, I actually think this is super cool. The amount of work and steps taken behind this is quite impressive. They even went so far as to create a copyright detector AND open-source this Al model? I can respect that. Can I
train this thing with my own data to improve the overall generation quality for all the people that use it? I don’t intend to use it because I loooove 3D modeling things myself, but I like helping out where I can. Lowkey feeling a bit honored when something I create is deemed high quality enough that people want to use it. Neat stuff! Please don’t make
more sloppy simulator games, I want to see some cool things being made with this. 3 Likes Great tool! 7 Likes After so long i finally learned how to use blender so i can make Meshes and Models for my game, and now after all this time, i didnt need to learn this!! thanks to Al, it can make models FOR ME!!! ok no, sorry... i just dont know about this...
Even though Al can do alot, dosnt mean it has to be used. I dont want to see a game where its full of this stuff. Im starting to feel like Roblox is slowly turning into an Al Platform with many features on Roblox Studio that uses Al. Whats next... put some text in a box to create AI VFX in Studio...? or maybe Animations...? I see alot of “Powering with
Al”... no Imagination... Im not saying that AI shouldnt be used at all, but 3D models? im sorry but thats a no... 2 Likes Another example of sloppy AI moderation 4 Likes There’s a reason for Al generated imagery to look like that. Al generates images by utilizing noise, which is often a image that contains an even amount of dark and bright colors.
Because of the sharp contrast between dark and bright, all textures generated with Al will also have this property which can result in deep-fried or oversaturated imagery with very sharp or otherwise weird-looking colors. It is something almost every Al has and it is extremely hard to get around which is why all images need to be edited. If you
inspect individual noise channels on a AI generated image (red, green, blue) you will also notice weird compression artifacts that are even present in black and white images and noise patterns looking consistent across all color channels. 1 Like Page 6 Corpze TheDeadestOne: Please don’t make more sloppy simulator games, I want to see some cool
things being made with this. You know full well that this is exactly going to be the vast majority of how this is used. 6 Likes Interestingly, this was posted after 3 days because the official Roblox channel on YouTube shared it in both standard videos and shorts: When I reviewed the video, I initially thought it would be a promising resource, enhancing
ideas with high-quality models like what you see from other Als such as Meshy.ai. Analyzing the advertisement, the new feature is far away. Depending on the complexity of what you are looking for, the Al tries to reproduce adding textures, but the topology of the asset doesn’t look natural; It feels like a bunch of sculpted decimated geometries: I
understand that this Al has been training a lot based on models that creators like us made through projects and/or are accessible through Creator Store, but I feel like it is not perfect enough to use for experiences if it can’t provide models with good texture and optimized topology. Now, I'm saying this is all based on the advertisement. With this new
announcement, I can test in real-time and make my own prompts to generate models: I started creating prompts such as “Roblox Logo”, “Cybertruck”, “David Baszucki”, “Ferris Wheel” and most of them came with appearances that you can say it is 90% odd, bizarre, creepy and 10% is not what you are looking for and it will end up failing to process
due to moderation, leaving it to be grey: Fun fact, the feature will provide the same creation if you use the same prompt instead of creating a variant or at least, another type of mesh with texture. That said if I were to use the same prompt from @IGOBOOM123, I would have the same results: Overall, it is sadly not powerful enough... It consists of
having bad creations that will most likely end up being a joke under social media posts such as in Reddit communities. 4 Likes i like this feature but are we seriously locking it behind id verification (on roblox) when it’s open sourced :1 Definitely... like emission maps for SurfaceAppearance! 1 Like It is not easier to just create a meshpart editor?? 1
Like This is an incredible feature that will surely change how Roblox game development is done. all the ai tools are amazing but they need to be improved for the tiny details for it to be usable Don’t worry 3d modellers, y’all are safe (for now). Anyway - with no disrespect to anyone specifically, just the feature - this is overall not a good thing to be
made public and a complete disrespect to 3d modelers in my opinion. Resources should’ve been used elsewhere given the engine’s current state. You (Roblox as a whole) should be encouraging people to create things for themselves instead of generating Al slop and slapping “game asset” onto it. At the end of the day, who is even benefitting from
this? Al is not the answer to everything. Certainly not for game assets. 34 Likes I prompted “Vikko151” and it gave me this as a result: Face reveal I guess. BONUS: Here’s the result with something of copyrighted: TF2 scout 2 Likes This is probably where half of the Roblox budget is being spent. Instead of giving us useful features that have we been
long waiting for. Such as the comment above Instead, you're going to give us some Al tool That may or may not rip the company apart 13 Likes cody: complete disrespect to 3d modelers in my opinion. I appreciate your opinion, but nobody asked. This is meant for users who don’t have experience. Let’s keep our comments non-biased. 5 Likes By your
logic, No one asked if you asked. 5 Likes Nintendo would like to know your current location. 2 Likes Aight I just got some questions: Why is roblox suddenly obfuscating the ID verification part? Are they aware of the complaints and just trying to hide mentions of it now? In the past, im pretty sure they have always declared that somewhere on the
update post Why is roblox not optimizing and further improving their platform? Stuff like the forced TextChatService still run like trash, just casually eating up performance And how can roblox afford to run all this AI stuff? Aren’t they just going to lose even more money from this? 2 Likes Wheatly199: Why is roblox suddenly obfuscating the ID
verification part? WDYM by this? Are you asking why it wasn’t clarified in the post? If so, beats me. Wheatly199: Are they aware of the complaints Yes Wheatly199: trying to hide mentions of it now? Doubt it, it’s already far too late. Wheatly199: Why is roblox not optimizing and further improving their platform? As @Reditect mentioned, probably just
different teams. Wheatly199: And how can roblox afford to run all this AI stuff? good question actually yeah i do mean the lack of clarification for that first one but like why can’t someone just forcefully motivate that other team into improving the platform, stopping the performance leaks that they themselves forced onto us, and just fix the platform
into being semi reliable for once? 1 Like Did you even look at his post, with all due respect such topology should never be used in any projects, it would only set you up for unoptimized failure, especially those who don’t know what they’re doing. As previously mentioned it encourages taking the easiest laziest route instead of properly learning the
basics to get better results, it removes incentive to learn the bare minimum, following this route you will rarely ever find any success and sooner or later you'll need to learn the basics of these skills regardless, all this does is prolong that realization process for new developers 6 Likes i swear the ai is going to misread one of my prompts and get my
account deleted... no thank you. 2 Likes With all due respect, it’s my opinion, of course it’s going to be biased. Inexperienced individuals have online resources to become experienced. I won’t be responding further 1 Like Wheatly199: Why is roblox not optimizing and further improving their platform? Stuff like the forced TextChatService still run like
trash, just casually eating up performance On the topic of TextChatService, that’s the ‘Roblox Chat Team’ as stated by one of their announcements. @be nj hasn’t responded to feature requests, but has quite a bit on bug reports like this: (so they’re working on it.) Script CoreScripts/ExperienceChatMain Very Slow Engine Bugs I also noticed a lot of
waste here, especially when flags were living for a long while. 100 flag checks can sometimes add up to 1ms per frame (This is hypothetical, I didnt see any evidence of 100 flags being called per frame)! I merged a change a few weeks ago that should have been released this week that cleans up a lot of these calls to FFlags. If you have a particular
thing you think Roblox should be “optimizing and further improving”, I could also look into that. I assume more staff read what we say than we think. They just don’t usually respond. 1 Like Page 7 I tested the Al out and it’s not the best. It will take years of training the ai for it to improve. 1 Like I do think this feature will be good for some people, or
people who just want to mess around with it. But i wouldve rather you guys put more time into other parts of the site instead of this. It’s not the worst thing ever, but it just feels unnecessary right now. i take it back. use all your resources on this actually 8 Likes This is the beginning of the end for 3d artists. We all thought Al wasn’t going to replace
us. Look what’s happening!!! It’s unlikely that it will takeover 3d artists jobs currently, but it might in the near future. Prompt: Roblox They tried making of Roblox r6 character (It looks exactly like a r6 model), but the Roblox characters texture was moderated. We will never know what roblox avatar looked like 1ol 3 Likes Some engineering directors
at Roblox -and the CEO- are optimistic and think it won’t outright replace game devs: (I set it to the timestamp) I'm not so optimistic. 2 Likes I mean it kind of looks like a Toyota? Prompt: “Realistic, Blue, Toyota Camry Sedan” 2 Likes Looks more like a Bloxda to me. 1 Like Remember what happened with image creation. It was crap at the start, but
drastically improved in 2 years. The same thing that happened to image creation will likely happen to the 3d ai creation system. 3D artists are safe for now but not so sure in the next 2 years. Prompt: Create nightmare fuel It did a ok job, would scare anyone below the age of 5 years old if animated 1 Like that topology is HORRENDOUS i have my fair
share of messed up things i did blender, but this takes the cake i wonder how these ai generated models would work with rigging 2 Likes Roblox reminds me of myself when I don’t take my ADHD meds. An unorganized mess, starting new project when I have 100 unfinished ones. What happened to Clouds Phase 3 (It’s been four years)? What about
terrain decoration painting (6 years)? Like I see you guys are trying to stay ahead of the game with Al, but can you also work on some of the many features that you promised or some of the tools in studio that are easily out of date by 10 years? It took you guys 4/5 years to give us the ability to change the length of grass globally. 5 Likes That’s good
visually (maybe not polycount or topology-wise). I'm sure the generative Al here will get better, to clarify I'm not arguing the contrary. I'm saying game developers are going to be out of a job in some instances. Why hire me when you can get an Al to do it for you? Quality, performance? Maybe now, but that argument will likely go away with time. We
as humans would need to value human creation over efficiency and individual personal control. I fear society will not value humanity in things before it’s too late to be effective. Weird to say it now, but it sounds like there’s a market for Al-created games out there. Will both human-made and Al-made games be able to co-exist? We’ll have to wait and
see. I got a mario Prompt: Create a plumber named Martin. He wears a red shirt, blue overalls, and a hat that has his initial on it. He has brown hair and blue eyes. 11 Likes Is there any filters or security checks in place? I asked it to make me Lloyd from Ninjago as a test and it created a very accurate one. Can it create anything with no restrictions?
What is the use case for participating in these ridiculous fads in an desperate attempt to make the company’s stock price go up? Maybe you (OP) didn’t have a choice, but none of this will be of any benefit in the long-term as you’ll only be teaching the millions of tech illiterate zoomers on Roblox that they too can (try) to make their favorite front page
game by using Al. This is why they wanted developers to “opt in” to their extremely invasive data collection and force-enabled the script assistant on them, FYI. Oh, don’t worry about the countless performance issues that plague modern Roblox, don’t notice those features which have been stuck in eternal beta mode for years at this point, and
CERTAINLY do NOT take a particular look at the politicians and old men who are investing into $RBLX right now... 3 Likes The texture can be moderated, but not the mesh I don’t think. If you wanna try it out: Cube 3D Play Experience - Roblox 1 Like I tested it, but it doesn’t compare to 3d models created by real people (not yet). Trying to create
guns or gun attachments causes it to exagerate some proportions such as length or often messes up textures. 1 Like I love how out of nowhere you immediately started out by saying my entire post was a “conspiracy”, even going so far to the point where you decide to ping some random dude on the devforum in an attempt to back yourself up in some
imaginative debate. I didn’t even know Blackrock invested in Roblox. That’s even worse, actually. I was referring to individuals like Nancy Pelosi who invested in $RBLX a while back, but if Blackrock is doing it... I think it’s painfully obvious what’s going on here. I will not fill this thread up with garbage, so I will leave it at this: Why would these
powerful people be interested in an platform filled with hundreds of thousands of easily impressionable children? 3 Likes Page 8 So I tested this out, and its super cool! Just wanted to let ya’ll know though, that whenever you try to generate a tv, the screen shows up on both sides. Idk 1 Like Cool, but the thing is, having many of these generated
models takes ALOT of resouces on my device, i hope this gets improved an the performance gets better over time. I love how there’s people complaining about Al, but Al will be utilized in the future for sure. This is just the bare beginning. There will come a time where humans are able to prompt experiences like Star Trek’s Halo deck. I can also see
future humans talking about how earlier humans (us) loved to do things slow and manual. Which takes up precious time we can be doing other higher quality things in life. But that’s just my 2 cents The world has only gotten worse in the past 40 years you think we’re heading towards Star Trek? Bestie we’re heading towards Elysium. Future humans
are going to look back at us and be like “they didn’t have to subscribe to Amazon Quench to swallow water?” 3 Likes I saw this link in a dev discussion post and didn’t pay attention to the date so I thought this was already out. I was thinking, “why haven’t I used it yet?” Didn’t see this was new. This is actually so cool! I'd still rather make my own
models and get better at that skill but this is there if I want it! You are looking too literal into the example. I'm talking about the use of technology and the way of doing things here, nothing else. And that has nothing to do with how better or worse life is outside of coding and technology. Al will come to a point where it can be utilized somewhat like
they utilized it in Star Trek, don’t think too literal on that example. But if you’ve ever seen an episode of it being used, you would understand the power and capabilities at which I'm speculating. We are showing early signs of generation by prompts. We already have people accustomed to talking to devices such as Alexa. It’s not far-fetched to
speculate how Al will be used to create experiences in the future. And coding manually, line for line will be seen as vintage because it’s time consuming and tedious. 3D asset creation is just as consuming. We also already have Virtual Reality and Augmented Reality, precursors to something even better that has yet to be realized. Among the many
things future humans will look back and scoff at us about, when it comes to coding, game developing, and experience making, they will definitely be thankful for the advancements the same way we are thankful for today’s advancements compared to how life was in the 1930s or even primitive era. We have computers to do task now compared to the
1930s, the first computer built was called the Z1 and it wasn’t for the public. Could the Cube 3D Play Experience - Roblox Place be downloadable? Would be very helpful With no respect in this reply, this is a terrible way for people who don’t have experience to “Make their own 3D models”. It’s much better and easier to start from scratch as someone
with no modeling experience up until the last three months I have been able to model “professionally” with no tutorials. (However I did have multiple years of Blender experience but I've only used it for animating.) All you need is 15 minutes and Blender which is free. 15 minutes of Blender each day minimum and in about a year or less you’ll be able
to model almost EVERYTHING you need for a Roblox game, but definitely not a real game outside the platform. 1 Like Reditect: On this, I feel like the whole ID verification thing is for legal safety The ID verification thing might be because they cannot guarantee that the model won’t generate anything inappropriate and there aren’t good enough
advancements in Al moderation technology for 3D models to reliably protect users in real-time against these inappropriate results. 3 Likes It is undoubtedly important to encourage companies that integrate technology and innovation into their products. The use of artificial intelligence in software solutions can be a valuable tool for beginner
developers, helping them implement their ideas, learn, and improve their skills, including beyond the platform. However, artificial intelligence is not and cannot be a source of creativity; it should serve a supporting role rather than replacing development stages. Those concerned about the impact of artificial intelligence on the creative process should
pay attention to the quality of the generated content and study at least the basic principles of how neural networks operate and perceive the world. In its current state, artificial intelligence holds no value for experienced developers and will not be able to replace their work in the future. 2 Likes Trey: This is meant for users who don’t have experience.
Then get experienced. It’s not hard. Blender and YouTube are free and have resources available to get you started. This entire ‘idea’ does nothing but show this company’s true colors. They mean little when they claim that they support UGC and experience creators when they put out horrid generative ai models on their platform as if anyone asked for
this versus actual content we should get or need. None of the content generated looks good and it can’t be used for high quality experiences, anyway, so this is just a complete waste of resources and a great look at this company’s preferences and focus. 5 Likes lol I can’t generate “Roblox character” or “Noob” 1 Like Will there be a beta for other
features not related to Al, such as multiple terrain colors? 1 Like checkersoda: Then get experienced. It’s not hard. as someone who has attempted blender it is pretty difficult to “get experienced” 4 Likes It took a while for it to finally click for me, try letting blender marinate in your brain for a month and come back to it, that’s what worked for me 2



Likes all this ai stuff is just gonna make people hire less artists and make more low quality games for money. It’s very impressive, but there could be way more important things to work on. 1 Like Awesome feature! cant wait for image to 3d 1 Like “We got Pikachu at home” The Pikachu at home: 6 Likes Awesome tool for fun use. However, i fear for
optimization because it creates so much unnecessary triangles and gives absolutely no control over creating mesh which is what mesh part for (Well, it won’t probably adjust mesh for your use which is a big problem and let’s mentions some glitchy looking texture and mesh itself). I'm still impressed of it actually generating decent, but i advise to not
use it for serious projects 1 Like Cube 3D + Avatar Auto Setup CAN make bundles that validate! I made one. //devforum-uploads.s3.dualstack.us-east-2.amazonaws.com/uploads/original/5X/c/9/d/a/c9da9d1205f2144a3662d58c882b697fd653ec87.mp4 It took a couple of tries. Went for something as humanoid as possible that wasn’t a human, to avoid
any textured on clothes or lack of modesty layer. Might be the first ever published bundle made 100% in studio! Only took about 7 minutes from prompting to on sale. Certainly a contender for the fastest bundle ever created from scratch. Check it out: Roblox Customize your avatar with the AI Robot and millions of other items. Mix & match this
bundle with other items to create an avatar that is unique to you! 5 Likes Page 9 You will be replaced by Al programmers just like 3D modellers are being replaced right now. Your job is actually much easier to replace now than 3D modelling. Good luck. This is likely not gonna happen for quite a long time. LLMs aren’t powerful enough to fit an entire
codebase and all of its dependencies in a single context window at once yet and as we can see in this thread 3D model generation Al is not even remotely there yet to fully replace a real 3D artist. 5 Likes The point here is that it’ll eventually happen. Being a programmer myself, I hate seeing other programmers (I can’t even tell if the guy that
originally posted the message I replied to is actually a programmer, but I honestly couldn’t care less) act smug about others potentially losing their job, especially considering that OUR job security is at a much higher risk than 3D modellers right now, even if it isn’t going to happen immediately. The fact that this thing can generate and has knowledge
of famously strictly protected intellectual properties from many large companies such as Nintendo says a lot about the data set used to train it. Just because something is “publicly available” doesn’t mean it’s free to use. Beyond a myriad of other ethical concerns with generative Al, using any asset created from this model, no matter how original, feels
like a potential future legal liability given how many precedents have yet to be established in this field. It seems like the end result here, especially in the short term, is just going to be enabling the further flooding all aspects the platform with half-usable poorly optimized bootleg sludge. 6 Likes I can vouch for this. Blender is my number 1 opp and I
hope it dies in a fire 3 Likes A very good opportunity to help developers In terms of optimizing the platform, a serverside method of bringing the old topbar back and limiting the performance drain of the TextChatService would be nice, as well as any other forced services that may just be eating up precious performance in terms of improvement,
manual controls or even a way to disable all this automated stuff might be nice, so you could manually assign graphics or remove annoying banners 2 Likes wtf, didnt know roblox made their own ai though... What is the assistant’s llm made out of tho? Finetuned Llama 3.1? who knows. 1 Like Prepare for a new generation of brainless slop moneygrabs
made with minimal developer involvement. Generate 3D models using Al, ask ChatGPT to write the code, generate a thumbnail and you’'ve got yourself the dull, soulless simulacrum of a game. Being a game developer, like anything else requires hard work and effort, the desire to create your dream game should be a driving force to underpin your
growth as a creator and ultimately a person but that requires hard work and patience. Let’s give developers tools that they can work with instead of harbouring an environment of laziness and creative bankruptcy. Sure, jumping on the most recent tech bro bandwagon could appease shareholders for a short while, people who’ll easily accept whatever
flashy, sci-fi reminiscent fad as the “next big thing”, but don’t forget that it’s developers keeping your platform afloat. 9 Likes And of those developers, a lot of smaller ones probably have given up due to roblox focusing on popular or money generating games, meanwhile the good popular games are being driven out by garbage or something else that
just makes them money, and then some of those larger developers are simply suspicious Despite being around 20 years old, the platform still feels underbaked in certain aspects I am even going to mention some lacking aspects in this edit: Searching: there is no way to filter by popularity, and there simply aren’t enough search filters, if any, while
certain terms will randomly get redacted, even if they’re harmless Game visibility: there is no way to hide games, meanwhile high quality games get left in the dust if they don’t have enough players or earnings (or their search terms could simply be blocked, even if harmless) Genres: the genres are too broad, and the 3 month cooldown is way too
restrictive (like why is there no sci fi genre anymore?) Graphics: there is no way to manually set graphics, while pretty much all other gaming related things have individual graphics settings, so you're at the mercy of what roblox thinks is best for a certain graphics level Moderation: do I even need to explain this? Moderation either is severely lacking
or extremely sensitive, and there are way too few moderators for the amount of users they have (this might have been fine 10 years ago, but it certainly ain’t fine now) Development tools: there are still certain tools/features missing from studio, which means you need to use various external programs to supplement those features, even if native
support for those tools would be the simplest thing to implement (either that, some of those tools are locked behind ID verification or have so many limitations that workarounds using other tools are better) Customizability: it is severely lacking, I don’t want the platform to look like sensory overload, but I also don’t want it to be full of 1 singular color
or full of buttons and menus that take up tons of space and that you can’t remove Community feedback: it’s practically nonexistant, apart from that one time where backlash stopped a very restrictive feature from being launched 3 Likes this topology nightmare vomit generation will scare away blender artists, 3d modellers and others alike. one step
closer to dystopian ai singularity. great job roblox 2 Likes I think this feature is really cool and interesting. However it indeed needs more testing and patiente. I asked it to generate mr beast for example and look what it generated lol 1 Like Only time will tell lil bro. Great demo! I must ask where is that Attachment Tool from? Seems super useful
1 Like Juan: These are horrifying to look at... 2 Likes It is a conspiracy according to Google. This made me audibly laugh. I tried it out myself and you’re right, 10k tris for a cube that should have 12. Looks like the assistant needs to ask itself what limited dissolve is. 1 Like Decent results: Inputs warehouse factory warehouse coral battle plane
dinosaurus Spinosaurus Therizinosaurus Sauroposeidon triceratops swat vehicle whale shark octopus large jungle tree Not sure results: Inputs: Water bottle egg with a face, legs and arms tiny city with a lot of buildings wolfspider Bad results: Inputs: Yellow Sponge Isn’t this copyright or something? Seaweed in cartoon style keyboard Final: Out of all
attempts I did, only 3 bad results and most being decent. It’s not bad at animals and vehicles, trees are decent. 6 Likes not so cute... (input: black cute cat) why is it bitting a tail... (input: orange cat) 3 Likes Sort of neat, but the system REALLY needs to realize that I don’t want all the textures looking like they come from a grainy televison. However,
assets generated in Studio via Assistant are added to a creator’s inventory and accessible via Studio’s Toolbox. Is there a confirmation for if we want to add it to our inventory at least? 2 Likes Page 10 Overall, a 8/10. Although this could make the modeler job harder, at least if theres a model that I cannot create because I need resources like Blender
which I don’t have and don’t use at all. But yeah very cool Al feature! I will be using the Assistant feature a lot now! Modelers can add a script, make better texture and blah blah blah on a model which the Ai can’t really do YET so at least they won’t lose their jobs... YET. 1 Like This is actually really cool, theres so much tech behind this people
definitely don’t see. The fact it can generate a “model” and texture it is really cool, although most models look like 90s video games, give it a few more years, this will be really cool. We could have entirely new experiences we never thought of powered by this, such as an infinite city with unique models as you go. I don’t like the comments saying its a
waste of time, i think its great a company is finally exploring 3d model generation by prompts. 3d modellers will be needed for years to come, because ultimately you still need original models to even train the Al, and you can’t train Al on AI made content as you get model collapse. there will likely always be a need for 3d modeller artistic vision Is it
possible at this time to use the GenerationService within a publish game to generate a mesh and then show it on multiple clients at the same time? How about generating a mesh and then saving it into a datastore and loading it later on? I cannot seem to figure out how to do this Karun: are proactively moderated by Roblox’s Al safety systems Ai
moderating a Ai is quite crazy. Explains why some prompts like “Roblox character” can be moderated. Maybe Ai thinks Roblox character is copyrighted or something so doesn’t want to make. Broken Spawn: it is pretty difficult to “get experienced” Sure, I'm biased cause I have years of experience on it, but it’s one of the easier 3D programs to learn
versus programs like 3DS Max or Maya, for example. It’s popular enough to have a WIDE VARIETY of tutorials out there for anyone to pick up and learn. All in all, willingness or lack thereof is not an excuse to suddenly lean on generative Al as if it’s perfect either. It’s unnecessary on a platform like Roblox with a slogan like “Powering Imagination”: It
doesn’t power anything but the pockets of the company. 1 Like Everything I am about to write is directed towards the people at Roblox who have (and have abused) the executive ability to make decisions like dedicating serious development resources to a half-baked model generator and announcing its beta with their whole chest. Roblox, to me, is
one of the biggest opportunities I've had in my life. Roblox is the only place I can see where a completely unassuming person can make an account in about 1 minute, work quietly in the background, and freely release a full game of any scale they want. Multiplayer or not; with free, permanent server hosting; free moderation; etc. I'd take a guess that
Roblox probably has the easiest implementation of multiplayer of any proprietary game engine. But, considering that things like Cube 3D are where development resources are going, I'll settle on another guess that you don’t care. Long yearned for engine features remain unfulfilled, you keep locking new features behind literal ID verification, genre
search should’ve been added back multiple years ago, discovery still doesn’t bring any games that aren’t already massively popular to peoples’ attention, the past few events have been nothing more than “go get tokens in these games and we’ll give you some wings”, and a staggering amount of the games that are officially presented in these said
events turn out to be slop, because it seems like the only requirements to make it in an event are to be a popular game and be multi-platform, so looking your best is an afterthought to nearly everyone involved. I guess Roblox jumping on the Al bandwagon was an inevitable next step, for more quick money and power and influence that they really,
really could not need less. Just like so many other massive companies now (the list really goes on), the end goal is for nobody to care about making an original thought for themselves, and just let their innovative Al features do all the thinking for them! Money! This really is a waste of time. It’s really irritating that resources are being wasted on
features like this, and on keeping the child gambling simulators that beg you not to leave as soon as you open the escape menu afloat for the rest of eternity, when those exact resources could’ve gone towards actually giving traditional resources that work to the people who are interested in making games, and giving more control to the people who
do, when there are about a million features in the pipeline that you could implement for a fraction of the cost as it would’ve taken to fart this completely meaningless generator out. Even if this does make it to a proper release, in the end the majority of people who will care about using it are people who don’t care about making games. Who don’t care
about using it to shoot out ideas, don’t care how good the model actually looks, and barely care about their playerbase in general. The generation result will be their final answer. They’'re going to release another barely modified template they found to an audience of 8 year olds, but this time it’ll have an Al Spongebob and skibidi toilet thing floating
over the map. The remaining people will immediately realize how loathsome and samey all of the models it generates look, and instead settle for taking from the vast, vast majority of deliberately created free models that are designed with human intent and make sense in either the Toolbox or somewhere around the internet. Please stop developing
this. Don’t change it, don’t “”“apologize”“” for the “”“confusion”“”, I am asking you to stop making this and add emission maps or something. 9 Likes Roblox has a team of Data Scientists for Al's those people aren’t able to work on the actual Engine because they studied how to make AI’s Roblox isn’t wasting resources. 1 Like My sister’s been playing
with this, and I gotta say this is pretty funny! It’s a nice and cool technology, however I don’t know if there’s any good use for this, as everything this generates looks very weird & the textures look ugly (there’s a lot of unnecessary noising and i don’t think anybody would enjoy wearing something like this on roblox) Models also got an unnecessary
amount of vertices & triangles in them. This is a cool concept, cool technology, but I don’t think this will be able to replace anybody’s job or be better than a real modeler. If you're looking to make an easy starter game to start your career, I think this might be helpful, but in no way this is going to help big developers with a big budget. My
reccomandation for everyone would be to keep paying real human artists to make 3d & 2d assets if you’'re looking for assets. This Al thing should only be used as a fun tool when you’'re bored. Assets like these are not usable for high budget games or games that you’'re expecting to make a lot of money out of. Here’s an easy comparison betwen human-
made assets and ai-assets within the same game: (human) (AI) There’s a significant different in details & geometry. This example is coming from the DEMO place Roblox Come generate and decorate! Check out Roblox's new 3D Foundation mesh generation AI model Cube 3D. 1 Like checkersoda: It’s unnecessary on a platform like Roblox with a
slogan like “Powering Imagination”: Not the slogan anymore (unfortunately.) Roblox’s slogan is “Reimagining the way people come together.” 3 Likes Very cool idea! However as everyone’s noticed, the Al isn’t very ready for real-world applications. Nice demo though. checkersoda: “Powering Imagination”: It doesn’t power anything but the pockets of
the company. While I personally am an advocate for people getting a real 3D artist to make models, you need to understand the use cases this tech has for developers who don’t have connections with or the money to pay a 3D artist to make models for them. This is absolutely “Powering Imagination” for any developer who cannot afford an artist if the
tech gets improved upon. 1 Like Didn’t know their way of bringing people together is just dumping Al everywhere, gatekeeping stuff behind ID verification, and seemingly gaslighting themselves into believing that roblox is much better than it actually is 5 Likes Reapimus: the use cases this tech has for developers who don’t have connections with or
the money to pay a 3D artist to make models for them Again, Blender is free and with effort and time put into it, you can put out better quality 3d models and 2d textures than whatever this Al slop is. i haven’t seen the context for this, is this about the floating point zone? Yep, it is indeed about the floating point 1 Like And not everyone has the time or
patience to invest in learning how to 3D model. Just because “oh you can do it yourself with free programs” does not mean that should be the only route available for you. checkersoda: you can put out better quality 3d models and 2d textures than whatever this Al slop is. Sure in its current state it isn’t the greatest thing but with time this tech will
only become better and more useful. Reapimus: not everyone has the time or patience to invest in learning how to 3D model. If you have the time to develop an experience, script various features, create Ul, etc., but don’t have the time or patience to 3D model, you may not have your priorities in check. This feature promotes laziness and it’s been
proven by various other companies who were caught with it. I don’t care whether it’ll create slop or picasso, it should not be available here. 7 Likes I dislike Al taking over people’s job— I'm still using it anyways, because it’s much better than what I could do. Cool stuff for sure I Would have a use for this. That use being background assets and stuff
that doesnt need high quality textures, however, the current implementation with the high poly count makes me really not want to use it. Im sure this can be made better in the future, sorry to your team for all the people who either dont see the great use of this technology, or are too rich to care. Hopefully that poly count can be brought down
especially for simple models. Thanks! Page 11 Everyone should be happy that this thing isn’t doing as good as human modelers because then it wouldn’t replace the job of Modeling. This feature is helpful for developers that don’t even know how to somehow model. And this will help save people’s time from downloading Blender and taking a very long
time to make a single model. I give this new Al feature a 7.4/10 because it helped! (I had to copy everything in here and make a new reply because i realized that I should have made this as a reply to idel’s post. So yeah the now deleted post in the topic had the exact same text before the parenthesis start.) The consensus seems to be that this tool is
only going to lower the overall level of quality in games. This garbage does not even deserve to exist on the same platform with other games that have taken actual human effort and time to develop 4 Likes idelww: Models also got an unnecessary amount of vertices & triangles in them. wait until you see the vertices in an ai cube... 1 Like Great,
another tool enabling more sloppily made games. Long gone are the days where making your own thing was encouraged now that you can just lazily type what you want and get it handed to you in a silver platter. 1 Like Very cool. Imagine infinity craft but 3d. stormeus: Great, another tool enabling more sloppily made games. Long gone are the days
where making your own thing was encouraged now that you can just lazily type what you want and get it handed to you in a silver platter. Its useful. You can make your game more immersive. Together with the Text Al you can for example have infinity unique crops for a farm game. Imagine Infinity craft but 3d. The model is great, but the texture
looks like a bad LIDAR scan. What??? 16 Likes Thats cool but it’d be better if you kept peoples’ jobs (i bet some of them are doing it for a living) and NOT kill it with AL It’d be better if you made people LEARN how to model and texture, not the Al. Al should be only used for learning and finding info. Nothing else. This update feels like a spit on the
face for 3D modellers and builders like me. 1 Like Misterx113: Imagine infinity craft but 3d. The moderation, the time it generates in and the limit makes it almost impossible though as a 3d and digital artist, this is genuinely beyond disgusting and disrespectful to all of the artists using their own time and energy to keep this game platform afloat. This
should be scrapped. This isn’t a “new era” this is enabling the ever-growing amount of slop games. This budget should’ve been allocated for anything else, like upgrading future lighting, adding more proccessing effects (even ones that were featured in hack week 2015), better code documentation, code “templates” for beginners, a man-made
texture/material library or more variants for existing materials, reviewing games to discourage slop game made to scam kids... ANYTHING but not more ai features. no one wants them and no one truly needs them. 10 Likes Don’t really want this update but not much I can do about it. At least when this goes into effect it better have REALLY good auto
moderation. Uhhh, needs a lot of work... Prompt: SIG Sauer XM7 assault rife Output: Impressive, but that’s very much not this: Also, how do I get Assistant to generate models? It’s refused to create anything other than scripts, importing toolbox models, or vague part “recreations”. photorealistic bunny rabbit with a gun he is egg 2 Likes FPS Enjoyer:
get Assistant to generate models? I believe that is one of the Beta features you need to enable in Studio in File > Beta Features 1 Like Oh, I should have clarified that I enabled the beta. Does it not describe some kind of keyword in the beta feature description? I think it was /generate 1 Like As an environmental science major, I want to know. How
much electricity and water does this use per generation? Hm? Seeing as this has a limit of 5 generations per MINUTE, I'd imagine very little. Al’s gotten a lot more efficient in the last few months. Let’s play a quick game of which item was made by a human (me). Axe (Far left) Baseball Bat (Second from left) Electric Guitar (Middle) Stop Sign (Second
from right) Sword (Far Right) I promise that I actually modeled and textured one of these. 1 Like interesting update for a company whos slogan is ““‘powering imagination’’ The model for 3D generation is trained on 1.5M 3D assets that utilize a combination of licensed and publicly available datasets, as well as the free data assets that are available in
our Creator Store. It does not include experience data. 3D models being free for use on the marketplace doesn’t mean you can just steal them and frankenstein them into ugly poorly optimised nightmares omg 6 Likes And Roblox’s CEO is currently using this bundle on their avatar. I guess it must be nice to see that they’re supporting this. 4 Likes
Page 12 That’s brilliant. I'm glad people are using this tech and pushing it forward. 2 Likes not only that, these generators produce worse results than having to manually model it yourself for example, i used meshy.ai and generated a simple sci-fi cube. all was good until you noticed that the model doesn’t look consistent, contained typical Al
artifacting, bad topology, all for a grand total of 227,540 tris... for a simple sci-fi cube decimating it to lower the tri count did help, but it caused so much artifacting you might as well model your own - which i did and managed to get 1.6k tris these ai’s don’t care about the actual process of modeling, they only guess where each vertices go... which is
NOT what you want when you’re making models for REAL TIME GRAPHICS, ESPECIALLY ON THIS PLATFORM. what i see happening is inexperienced people scratching their heads wondering why their games perform crap, yeah because you used an Al generator that spat out garbage 9 Likes blender took me roughly a few weeks to get used to and
another month to start actually making some sick models, to me it looks like people not wanting to put any effort into a game and then being shocked when it doesn’t end well Obviously it isn’t completely ready to use yet, it’s working in progress. It’s brilliant we’ve gotten this far. It’s the start. 3 Likes dude, when they see the complexity of 3d studio
max, maya or houdini, they’ll definitely have a second choice with blender, like they’'re used by industry professions with YEARS of experience blender isn’t hard as people make it out to be, it’s the most accessible than the former mentioned. with that said, use resources, practice daily and reach out for help, that’ll bring you so far with getting ahold
of blender, or even life in general 2 Likes More features to suck the life out of creation I guess. I think we all know very well these features will never just be used for “prototyping” especially if they get better. In 2025 you can code without coding, model without modeling and make art without caring. You are powering slop not imagination. 3 Likes the
start of more job security for us 3d artists when people start to complain why their 100k tri ai generated 3d models wont work properly. likewise with the whole vibe coding stuff in regards to programming & cybersecurity. even then, we literally wont bother trying to fix the model, might as well start from the ground up 3 Likes Literally I cant even
comprehend how this is seen as useful at all. Literally the engine has so many features missing and we get this... 3 Likes This is great!! It helps a lot to visualize ideas being materialized. It improves the coding experience by enabling a tangible asset (quite close to what we have in mind, despite not being perfect) to replace a random part when
programming. I've tried downloading Cube and couldn’t use the EngineFast on my RTX 3060 Ti with 8GB VRAM. Engine works fine, although it takes about 15 minutes to generate an asset. Any suggestions on how to update parameters for a faster generation? It also comes without any texture. I assume Cube doesn’t provide textures, they are made
only in Roblox Studio using the texture generation. Is this correct or am I doing something wrong? Looking forward to more innovations like this that help developers bring ideas to life! The implementation seems super scuffed, if you use /generate it just pulls assets out of the Toolbox and the only other option seems to be the API which you can’t
really use while in edit mode I don’t get why there isn’t an option to generate meshes similar to the texture generator Did you enable the “Assistance Mesh Generation” beta feature? 2 Likes There needs to be better simplification. This is “a cube with sharp edges”: 6 Likes I do actually agree this is just going to make actual developers more useful.
But, I view these Al advancements like freemodels. There is no problem with somebody using a free model, and Al will probably replace these free model eventually. While real developers will remain in demand. 2 Likes Nox: personally i think there’s better features to spend development time on but oh well This is likely a separate division than the
studio team, since they would have need a different skillset. 1 Like My personal feedback is... Some of the things cube 3D generated are really low quality now there are a few things that look pretty good, I believe it needs a little more improvement but this is progress. 3 Likes Great, more garbage Al. I already see how great Meshly is performing. I
can already see how good this works from the preview. 4 Likes Decimate modifier go brrrrrrrrrrrr 1 Like Exactly. Roblox could have invested their time into much more useful and resourceful things to improve the platform instead of this—a silly Al that could potentially take jobs. Roblox doesn’t even realize it, but this could actually cause their funds
to go down. Hiring someone and paying them a small amount of Robux benefits Roblox, but with this, it’s free—so Roblox doesn’t get that small cut of Robux. 2 Likes I don’t think the quality is good enough to be used in real games, but it is shocking how close it is to being at that quality. I'm not sure how long it’ll be until then, or if it’ll even happen,
but it is pretty good. It’s great meshes and 3D models are becoming more accessible to beginners and people who can’t afford to hire anyone, but also a bit scary for people who have it as a job? 2 Likes cool. when are we going to get shaders??? 6 Likes Page 13 I don’t get the arguments against Al People who hate it say that it makes low quality work
yet fear that its so good that their jobs will be taken? Like pick a side man 5 Likes performance > good models (10000 tris for a cube ) CrazedBrickl: People who hate it say that it makes low quality work yet fear that its so good that their jobs will be taken? I think that’s just cope tbh 3 Likes Training it off toolbox models may not be the best idea.
When I asked for a scary monster, it just gave me retextured versions of sirenhead, the blue dude from poppy playtime, and some what seemed to be piggy characters. Also any time it say to generate water, it makes a gun. Other generations were pretty good though. 1 Like Yo I think they fixed it. Like just now one of my meshes went from 10K tris to
500 looking MUCH better prompt: /generate character Result: Tris: I generated a fine chap (all seperately, was even able to generate an individual left/right dress shoe of the same style!!) Edit: another model 500 tris again, seems like they added an lod sort of thing thats dependent on the complexity of the mesh My friend is messing around in the
same studio place as me and the meshes im sending are all still 10k for him. NO IDEA how this works or why but I have the upgrade version of this feature I guess lol This version of the tool makes my vision of a museum map possible without costing 10 trillion robux for 100+ background models!!! 6 Likes smashman65: image515x687 64.8 KB i cant
even lie (with our current marketplace) this is honestly almost sellable 3 Likes Almost? Your standards are too high! If we can sell a literal Blender Cube, we can sell this AI model. 8 Likes Broken Spawn: performance > good models My concern is... what makes a game functional? Part of that is actually having visual rather than just out right
alienating 3D poly-shapes that seems unrecognizable. I also don’t get how a cube would take 10k, and I agree that’d ef up the performance, but there’s always a room for change. I might also have to do a better job than Al. 3 Likes What AI spews out now is the worst it will be. Chances are it will just become better and better looking. And, as long as
it’s making money, no one cares whether it looks low quality. That’s why so many businesses in real life use Al generated images despite looking abysmal. 3 Likes This is really good, but I think you should make some features not locked of ID verify, but I try this feature and I generate a cat with top hat, it work ! Seems like Roblox is just testing new
waters in order to “improve” the development experience. I wouldn’t worry about it. consistency and creativity will always out perform Al. We set the standard while Al plays catch-up. 4 Likes r/topologygore moment Ima be real... this looks really bad... When you released image generation it was a bit iffy at first but had actual uses. This does not
simply because the quality of meshes it produces is crap. Looks not bad now but I see potential 1 Like It generated the laptop right, except... What is this mess . 8 Likes Wrong place but i totally agree. i need shaders 1 Like A solution to not being able to hire someone is to putting the hard work and dedication into someone you enjoy and being hired
for it. yeeaaah chief this aint it, I think we would rather something like custom shader support. 1 Like Can we get a blender plugin so they can be modified easily? 1 Like There’s multiple solutions not just one. Wow , it make unicorn 2 Likes Page 14 I would suggest lowering your expectations for modeling efficiency for now; after all, it is in beta, and
that must be considered. 1 Like While I do think this is a great feature, what’s unfortunate is that the mesh/image api is locked behind an ID verification wall. I don’t understand the reason for such a requirement, and I don’t see myself using it anytime soon unless this restriction is lifted. Instead of focusing on Al yall should have added more
requested features to the Roblox engine tbh. 4 Likes im genuinely impressed by spongebob and wall-e Dont like how everyone is saying how bad this feature is. It is bad for a reason in my opinion, so it doesnt replace Modelers. This feature is still usable and fine to me. “Works” may be a bit of an overstatement... (but yes, I get what you mean lol) 6
Likes Yo guys remember Ugly Sonic? He’s back in full force now! 1 Like This feature is in beta, with limited generations per minute as mentioned within the original announcement. Every Al generation has a cost-per-request, which Roblox is waiving for free. It has its own challenges, including bad actors abusing the generation, which they have
stopped a significant portion of by mandating identity verification to keep this service free. Another concern could be related to privacy and data collection, as these services are free, which there is a saying - if a service is free, then you are the product. In this instance, by utilising the service, you’re providing data to the team responsible for this
project, which they will process in developing their algorithm. I do believe it will become a state where it doesn’t require users to be identity verified, mostly when ROBLOX optimises their algorithm and computational processing to reduce the cost-per-request to widen their accessibility. 1 Like These tools and services with Al-generated content
widen the potential for social development. I've personally worked with educational institutions (under 13’s) in allowing students to create their own creative ideas in platforms, such as ROBLOX. These students generally have no experience with 3d modelling, or any programming (set for block-based coding such as Scratch), which are required to
have to start any project. We also have time constraints, as these are short courses to bring students innovative ideas into practice. ROBLOX’s solutions, specifically their Al coder, have brought success with the students I work with - and seeing how joyful they are to have their ideas for others to play is amazing. This brings amazing opportunities to
introduce students to different industries much faster and allows them to develop skills in a specific field that they’'re interested in with direct help from Artificial Intelligence. In the video game industry, companies are venturing into artificial intelligence tools to speed up their development pipeline. For example, a crate model with a base texture is
created by a 3D Modeller. However, a game set in a battlefield will require 10 variations of this crate with different levels of destruction and aging. It will take a significantly long time to hand-paint each texture, compared to utilising the data and lifting the work out so they can prioritise other tasks. All of these case examples bring more potential to
the development space, if used correctly with the correct intentions. 3 Likes exactly!! this benefits quite literally no one lol 4 Likes I wish Roblox Corporation would spend all the resources elsewhere, than following whatever is trendy in Silicon Valley... 4 Likes Maybe instead we should start getting updates that benefit ROBLOX'’s actual creators, the
ones that aren’t using Al slop to spit out junk for them. Let’s look at that platform to creator revenue split as well while we’re at it. 30% for something I made AI gag out at me? Fair enough. 30% for something I spent hours, days even, modelling and texturing with my own hard work and skill? Abysmal! Ugly Sonic (2019): I'm the ugliest Sonic ever.
Ugly Sonic (2025): Are you sure about that? 1 Like Seriously, Roblox? Obviously these models are in no way better than something that a modeler could make, and look straight out of a mobile horror game, but there might be a day where they don’t, and that’s terrifying. I'm okay with Al when it comes to learning, but come on, if people don’t use this
feature to generate brainrot simulators, then I'm not a Roblox user and you know it. Please don’t release this update to the public, please don’t continue to encourage the trend of using Al for games. 4 Likes If people do not want Al slop games to take over Roblox then just don’t give them any attention and focus on the ones that aren’t slop. Games
will thrive if people engage with them, and vice versa. It’s that simple. Soon the “Al meta” would hopefully die down and people will realize that they won’t make money that way. I am certain that some developers will still maintain the decency to hire an actual person instead of utilizing Al for everything in their game. After all, Al is supposed to assist
people, not replace them. 1 Like While I agree with you, I have a feeling that won’t happen. At least on ROBLOX, that is. People on ROBLOX seem to complain and make noise about things and then it immediately gets erased from their brains and they support it? Everyone complained about public UGC, wanting it to be reverted and then poof no one
made noise about it anymore and people happily pay their monthly premium subscriptions. Due to that, now ROBLOX will most likely never fix/revert it. If slop games use those Al models like crazy for a while, ROBLOX might think to keep doing updates like this as people were using it. I mainly just hope complaining users actually just stick to their
word (not targeting anyone specific in this thread, to make that clear). 2 Likes this is NOT luffy 6 Likes I highly suggest you press the reply button on my post next time, so I can be notified. If it weren’t for someone liking my post, I never would have known that you even replied. That aside, this is Roblox. There’s always gonna be some idiot(s)
misusing a feature to put out crappy games. Rev: If people do not want Al slop games to take over Roblox then just don’t give them any attention and focus on the ones that aren’t slop. Games will thrive if people engage with them, and vice versa. It’s that simple. You don’t seem to grasp the concept that young children use Roblox, and that they’ll play
anything that has bright flashy colors. We may not engage with them, but the larger (and younger) portion of Roblox probably will, and they will continue this junk of Al updates since they get money from it. I think @iHA3CH4N made a good point on this. Adding onto that, everyone hated Rthro avatars, but then you have mostly those same people
using hyper-realistic UGC bundles. 2 Likes Exactly, I don’t get how someone can change opinions so fast. This is why ROBLOX never does anything or reverts anything, because people will soon go along with it. How could you hate rthro but then use UGC versions? Either you like realism or you don’t. I get they’'re different styles but people literally
used the complaint “realism doesn’t belong on ROBLOX”...but then use other realistic bundles...? Either you wanted an update to be reverted or you don’t!!! At this point, even ROBLOX must know that they can do whatever updates they want because complaining users will soon forget and support it! I only glanced at the comments to get a consensus
and replied to voice my opinion. I wasn’t replying to you at all. Anyhow, I'm aware that children have no sense of quality and that is an issue that cannot be fixed without quite literally messing with their brains. While we can avoid games like these, they won'’t. I failed to remember this, and I'm sorry about that. If these games do thrive and Roblox
decides to push out more Al features then that’s entirely on them for being a greedy company that wants to make as much money as humanly possible. These new Al features should be tools to assist us and I have already made this point in my first reply. Roblox seriously needs to address this issue and fast, before it gets too out of hand. Also, I don’t
understand the Rthro comparison, as I've never seen anyone (excluding staff members) using Rthro (or other realistic bundles) unironically. To add onto this, this game slop issue has been around for years and people still criticize it. AI will only enable developers to produce these slop games faster than before. I can’t even fathom that people will soon
“support” these Al games. 1 Like Page 15 Rev: Also, I don’t understand the Rthro comparison, as I've never seen anyone (excluding staff members) using Rthro (or other realistic bundles) unironically. There’s literally a whole community of people that use them? Without having to name other players, many people use them. Mainly female, I've even
used them “unironically”. (Then again, I never personally complained about rthro.) Many users will use only the body and not the head of a realistic body too, as they’ll use a “makeup head” face accessory instead, as seen in many role play games - even in the thumbnails of them. Rev: I can’t even fathom that people will soon “support” these Al games.
Even if they don’t straight out support it, they’ll stop asking ROBLOX to stop giving us updates like this. If you stop telling ROBLOX, they’ll see it as support. ROBLOX barely reverts things as it is, let alone if people stop complaining because they can’t be bothered to anymore or whatever their reasoning may be. Some brain rot kids will play the
games, therefore supporting them - whether they mean to or not. Some developers/creators will just stop arguing their case, therefore ROBLOX will think it’s okay to keep making trash updates like this one. It all comes down to how the community reacts to ROBLOX’s updates, at the end of the day. 1 Like Listening to Dave’s Tech Talks “Al in Game
Development” (Episode 24) Podcast brings a lot of perspective to this topic. It’s rare to get a behind-the-scenes look at how companies make decisions, but Roblox shares a surprising amount in their Tech Talk podcast series. Rev: I only glanced at the comments to get a consensus and replied to voice my opinion. I wasn’t replying to you at all. Ah,
apologies then! The context of your reply really did seem like you were talking to me. Rev: These new Al features should be tools to assist us and I have already made this point in my first reply. Roblox seriously needs to address this issue and fast, before it gets too out of hand. I completely agree. And again, sorry for misunderstanding your replies. I
usually read any kind of text extremely fast, skipping over important parts at times. Rev: Also, I don’t understand the Rthro comparison, as I've never seen anyone (excluding staff members) using Rthro (or other realistic bundles) unironically. What I meant is that users mock roblox-made high detail bundles, but then they’'re perfectly content with
even uglier UGC bundles. Sounds a bit hypocritical. I'm not saying everyone should equip those bundles, but people should stop criticizing things similar to what they actually support. P.S, sorry if I overuse quotes, and once again for the whole misunderstanding thing. 2 Likes It’s all good, man. Mistakes happen. 1 Like How? The basic model is
surprisingly good, but the textures are low res. Overall, I can’t believe this is possible... 1 Like Just wait until you see the amount of vertices and tris... In my opinion, Performance > Quality 2 Likes Tried testing the feature out, the texture looks so odd 1 Like yes and no tools need update left handle right handle or both no use a 2 script like add motor
6D or weld constain or something else for Dual object so you dont see 3d artists, enviroment artists, texture artists, animators or concept artists as “actual developers” then? I said the exact opposite of that, in fact. I said real developers will remain in demand and Al made stuff will be viewed like free models. This is a tutorial for you to deal with
scripting your custom character in roblox! How is your character made? Roblox characters can have different types of structures and can be build in many different ways. Probably if you got to this article you already have your character made, but here are some tips over creating it: Roblox’s default are made with the R15 and R6 structures, so you
will save some time if you could rig your char in a way that can copy the R15 or R6 structure. But there is also the R1 option: characters that are a single mesh rigged by bones. Lets say, if you want to create non-humanoid modelas like a dragon or a snake. If your are using an R1 character, take special care over the decision about using a Humanoid
object inside your character. Maybe removing the humanoid and creating your own character script would be the best choice. Humanoids are made to work specifically with R6 or R15 models. For animating a model without a Humanoid you can use the AnimationController instead. For rigging models on Roblox Studio, try this plugin Rig Editor by
@goro7. For some reference of ways on how you can create your character: Bone | Documentation - Roblox Creator Hub Rigging and Skinning | Documentation - Roblox Creator Hub Rigging a Simple Mesh | Documentation - Roblox Creator Hub Skinning a Humanoid Model | Documentation - Roblox Creator Hub 3D Layered Clothing is Now Available!
Layered Clothing Example | Documentation - Roblox Creator Hub Talking about R15 and 16, A common problem with custom created rigs is when the modeler forgets to create meshs facing the right direction. Make sure all your character’s parts face front and your animations will stay consisent over different character types, avoiding this kind of
problem (custom rigged character with wrong-faced meshes reproducing the default Rthro walk animation): //devforum-uploads.s3.dualstack.us-east-2.amazonaws.com/uploads/original/5X/a/b/f/4/abf4b8ad9a7cc6a03d6fe254a51a0bfe0381dd2c.mp4 Recapping what is inportant: If you are using an R6 or R15 based rig, you will be able to use a
Humanoid object without problems and will have no hard time using the default Player’s methods related to the Player’s Character. If you are using an R1 model, you can still rig it with bones to match it with an R15 or R16 model and get the default Roblox’s APIs for characters. If none of the above is possible for you, then you have choosen the
“create from scratch” path, where you will get no benefit over Roblox scripts that regards to Sounds, Animations, HumanoidStates, Loading, Respawning, Camera setting and etc. I will talk less about scripting this type of model because scripting it adds a big layer of complexity, but its never impossible. If you want to make it right you will need to
fork the default player and character scripts, analyse it and edit for your needs. CharacterAutoLoads CharacterAutoloads is a Property of the “Player” service, changes if the game will automatically spawn your character when the game begins or when you die. You most likely will prefer that option disabled, specially if you are using an R1 character.
LoadCharacterAppearance Turning “LoadCharacterAppearance” makes the game not to download the player’s character appearance with the API, that makes the game quickier on iniciation in case your are not going to use player’s characters default appearence. If you use the Player:LoadCharacter() (needed if “CharacterAutoLoads” is disabled)
method with this disabled, the character spawned will be a grey blocky character. Players also have individualy the property CanLoadCharacterAppearance to define whenever its appearance will be loaded or not. StarterCharacter, StarterCharacterScripts & StarterHumanoid StarterCharacter [Class Model] Placed over the StarterPlayerFolder. All
objects placed inside this model will be copied to the Character model of each Player as they join the game or respawn after death. These objects will be loaded in place of the default character that is sent from the website. StarterCharacterScripts [Class StarterCharacterScripts] Folder already inside StarterPlayer service. All Script or LocalScript
objects placed inside this object will be copied into the Character model of each Player as they join the game or respawn after death. If any scripts named ‘Sound’, ‘Health’, or ‘Animate’ are found inside this object, they will replace the default scripts inside the character with the ones included in this object. StarterHumanoid [Class Humanoid] Placed
over the StarterPlayerFolder. A copy of this Humanoid object will be copied to the Character model of each Player as they join the game or respawn after death. This can be used to initialize any settings on the Humanoid object such as JumpPower or MaxHealth. Many people try to keep changing StarterCharacters in “StarterPlayer” during the game
to change characters in the middle of the game, I was doing it until I find out that it leads to lots of weird bugs all over the char, with plenty of APIs not working as it should. Instead I started to create my own script to load the characters. HumanoidDescriptions HumanoidDescription is an object that stores a description for a Humanoid for R6 and R15
rigs. It can be applied in order to set a rig’s scaling, clothing (Shirt, Pants, ShirtGraphic), Accessories, Animations and BodyColors. HumanoidDescription | Documentation - Roblox Creator Hub There are also some useful methods that interact with humanoid description on the Players service, like: Players:GetHumanoidDescriptionFromOutfitId()
Players:CreateHumanoidModelFromDescription() Player:LoadCharacterWithHumanoidDescription() Loading function for R15/R6 Humanoids Your custom loading function can have the role of spawning and customizing your character on spawn. Roblox have some default functions on Player instance for loading characters and some on Humanoids
together with HumanoidDescriptions to customize it. If you are using Humanoids with R15 or R6 rigs, search these links: Player:LoadCharacter() Player:LoadCharacterWithHumanoidDescription() I also like sometimes to create a function to spawn a “Blank Blocky” R15 humanoid and customize it after spawn using one of the functions above and
adding Accessories, BodyColors and AutomaticScales. For weird R1 characters you will need to create a function that clones a characters, puts it in workspace, set the Player.Character to that model, create custom RemoteEvents and Events for Player.CharacterAdded because the default ones wont work, and add your own customization to it.
RbxCharacterSounds If you have done it all until here and you are working with an R6 or R15 model with a Humanoid in it, it is very possible that you would want to disable the custom walking sound that haunts your rig if it is something like a dragon or an alien - Why would it have that spongebob’s boots sound while walking or climbing? To change
or mute default character sounds you will have to fork RbxCharacterSounds and edit it: Hit Play button. Go to Players > Your Player > PlayerScripts Copy “RbxCharacterSounds” Hit Stop button. Paste it in StarterPlayer > StarterPlayerScripts Open it and find the SOUND DATA table, it contains sound ID’s and Volume. You can take your look on this
script to mess with sound related character’s default behaviour, or clear it if its your will. It must stay inside “StarterPlayerScripts” to be used by the game instead of creating a new default RbxCharacterSounds script on spawn. If you want to delete the sound, you can go for deleting the whole walking and climbing sound object from the table (and
you will have to find delete all of its calls in the whole script) OR you can just mute it by setting Volume to 0, and muted the SOUND DATA table should look like this: local SOUND DATA = { Climbing = { Soundld = "rbxasset://sounds/action_footsteps plastic.mp3", Looped = true, Volume = 0, }, Died = { Soundld = "rbxasset://sounds/uuhhh.mp3", },
FreeFalling = { Soundld = "rbxasset://sounds/action falling.mp3", Looped = true, }, GettingUp = { SoundIld = "rbxasset://sounds/action_get up.mp3", }, Jumping = { Soundld = "rbxasset://sounds/action_jump.mp3", }, Landing = { SoundIld = "rbxasset://sounds/action jump land.mp3", }, Running = { Soundld =
"rbxasset://sounds/action footsteps plastic.mp3", Looped = true, Pitch = 1.85, Volume = 0, }, Splash = { SoundId = "rbxasset://sounds/impact water.mp3", }, Swimming = { SoundId = "rbxasset://sounds/action_swim.mp3", Looped = true, Pitch = 1.6, }, } You can also try to change the default sound URL for another URL Animations For R15/R6
Humanoids, Roblox automatically spawns a local script called “Animate” inside the characters. You can fork it to edit and place it in StarterCharacterScripts. It will allow you to change the animations or animation behaviour of your character. Hit Play button. Open your Character in Explorer Copy the local script called “Animate” Hit Stop button.
Paste it in StarterPlayer > StarterCharacterScripts Inside the script (instance, not its text) there are values with the action name, go inside the value with name of the animation you want to put yours, click on the Animation object inside it and change it’s ID in properties to your animation’s ID. Attention here: Although there is a “walk” and a “run”
animation, the actual normal walking sistem is only using the walk anim, changing “run” seems to rave no effect. And more important: Never use the same animation ID for walk and run animations because it will stop the animations from replicating to server. This tutorial assumes that you have a basic understanding of blender and how curves work.
For this tutorial, we will be using curves, converting those to meshes, and UV unwrapping. Below I will provide you with the Roblox character to use as a reference. Remember this does add to the tris count. Curves - We will be using these as the main function for the hair. It allows us to manipulate the shape of the meshes. Mirror - It allows us to
mirror the object, reducing our workload. Decimate - Reduces the tris count, causing less lag. RobloxCharacter.blend Getting started Open the scene, it should contain just the Roblox character and nothing else. Go ahead and add a curve circle. Shift-A > Curve > Circle. This is what you will use for the shape of the hair. As you will see below, there
are a few ways to make the shape, but this is the way we will be covering in this tutorial. While selecting the circle, press tab which will bring you into the editor for this object. At first, it may seem quite complicated, but once you learn how to manipulate it, it's easy. Your circle should look similar to what is below. Another method we can use is using
regular curves and shaping them in a triangle, which can help to reduce the tris count. Then you are going to have to enable the free handle type. This is located at the top of the screen under Control Points > Set Handle Type > Free. Next, you are going to shape the circle to be your desired shape. You can do this by selecting the vertices and moving
them. Below is the shape I will be using, however you can use any shape you want. The less complex the shape is, the less tris you have. Step 3 We are going to need another curve for the hair. Shift A > Curve > Path. This is very important as it will allow you to shape your hair. Next, we have to apply the shape to the path. We can do this by going
through the Object Data Properties > Geometry > Bevel > and select the circle we made earlier. It should look something like this. Step 4 Next, we have to make the edges pointy. We can do that by selecting the vertices and pressing alt s. It should look something similar to what I have below. I moved the curve up a little, to give it more shape. Make
sure you scaled both sides. Step 5 Steps 1-4 were pretty easy and didn't require much messing around. The next few steps will. You are going to want to shape your first path as hair would flow. If you need some references you can look at the final product. Mess around with it for a few, and see what you can get. Try to get the hair facing different
ways. The way you apply the hair comes down to the style you are going for. Don't worry much about it looking like banana peels right now. The back of the hair is the most work. You just have to try to get it to flow, which takes a bit of time. After some messing around you can get to something like this. I used the same curve to add some ears to the
mesh. Step 6 Before we can go ahead and convert the curves to meshes we need to start limiting the amount of tris we have. The first thing we can do is turn down the resolution of the mesh. I find that 4 works fine for me, but if you need to reduce it further mess around with the count. Step 7 Next, we can convert all the hairpieces over to mesh. I
assume you did all of the curves as separate curves, so we will cover on how to group them. While in object mode and selecting all of the hairpieces, press Object > Convert to > Curve From Mesh/Text. This converts it from a curve, to a mesh allowing us to edit the topology. Next, you will get a prompt for the target. Select Mesh from
Curve/Meta/Surf/Text. If you go into edit mode, you can see that there are a billion faces. Don’t worry about this right now. While you have all the objects selected group them with ctrl J. You can also do this step for other objects you have added such as ears, or bow ties. Step 8 Next, we can apply a decimate modifier. This brings down the tris count
even more. If it is still too high, you can apply another decimate modifier. You can also select all while in edit mode, and go to mesh > clean up > limited dissolve if you need to further reduce your tris. Step 9 UV Unwrapping is very important for any UGC creation. I will be using simple gradients as it's late at night. But feel free to use whatever you
want. I expect you to be able to unwrap the UV map. You can also shade out smooth if needed. Final Product This was the final triangle count of the hair above. Conclusion I'm hoping this tutorial helped you learn a little more about how to make hair in Blender. This can be applied to anything, whether it be UGC or accessories for NPCs. I learned this
fairly recently, so it's probably not the most polished work but I thought it'd be awesome to share it with everyone! 215 Likes Nice tutorial! I am not very good at Blender, so this helped me a lot! 19 Likes No problem, I just learned this so it’s not super polished but I wanted to share the skill. 9 Likes I don’t even know how to use blender, but I'm sure
this’ll help someone out there! 5 Likes I'm more of a Maya person but a lot of the stuff is applicable in some form. We got NURBS curves. Thanks for the guide! 4 Likes Finally a tutorial for make a hair in blender! I was looking for a detail tutorial for a while 5 Likes Glad you like it. I noticed there wasn’t one so I wanted to get one out as soon as I
could. Let me know if there are any issues with if, and please share it. It’'s something most modelers should know 5 Likes Great tutorial! But is it possible to make this in 2.7? 2 Likes Im not sure, I would assume so however. 2 Likes Can i use 3DS to create a Hair? 2 Likes I would assume so. It’s probably a little different, but a similar concept. 2 Likes
In step 5, how did you make the hair a lot more thinner? 2 Likes All you have to do is press s in object mode of Blender and there will be a drop down menu and it scales corresponding to the x, y, and z axis. 1 Like Nice tutorial! How do you do UV colouring? 1 Like My hair pieces looked terrible because i did something incorrect. Can you describe the
steps from 1-47? It’s hard to make the hairpieces pointy and i don’t understand how to make them even pointy, does it require all vertices or just seperately? Honestly this tutorial is currently really impossible for noobs like me. My Blender version is the latest (version: 2.8.2 Alpha) NOTE: Please respond within 2 days or else i will not reply to the
answer so please respond as quick as you can 1 Like To make it pointy grab the end of the path and click alt+s, then click 0 to make it as small as possible. To change overall shape of the hair go to object mode and click s and move ur mouse around. 2 Likes uhmmm... I don’t know where is the end of the path. Can you show where is it on the curve
made? 1 Like There is a way easier method that I found. Download the add on called bevel curve tools. Watch tutorials on how to use it. If you still need help lmk 1 Like Pretty nice tutorial, will really help out new modelers in the community. 1 Like I'm using the Steam version and i can’t seem to find the addon Can you give a link to download the
addon? 1 Like Page 2 Jaudr3y: make the edges pointy how do i do this? it’s RLY impossible for me 1 Like GitHub Blender addons that helps you with creating and maintaining beveled curve. - GitHub - ucupumar/bevel-curve-tools: Blender addons that helps you with creating and maintaining beveled curve. Make sure you download as a zip file. Look up
tutorials on how to put the add-on into blender 2.8, and once its in Imk. 1 Like I use the Steam version, how to save the addon on Blender? EDIT: i found add-ons button in Preferences and clicked Install. Then it asked to select a ZIP file and i selected the one with bevel curve tools. 1 Like Alright, make sure you click save preferences so it shows up
after you close blender. Now Once in blender click N and you will see a side bar show up on your top left side, click on bevel and everything should be there The bevel area should look like this Click on add/override bevel, once done with your hair (Completely done) you can click convert: To mesh(es). Using this method I got this done! Hope this
helped! 2 Likes Which version of blender is this? 1 Like Possibly 2.8.2 or 2.7. I don’t know 2 Likes I don’t know how to texture hair and UV-unwrap in Blender. How do i do it? 1 Like 2.82. Sorry for late response 2 Likes Alt A. I said this in the tutoriall 1 Like nice tutorial, this is a very interesting way of accomplishing hair creation, hopefully compatible
mesh deformation becomes a thing, so we can make animated hair later, but im gonna bookmark this. 4 Likes You select the mesh, and go into edit mode. Select all with A, and press U. Press Unwrap. It wont be pretty, but that’s the basic way to do it. In the shaders tab but in a texture of your choice, and move over to the UV editor. From there, just
move around the UV map to however you want it to be. 2 Likes I'm very bad at blender but this tutorial looks very good, thanks for making it! 2 Likes Nice tutorial! I might use this soon, 2 Likes I'm eternally dying. I made typical male hair that you see in TikTok and it has nearly 100K triangles and now that I reduce the size, it looks like deformed
worms that have been spilt and is shaped to look like puddles of ice cream. SO ANNOYING! 4 Likes 2 Likes Thanks, ur tutorial helped me a lot I made this 5 Likes Hey there! Today, I will be teaching you how to script from scratch - all the basics you need to know when coming to script on Roblox with a better and updated version! [If you're a
beginner] After this tutorial, you should learn: Understand the very basics of scripting on Roblox. In this tutorial, we’ll be talking about: Variables, DataTypes. Attributes, Properties. Math library. Conditions,Functions, Loops. Return, Remotes. Gamepasses,DevProducts. Tools,Player, Character, Animation. TweenService, Camera. ClickDetectors &
ProximityPrompts. Mouse & UserInputService. Anticipation and expectations Look, like every other profession/hobbies, it doesnt take straight away to success in learning something new. It is a process, it might be short or long way, but you can’t escape the process. The result doesn’t matter. What matters is the process done throughout the way.
Because during that, you're learning how to be better, and how to struggle with multiple conditions. So, what does scripting mean? When you’re scripting/programming, you’'re actually manipulating, customizing, and making cool stuff using an existing program/system. Meaning, you’re providing instructions to your computer - telling it what to do,
and how do you want to acheive your goal by doing what I mentioned above. On Roblox, you could think of scripting as the Scenes in the back of each game on the platform. And every game you see on Roblox, was made by people who scripted and wrote codes to run these games properly and playable. Let’s dive into the sea! So now that we know
what we are doing and what stands behind it, we should start learning how to implement and write our first codes which would eventually lead to a long process that at the end, we’ll be ready to make our own games. Part 1 Variables A variable is basically a name[ string ] that can hold / have any value. Very impotant! There are few keys that you can
not use as variables, and those are: Defining a variable should look like this: local myVar = 5 --OR myVar = 5 The difference between the 2 ways is: first one is local, whereas the second one is global[ which is slower by the way]. You could see that difference in the following example: --Local Variable local myVar = 0 for k = 1,10 do local myVar = 0
myVar += k print("myVar now equals to: "..k) -- 10 end print("myVar now equals to: "..myVar) -- 0 --Global Variable myVar = 0 for k = 1,10 do myVar += k print("myVar now equals to: "..k) -- 10 end print("myVar now equals to: "..myVar) -- 55 DataTypes A DataType in programming means classifying values and specifying their variables with value
types. [For example : string, number, boolean, table, nil]. In addition to that, it also determines what type of mathematical, relational or logical operations can be applied to it, which would eventually lead us to different results depending on what we used. Data Types On Roblox! On Roblox, we have 6 types of Data Types, let’s review them and see
what they are and what they do. 1. Nil On Roblox, the nil value means nothing/doesn’t exist. And what it does is remove the object/value from your game or and/or its reference. Moreever, luau [ Roblox language] has a garbage collector which basically removes any data/references which are not used/accessible by any script. Let’s see an example:
local part = Instance.new("Part") --Properties part.Name = "Test" part.Color = Color3.fromRGB(85, 255, 255) part.Size = Vector3.new(1,1,1) part.Transparency = 0.5 part.Position = Vector3.new(0,5,0) --Parenting it part.Parent = workspace print(part) -- Test --Delay task.wait(3) --Re-parting it and removing it, so you can't see it. part.Parent = nil
print(part,part.Parent) -- Test, nil --Removing part reference part = nil print(part) -- Nil As you can see, the code above creates a part, changes some of its properties, parents it into workspace, and then to nil, and then setting the part itself to nil, and as you should’ve noticed : Although we parented the part to nil, we still had its reference, hence
that’s why the second print returned us the part, whereas the last print returned nil because we removed the part’s reference. 2. Boolean The boolean value can have 2 values - true or false. Notice that if you set the bool’s value to nil, it would return you false. An example: local value = Instance.new("BoolValue") value.Name = "Boolean" value.Value
= nil value.Parent = workspace print(value,value.Value) -- Boolean, false 3. Numbers A number value represents any possible number. Including decimals, zero and negatives. It is also important to know its limits: Range: from : -1.7 x 10308 to 1.7 x 10308 (around 15 digits of precision) An int value represents any possible integers. Including zero and
negatives. Trying to set an intvalue’s value to a decimal number, would give you the following error: Unable to cast string to int64. It is also important to know its limits - Range: from: -2 ©~ 31 to 2731 - 1. Note: When you're trying to set an int/numbervalue’s value to nil, it’d return 0. And when you're trying to set an intValue’s value to a decimal, it'd
round that number to its closest int value. [ see example below]. The following example is simply creating an IntValue and a NumberValue, and tries to set its values to different time of values. ------ Creating an IntValue------- local Int = Instance.new("IntValue") Int.Name = "Int" Int.Value = 10 Int.Parent = workspace ------ Creating a NumberValue-------
local Num = Instance.new("NumberValue") Num.Name = "Num" Num.Value = 10 Num.Parent = workspace ------ Setting their values to different values------- Int.Value = nil print(Int.Value) -- 0 Int.Value = 10.5 print(Int.Value) -- 11 Num.Value = nil print(Num.Value) -- 0 4. Strings A string value is simply a sequence full of characters [ letters, numbers
and symbols]. Declaring Strings On Roblox: There are multiple ways to define/delcare a string on Roblox, I will show 3 of them: 1.double quotes ("), look at the example below to see. 2.single quotes ('), look at the example below to see. 3.double brackets ([[), look at the example below to see. The following example simply delcares multiple strings in all
3 ways mentioned above. ------------ Defining Strings------------ local Stringl = "Hey! This is a string!" local String2 = '1+1 = 2! This is a string too!' local String3 = [[ "Hello!" 'Hello!" ]] ------------ Printing Strings------------ print(String1) -- Hey! This is a string! print(String2) -- 1+1 = 2! This is a string too! print(String3) -- "Hello!" -- 'Hello!' Converting Strings
— Numbers and vice versa. There are multiple times when you would prob need to convert a string into a number [ or vice versa], a fresh example would be: Say you have a TextBox which lets you redeem players’ IDs, and you want to use the input to do something. You notice that that number is passed as a string. Not as a number. That’s where
tonumber() and tostring() get involved. tonumber() This function would convert your string into a number [ if possible]. tostring() This function would convert your value into a string [ if possible]. The following example would try to convert both a string = number, and number - string. local Number = 1 local Stringl = "Hello" local String2 = "1"
print(Number + String2) -- 2! Since "String2" can be defined as a number , althought its variable defined as a string. print(Number + String1) -- Error! attempt to perform arithmetic (add) on number and string. print(tonumber(String2)) -- 1 print(tonumber(String1)) -- nil print(tostring(Number)) -- 1 print(tostring(String2)) -- 1 Combining Strings To
combine 2 [ or more] strings, you’ll need to use this: .. . See example below: local Stringl = "Hello" local String2 = "World" local String3 = 5 print(String1.." "..String2) -- "Hello World" print(String1..String2) -- "HelloWorld" print(String1..String3) -- Hello5 5. Tables Think of tables as big containers which contain multiple types of variables [ except for
nil]. There are ‘2 types of tables’ that you'll see: Arrays A list with an order, containing multiple types of values. An example: local myArray = {"Hello",1,game.Workspace.MyPart,true) As you can see, myArray contains 4 types of values: string, number, object and a boolean [ accordingly]. Notes: To get a value/ read from an array, simply put a [] and
the index within. For example: print(myArray[1]) -- would print "Hello" print(myArray[6]) -- nil, doesnt exist. To replace an exisiting value within an array, with something else, you should call the index of the value you want to change, and put in within the [ ] when calling the array, an example: local myArray = {"Hello",1} print(myArray[1]) -- "Hello"
myArray[1] = 2 print(myArray[1]) -- 2 Functions For Arrays: There are multiple functions to work with when using arrays, here is the list of them: -table.clone() -table.find() -table.getn() -table.maxn() -table.move() -table.pack() -table.sort() -table.clear() -table.concat() -table.create() -table.freeze() -table.insert() -table.remove() -table.unpack() -
table.foreach() -table.foreachi() -table.isfrozen() I will exaplain 4 of them: 1.table.getn(): returns the amount of items your array has. An example: local mytab = {1,2,6} print(table.getn(mytab)) -- 3 2.table.insert(): inserts the provided value into the provided table. An example: local mytab = {1,2,6} print(mytab[4])--nil local newValue =
table.insert(mytab,5) print(mytab[4]) -- 5 3.table.concat(): returns all the values in your array, separated with the given symbol. An example: local mytab = {1,2,6} print(table.concat(mytab,"!")) -- 1!1216! 4.table.clear(): clears all the values from the given table. Meaning it sets those values to nil. An example: local mytab = {1,2,6,"hey"}
print(mytab[1],#mytab) -- 1,4 table.clear(mytab) print(mytab[1],#mytab)-- nil,0 Iterating/Looping over arrays: To loop over an array, simply use the global ipairs() [or pairs(), depending on your use] function in a for loop. You should also remember that arrays have numerical indices, which means - you can also use a numeric for loop from 1 to the
length of the array (#array). An example: local tab = {4,3,2,1.2} for index,value in pairs(tab) do print(index,value) end print(" ") for index,value in ipairs(tab) do print(index,value) end The difference is that if there was a nil value within the table, pairs would continue counting, but without the nil index. Whereas ipairs would stop at one
index before the nil value, and won’t continue. Dictionaries Extention of arrays.Unlike arrays, dictionaries contain a set of key-value pairs. (where the keys can be any number, string, or object.) An example: local dictionary = { Keyl = "Bell", -- Key,Value Key2 = "Steve", --Key,Value Key3 = 500 --Key,Value } print(dictionary) To replace an exisiting
value within a dictionary, simply specify the key of that value within a couple of []. An example: local dictionary = { Keyl = "Bell", Key2 = "Steve", Key3 = 500 } print(dictionary["Key1"]) -- Bell dictionary["Key1"] = 5 print(dictionary["Key1"]) -- 5 To add new values, simply specify a key within a [ ]. An example: local dictionary = { Keyl = "Bell", Key2
= "Steve", Key3 = 500 } print(dictionary["Key4"]) -- nil dictionary["Key4"] = 5 print(dictionary["Key4"]) -- 5 Iterating/Looping over dictionaries: Notice! ipairs only works with arrays, so don’t try to use ipairs on dictionaries [unless you have made custom functions which would help you with that]. Notice! using pairs would NOT necessarily return you




the items in a specified order, it’s random. A solution could be as the following: --Our dictionary, containing multiple keys. local dictionary = { Keyl = 5, Key2 = 25, Key3 = 500, Key4 = 210 } --A table[to be an array] that will store our values from the dictionary local values = {} --A for loop, to loop over our dictionary and then insert the values into
our 'values' array for key,value in pairs(dictionary) do table.insert(values,value) end --Using 'table.sort' to sort our values with an order. function(a,b) would determine what order we want to have table.sort(values,function(a,b) return a script > tag editor 3 Likes Anyone else having issues with the little “tooltips”, they take extremely long to appear
when you hover over an icon, and they even sometimes appear above other things open within my Desktop. I was just switching to my browser when a tooltip comes up explaining what a part is, above my browser. 2 Likes Enabled the UI Preview, once loaded up a baseplate, the studio crashes 1 Like I really like the appearance of the UI, but as many
others have stated there is some inconsistencies, and issues with the overall UX now. A good example of this, would be that the “Move” and “Rotate” options have been swapped. My muscle memory instinctively would click on the bottom option, thinking that’s Move, but it’s no longer the case. Also, padding is kind of weird; you can see that the
“Geometric” button is awkwardly placed right next to the edge of the Move + Rotate section. Not sure if this is a side effect of something, or if that’s just beta growing pains. It still looks really wonky regardless. Despite what others have said, I don’t actually dislike the centered topbar. The only thing I don’t agree with though, is this awkward empty
space above it. I feel like those icons could just be shifted up as they were before, rather than just making them bigger, and adding that unnecessary claustrophobic spacing. I could definitely get used to it, but having that extra viewport space makes all the difference, especially for laptop screens that genuinely need it. Especially the script editor. My
next issue lies at the Tool Tips that appear when going over icons; For some reason, even when you don’t place your cursor on one, a random Tool Tip will suddenly become visible for no reason at all, and appear to be laggy when being removed, or shown. This same laggy experience, also translates to just using the Ul as it is. I have zero plugins
enabled (cuz at the time it was crashing, and not sure if you already resolved it), but when hovering over icons, it just doesn’t feel as snappy as it once was. I obviously want Studio to become a greater tool than it already is, but as it stands right now, it feels more like an Alpha than it is a Beta. I'm also hoping that with this Studio refresh (again), they
finally fix the weird lagging issues on specific graphics configurations, and actually get Studio to be registered as a High Performance program so it stops being limited to like ~40 for me. It doesn’t seem to just be me who is experiencing that particular issue, either. Why is my Studio Lagging? Platform Usage Support The OP has already explained
that they have done this: I've also been experiencing an issue like this, where Roblox Studio chugs to about ~40 FPS consistently. I discovered that Windows keeps automatically setting it to Low Power mode, so you have to go into the Windows Graphics Settings and forcefully set it to High Performance, which uses your Graphics Card, or puts it out
of Low Power mode. I'm unsure if this is specific to Windows 11, but you’ll HAVE to go in there to fix it, only tempo... (p.s), it appears the Tool Tips render on top of other Windows 5 Likes My complaint is the initial team collab players’ icons weren’t added as part of the ui change, but other than that, it looks really nice and modern! (But can we align
the buttons below tabs to center?) 4 Likes Maybe we will see Roblox Studio out on M1+ iPads in the future...? 1 Like Will there be new documentation for where all of the UI stuff is located on this new UI? Noticed the “Game Settings” button is no longer on the main tab & you now have to go to “File > Game Settings”, if there are other buttons that
have been moved around, it’d be really nice to have it documented somewhere so we don’t get confused or lost. 2 Likes Why does it look like it’s made for mobile, when Studio itself is not available on mobile? Do you guys have plans to port it to that at some point or something? Otherwise I don’t think I can really say much as I'm in that crazy camp of
actually liking the 2012-ish versions of Studio more than what we currently have. Wish that was still an option, its removal contributed a fair bit to me going inactive for a few years back then. 5 Likes Whenever I try going into a game with this enabled, my studio crashes before I can see anything. (i am not pressing anything here, it just crashes) 5
Likes You’'re on to something, I always hated how Roblox Studio’s top bar looked horrible because I was always in dark mode yet the top bar never changed colour. 3 Likes I love this, I will have usability feedback and first impressions later. Super happy to see this Ul refresh finally happening. The old windowing system has been severely getting on
my nerves lately with windows moving around or outright closing (possibly caused by the release of this beta but I don’t care). 2 Likes How do I disable the new UI? I'm on mac and there’s no options at the topbar to go to beta features or anything. Edit: Nevermind, just found out that they made it with the built-in screen topbar. 1 Like You can do this
with canvasgroup already. 1 Like I think what he meant was an Instance similar to a “Frame” that blurs 3d space, if not 2d space as well if the ZIndex is behind everything else, although this is really performance heavy demonstrated by BeamNG which has horrible Ul responsiveness and it’s all to do with how poorly it’s managed using blur and such.
For my post to not get taken down, I will say that the Next Gen Studio UI is the right step for us. 2 Likes Thank god. Studio’s UI has always been horrible to look at. Everything looks fresh. I hope UX was a big factor here. Am I able to delist things that I don’t care about? Am I able to bend studio to my will? If I tell it to bake a cake for me, can it be
done? 4 Likes Why the massive change to the layout. A lot of people have muscle memory on current studio and this just throws all that to the gutter and hurts productivity. And it doesnt look like its so good it benefits anyways after re-learning the layout. Keeping the visual change but keeping the old layout, especially with the buttons pushed to the
left instead of center would be preferable. 9 Likes That’s not what I meant, each corners would have their own Udim value, just like in Figma or any other UI editing software, each corner can be rounded to a different value: 5 Likes Oh! I meant that I think it should use one on Windows too. It very much does not have one at the moment 3 Likes Page 8
You can still achieve a similar effect with CanvasGroup though. 1 Like Honestly the new UI looks not that good In my opinion, I personally like the 2019 UI. like the current Ui personally i think it was terrible enough when it frist came out. And I don’t see why do we even need the home, model avatar, Ui etc... tabs in the middle. I would complain more
but I can’t even use studio because is crashing 24/7 8 Likes Sanjay: Am I able to delist things that I don’t care about? Am I able to bend studio to my will? Soon - they said it’ll support custom tabs down the line! Sanjay: If I tell it to bake a cake for me, can it be done? The cake is a lie. Do not listen to its siren song. 2 Likes It does have one on windows
11 (i think?) 2 Likes We're talking about the ones on the plugin tab, there isn’t one there for me 1 Like That’s a native Qt component rendering a Win32 era drop shadow, so it’s not quite what I mean 5 Likes Also, how come this is like the only Ul element that doesnt have rounded corners? Its kinda odd since the buttons in the dropdown ARE rounded.
2 Likes It has rounded corners on Windows, it seems that there a few differences between the windows and mac builds Paul: Completely new menu system (on Mac these will appear in the MacOS menu bar) This looks really bad, and removed some very handy features. For example: When selecting an experience to work on (in the Main Menu), i used
to be able to select Recent Games, and would not have to go onto Finder and select the placefile from somewhere on my hard disk. With the new Beta, I have to find the file manually, which is really annoying. 3 Likes It seems really good, but Studio crashes with no error message when I enter any place with this enabled. Wish I could try it out. 3 Likes
No idea! I've only just been introduced to this new UI so I don’t entirely know how it works. The new UI will take time to get used to, however I do appreciate the modernization. If I recall correctly, didn’t the initial preview shown at RDC have a darker theme? Any chance we will get that? I really liked how it looked 4 Likes Mine is also doing that, I
have tried removing all of my plugins yet it still crashes. (removing plugins suggested by someone else) 3 Likes I don’t like how flat it is. There’s empty gaps in unexpected places, and removing borders is fine but atleast make it more compact, or else you’re wasting space. Thought Put In : 8/10 Actual UI Design : 3/10 4 Likes The darker theme will
come when it is fully released or most of the components are redesigned 3 Likes Finally the new thread is here! This will definitely be a better way of seeing the feedback. A couple things that i want to mention here (even though they’re probably mentioned above) is that the new functionalities and menus are lacking in a lot of ways. For example, in
team create i cannot save the place to a file. And some custom functionalities are still missing, but i am excited for the upcoming updates that will hopefully bring those into reality. Thank you again! 3 Likes Looks hella cramped, i feel like the buttons are too small and the icons make it all look weird honestly. Will we be able to keep using the current
UI without being forced to use the new one? 4 Likes I don’t have alot to say, But I do believe it is an improvement. It looks clean and alot better than the current version in studio, but I do feel studio loses some of it’s identity, And I am worried about icon projects like vanilla. 1 Like Exodation: Will we have a feature to use the legacy UI? No 2 Likes
YES! YES! YES! WOOOO0O0O000000000000! FINALLY! I've been waiting for this ever since it’s first concept shown to the public! YES!!! This UI looks so good - I CANNOT wait for this to be properly updated for all the other Uls!!! Looking forward to this - And being sure to KEEP THIS ON! Studio looks so good now. Just 1 suggestion - PLEASE let
us use our own color3 value for themes instead of the regular dark/white. It'd probably be insanely easy to impliment and would make looking at Studio so much better. Possibly a image background option for the script editor too? 2 Likes Page 9 I haven’t removed any plugins, but that might be a good idea. The crashing might be because of the fact I
put some shortcuts (mainly the hide UI button) on that quick bar which seems to be removed? I'm not certain. Maybe it’s the fact I don’t have the new beta camera enabled or something. 1 Like Exodation: Will we have a feature to use the legacy UI? Until around spring of 2025 yeah 1 Like By making four different frames with different values for their
UlICorner? This is not a solution, just a workaround, editable UICorner is what would be an actual solution. The new native UI editor hints at this, so I wouldn’t be surprised if it was coming soon 1 Like Yet another UI reskin instead of actually useful features. Way to go! 3 Likes I wish yall didn’t make a generic type of ui and made it way more fancier.
It feels kinda boring but better than what we currently have. Well, it is kinda nice. Only thing that really bugs me is that i cant hide it like the regular version. 1 Like Hopefully you guys change the tabs as well and make the theme darker. It looks really good so far and the idea of having a separate tab for each thing is great. But hopefully the theme
also gets some love. Paul: Padding, spacing, and layout values are a work in progress Please consider making the Uls as small as possible (no huge buttons like you’'ve added for the top tab with dead space around them). I've known quite a few people who’ve mentioned that they like to have about 4 windows open around their center workspace
window and the workspace window keeps getting smaller and harder to view. I know the windows are resizeable, but only down to a point. This is the main reason I bought a 2nd monitor, so I could stuff all my other windows there and keep the workspace window as big as possible to work on small detailed stuff. Hopefully this update cures the bug of
some windows moving up on the second monitor every time you open Studio. 7 Likes They added new stuff though? They didn’t just change the icons and can it “next-gen”, they had to rewrite all of it in Luau. 1 Like Turns out that I didn’t disable all of my plugins, there were still 3 left enabled. Disabling them caused it to start working again. So yeah,
try disabling all of your plugins. Yeah, I'm hoping too that it will soon become an actual feature. 100% absolutely working towards this. 17 Likes This part is actually better than the old one (even saving vertical space): but everything above that looks terrible, here is why: Too much padding everywhere, everything looks so empty The top buttons are
taking way too much of the already valuable vertical space (again too much padding) The top buttons look like they were made for mobile devices? it’s all much bigger than it needs to be, why? What about the hide option? I travel a lot and I work on my laptop, there’s usually not enough space on laptops so I hide the top menu and I move everything
necessary into the quick access (great feature by the way), this will be so laptop unfriendly Where is the quick access? lack of customization... Why do we have a double menu now (the bar with file, edit, view... and home, model, avatar...)? why don’t we keep the old layout that most of the programs use since the 80’ (we could just “refresh” the design
of the old layout to look more modern), we could have all the buttons in one row, check the top bar that Blender has, they did a great job distinguishing the dropdown menus and the tabs. Why isn’t the top bar (with the home, model... buttons) separated more visibly? changing the background color could make it visually more separated Why does it
still use the old Win 95 dropdown menu (with no corner radius) on Win 11? I've seen many other programs use the Win 11 dropdown menu? Why does Roblox Studio now look like a simple program for kids? 13 Likes The only thing it benefits is internal developers. They did not need to fix what was not broken. I am talking about actually useful engine
features. Like a proper graphics API for PC clients, or a physics update. 5 Likes As of currently some plugins seem to cause a crash with this Ul. Paul: The background colors are not final — we had to compromise to accommodate old UI Does this mean we will get the darker background colors as shown at RDC? Or even better. Custom colors? This
(currently) also seems to be missing the tabs it had 5 Likes now you point that out it’s annoying me and haunting me Looking pretty good, hopefully we’ll have improved performances when using it and not feel like 30fps 1 Like I HAVE BEEN WAITING FOR THIS FOR SO LONG unfortunately this first beta is pretty unusable since it lacks the view tab
and when you hover over something the info box never disappears 2 Likes removing Qt?? oh no if it was done in Luau what level, CoreScript? uhhh Page 10 i will figure out a way to access CoreScript and DELETE this ui. 2 Likes LOL fixed to say Luau The good news is it’s so much easier to change styling and layout in this new implementation. Which
means it’s faster for us to iterate on improvements like you mention and it does mean we can offer more customization/personalization in the future. I can’t begin to describe how hard this would be in the old UI. 15 Likes It is done in LuaU it seems to be in BuiltInStandalonePlugins The source isnt available tho (sadly) Also studio does still use Qt they
didnt fully rewrite the entire thing Will we be able to port these to different UI libraries? I want to use Aegis for my plugin projects 3 Likes I’'m so happy to hear that the update has officially been announced as I've said in the linked topic below ‘Roblox Studio’s new UI?’ that I was excited for it. Finally, We can compare to Unreal Engine for once...
CaspianLake: They did not need to fix what was not broken. “Not broken” is subjective when it comes to design. I think the new UI looks more modern, and the old one a little aging. The team that works on the physics system is working on Aerodynamics and Fluid Forces, and the Rendering team has worked on Future lighting for Android. It’s not like
working on a Ul refresh slowed down the progress on either of these things, because these are different teams with different expertise in different areas. You can’t just have more people indiscriminately work on something and expect it to happen faster. I've heard that Roblox’s porting of React as react-lua (which they use for all their app UI,
including this one) is specifically to entice Meta developers, who won’t necessarily have the expertise necessary for implementing Physics features. Some of these (like the graphics API thing) are tough problems. 5 Likes This is really going to change studio in a positive way. Great work! Is there will be a way to hide the Next Gen... bar? Like that old
UL Because I have 1024x768 monitor, and viewport is small for me. 4 Likes I think it’s pretty great. I think it looks more visually appealing though right now even while in beta i can’t exactly call this a next gen ui or whatever. Maybe some day in the future but not now. My issues with the new top bar are the following: Drop down’s are harder to
access due to the small right side bottom arrow of each icon. The fact that the play button has an even smaller arrow does not help. Quite a few features removed such as the ability to physics pause and plugin groups. Other features have been moved to the small left side top list of drop down menus. I can’t say this is entirely bad however since the
current ui lacks any sort of customization i can’t really see this as a good thing right now. The amount of empty space is insane. I do understand the idea however right now it just dosent look that great. The plugins tab got it the worst. Maybe some clear dividers could help? Docking still sucks, roblox pls fix Other than these issues, i think its great.
Here’s some of my feedback for it: All light instances should probably get their own section/label. Not sure why they are being held within the Effects tab. Since the scripting tab is now always visible, whenever you aren’t actively looking within a script the “Find...” button should just open up the Find All menu. Or maybe straight up just remove it
when a script isn’t open. This sort of behavior should be customizable by the user. Add/create a new menu to manage all open windows. The CTRL + Tab one is mediocre at best for that job. Allow for resizing and repositioning of the top bar? Repositioning it like placing it sideways somewhere else may be a bit past the original but at least letting us
change its thickness should not be too hard to implement right? Entirely ditch the arbitrary bottom bar and instead make the command bar and diagnostics bar separate items rather than things baked into one singular menu. Give the diagnostics bar more labels. Such as VRAM utilization, quick luau vim memory utilization and similar things like that.
Add a menu somewhere close to the actual viewport (pls make it customizable!) to hold all of the viewport related features like wireframe view and material grid. With this maybe throw in more rendering related toggles like a “No Lighting” button which would remove any sort of lighting or “No Shading” which yeah, would do as the name suggests.
Some of the drop-down menu’s have no corners nor any background shadows so they just end up blending in into the rest of studio. Add some quicker and easier ways to modify the viewport’s resolution. The device emulator works for what it is but its often too restrictive for no reason. It’s hard to test multiple resolutions without stopping and starting
numerous play tests over and over. No 4k limit either pls! 3 Likes FINALLY, THANK YOU ROBLOX FOR GIVING US THIS NEW UI. Um, my studio just crashes when opening a place... 1 Like Aerodynamics and fluid forces, yet the core physics engine is still an absolute joke even with the limitations of Roblox. “Future lighting for Android” Roblox uses
DX11 for lighting and its very funny that it is worse than some OpenGL engines. I am talking about an actual proper lighting tech, unique to PC clients (the support for selecting different lighting for different clients is already there). I know moving people from Ul to graphics isn’t possible, I very much know graphics is a very complex topic. However
instead of spending resources on features that will be left half baked and with niche use cases, or features nobody really needed, it can be spent on fixing the long lingering core issues of the game engine. 3 Likes This seems to be caused by some plugins try disabling some of them. I'm currently trying to figure out what plugin exactly is causing this
I'm glad to hear that I'm not the only one crashing when I use this preview. I had to unwillingly accept to ROBLOX’s new terrible policy to even use Studio and/or test out the new beta feature, only to find that I cannot use it due to the crashing. I didn’t want to train the Al. 1 Like A friend of mine is also having this issue. just... can’t open any place
without it either hanging or crashing. That’s one thing that I've noticed - This implementation is... well... A little unstable. But I imagine it’ll get better. For now, I guess - Try just turning it off. please don’t change the Ul, it will take a long time to get used to this 5 Likes Do you have the Render settings plugin by @TheNexusAvenger installed? That
seems to be the issue (for me) ( 2 Likes Here’s my opinion: IMO, it’s essential for the in-game other Studio UI to be updated to align with the current design. The new U], as it stands, doesn’t seem to match with elements like the ‘Explorer’ and ‘Properties’ etc tabs. Despite this, I still find the changes to be AMAZING! 1 Like This new Ul is great, but i
think that the docks (like Toolbox, Explorer, ...) don’t look like the topbar, with the rounded corners and icons. 1 Like Page 11 ah, interesting then it’s compiled Luau Bytecode hmmm 1 Like Suggestion: Adding the thing back that allows you to close and open the panel because for some of us it takes up too much space of the screen when always open,
and when you close it should only show this: 4 Likes we aint on windows here... its possible that they add it Honestly the new Uls looks way cleaner and way easier to understand than the old Uls, the only issue is some of the menus go off the screen (for me atleast) as the images show: but overall its way better and honestly i will use it from now on 3
Likes Basically what I said. I think it doesn’t match that good with other Studio Ul sparkl3: IMO, it’s essential for the in-game other Studio Ul to be updated to align with the current design. The new UI, as it stands, doesn’t seem to match with elements like the ‘Explorer’ and ‘Properties’ etc tabs. Despite this, I still find the changes to be AMAZING! 2
Likes It was the same plugin for me, so I did some digging. Apparently this causes the crash: local plugin = PluginManager():CreatePlugin() local Toolbar = plugin:CreateToolbar("test") -- you need to actually interact with the plugin variable for the crash to occur 1 Like Super excited to see this starting to become available! I have been waiting for this
particular update for a long time!! I pray that you guys not only fix issues with the current multi-client test feature, but improve the user flow for it as well. My biggest gripe with studio currently is the terrible UX when trying to run a test with 2+ clients. I love the move to a more custom UI layout and I hope that this layout will better accommodate
the plethora of features present in studio that weren’t there previously. I am looking forward to custom tabs as well! I hope it will work as a drag-and-drop style system where I can create line-ups of my own most used tools. Amazing work to the team, I know this has been long in the making! 1 Like Happening to me as well. No matter if I load a small
game or a bigger one. Ty - I think we’ve narrowed down the issue to plugins using a deprecated API. We’re actively working on a fix now that should stop the crash and allow those plugins to be used and function as expected. For now, a workaround is to disable those plugins. 5 Likes More crucial screen space being taken up for a... blank bar with a
bell and text? Everything needs to be smaller. If this UI really is now built with Lua, it clearly shows, with some of the popups and dropdowns clipping outside of studio: I'd also like to show off how large each entry is in the tabs. It also appears that the only customizability we will have is the ability to make more tabs, to shove our random garbage in,
mostly plugins, since tabs will run out of space a LOT. The dropdown menu has no outline or shadow. It just covers whatever it’s on creating a weird effect for other elements with the same characteristics. It also appears that some of my plugins, which were condensed into one dropdown menu themselves in the old Ul, have ungrouped in a sense. Not
sure why that happened. I posted this in the New UI discussion thread: It unfortunately appears that the Ul team has decided to only make the topmost menu compact and simple, while the ribbon bar remains oversized and bubbly. I was hoping they’d change that, but it appears the redesign will be inconsistent and harder to manage. My attached
image would be ideal to work in when it comes to Roblox Studio. Everything would fit. The explorer, properties, and many other menus already have this kind of style. Why make everything inconsistent by shoving an inferior design into it as well? Perhaps it’s simply to mimic the inconsistencies found in Windows 117? If I am able to customize the new
UI to look compact and professionally designed like it should’ve been, then I have no problem. Otherwise, I will consider this a visual downgrade. Any particular reason on why it can’t just be rewritten but maintain a sensible UI? 14 Likes The only thing that’s been redone in the current state of this beta is the ribbon UI at the top. 70% of your
complaint here is about Qt and not the new UI lol 8 Likes This is still a beta feature, many things will still change with the help of good feedback, be patient! 1 Like looks good, modernisation of ui is always helpful however it would be nice if everything remained in a similar position Keeping it simple: looks great but there’s too much empty space (the
top Ul is so big!) 1 Like Please add this in the new beta that’s just what I need 4 Likes I personally do not like the new “modernisation” ui design which is a copy from Microsoft that companies are all trying to do, just stick to the same layout but update all the code behind it and fix the issues, it does not need to be changed this drastically and
pointlessly moving stuff around to be miles apart or hidden behind extra steps messing with years of muscle memory that people have built up. If this is going to be added regardless of what people say at least add an option to use the old layout or edit the layout to the point it’s literally the old layout but with the new code behind it because it’s not
going to be fun having to relearn the whole layout when just trying to develop when the layout was never an issue and everything was where you needed it. 5 Likes There’s a trend where every single Roblox redesign is bloated and uses space worse than their legacy counterparts. Will we ever get the option to have a “pro” mode that wastes less
space? I understand the tool is meant to be intuitive for new users, but some of us are using Studio 10 hours a day, we don’t need half an inch of vertical space being used for 4 tab buttons- we’d rather see additional information, shortcuts, and plugins. Also, when can we pop out viewports again? This has been missing for several years. 9 Likes It
crashes for me, this is something you can look into 2 Likes Also, when can we pop out viewports again? This has been missing for several years. You can do that today - they added this in the docking controls beta. 4 Likes I like how the current Ul is just fine and dandy, already know where the icons are despite having changed left and right a couple of
updates ago, but the next-gen Ul is just a topbar got a new coat of paint and a bit of spit from Waiter at Olive Garden. This feels more like mobile UI than just being the next “Unreal Engine” or whatever people are using atm that is not Godot. It needs more thinking before it becomes its own thing, or even allows us to use the legacy version of Studio
UI. Right now, it takes way too much space than it needs to be and it will ruin people’s experience of using Roblox Studio while they have to deal with smaller screen resolution. 5 Likes Page 12 I've noticed an issue where all buttons, except for the tabs, still activate even when the cursor moves away after clicking. It behaves as if MouseButton1Down
is used instead of Activated on a GuiButton. This means you can’t cancel an action by dragging the cursor outside the button area like you can in most other programs. 3 Likes I really like the new design but when I tested it, Roblox Studio crashes whenever I join any place. 2 Likes Actaully im using 15.6 inch scrren and i will not use it and i hope
roblox never force users to use it. If u want make UI for mobile then do it. But give choose. 3 Likes The UI Ribbon is too big. This will be problematic for designing UI. If you can, make an option to make the Ribbon shorter or collapsible as it wastes lots of space on my workspace. 3 Likes Really. What is the point of moving tabs from top bar into the
second bar? What I see it’s only waste of space. Would be better if u add properties options to right click on part. There are many thing in the interface for improve this. But nope. Roblox has to fight with with studio like with hedgehog. And now they pricked themselves on the tongue. And next year will be like improve new interface. Would be better
if you add possibility for total customize interface. like adding own tabs and placing every button there. Just leave this interface pls. 3 Likes I'm not sure if this is intentional, but the plugin sections seems to no longer display the PluginToolbar names, and all of the PluginToolbarButtons appear next to one another with no separation. Unless a user
specifically knows which buttons were present before, and which new ones to be aware of then knowing what buttons a new plugin has added might be difficult. I also think that the PluginToolbarButtons in the dropdown should be separated by the PluginToolbars that they belong to too. Not separating buttons would mean that if two, or more plugins
used similar naming conventions like ‘Edit’ then the user would not know which button is which: //devforum-uploads.s3.dualstack.us-east-2.amazonaws.com/uploads/original/5X/f/8/c/d/f8cd9cfdccba42d4bc41cd5d5fc4a44c34e83601.mp4 2 Likes I enabled this and now when I open a place, it crashes my studio. 6 Likes personally i like the current
version and the next gen looks so confusing compared to the current version. When this UI is fully added to the studio will there gonna be a option to change between current and next gen Ul ? Turn off the beta, disable all of your plugins, then reenable the beta, should let you in to a game. 1 Like phew just clicked color and studio turned off 1 Like
Does anyone know where the undo button is? 4 Likes Well look like there’s going to be backlash until people are going to get used to it. Removal of the play section was kinda annoying Elements take up too much space (liked it when it was compact before). Signs of oversimplification (hiding descriptions of sections) Overtop bar has more height than
before which was pretty unnecessary. Could’ve sticked with smaller tabs No view menu?? Might confuse a lot of people on finding utilities for development Overall I understand this is a beta and is subject to change but this needs to be fixed to appeal to your frequent developers. Eventually, this demo would make a great change in productivity. 7
Likes I've disabled all plugins and removed all local plugins and it still crashes. Update: Toggling plugins on and off, restarting a bunch, and switching accounts in Studio and back again, eventually seems to have fixed the issue. Can you share which API is the problem so we can make sure it’s not in any local or our own plugins? me too. Studio
crashes when i open a place Not sure if I'm the only one having this issue, but I cannot use studio after enabling the beta. Anytime I open an experience, or a new baseplate, my studio crashes. Disable the beta and it fixes it. 1 Like There’s an issue with an API call and some specific plugins (mostly older). Disabling plugins will allow you into the beta
until we roll a fix. @tnavarts look like your edge align plugin causes studio to crash with this beta feature enabled. 1 Like Some of it is good, but I don’t like how plugins are collapsed into a dropdown menu if there are too many of them. Definitely needs work 5 Likes I'm not experiencing any type of issue mentioned in this whole thread... There’s no
crashing, not slow at all, no UI cutoffs and the tooltips are a tad bit slow but it doesn’t bother me at all because I just use shortcuts. Yeah needless to say, I LOVE THIS NEW UI!!! 1 Like Page 13 i actually like this UI but my only problems are: the spacing (that was already named) and the plugins menu because the buttons can no longer be
distinguished from which plugin they come from 1 Like Really happy to see Studio getting a facelift- and it looks quite good. As a Mac user I'm glad to finally have a functional Help search bar. I have been searching for the Emulator button for the past 20 mins and can’t seem to find it. Anybody now how to enable it? 4 Likes It has been renamed to
Device apparently 3 Likes Ah it’s been moved out of the toolbar into a menu. Thank you I need the plugins, I can’t just disable them Thanks for being willing to listen and communicate with the community even prior to this launch, it truly means a lot. I already see a lot of potential with this new beta and I'm super excited to see the UI continue to get
polished. I really love that MacOS now finally uses the menu bar for everything, it feels so much better Keep up the great work! 1 Like Just noticed too that the ‘Download Copy’ button is no longer present! Quite an important one that I use often. 3 Likes Can this be disabled? Roblox Studio has a 100% crash rate for me. 3 Likes I’ve been using the
Roblox Studio for about 2/half year now. I think my suggestion is shrink a little bit about the upper UI of the studio so we as a game dev we can have a lot of space on the screen specially to me having a 14-inch screen display or maybe setting for that about adjusting the UI size just like Android Phones in the settings. I would love to see that btw. 2
Likes +1 to this, having all plugin buttons visible without being in dropdowns feels really weird. It feels like a step backwards, since this update compressed a handful of buttons down to one dropdown menu (such as inserting a Script) This could just be a result of the new dropdown behavior? Not too sure. 5 Likes I wish they’d Luauize the Qt instead
and make more hooks 1 Like I've noticed that the Download buttons have also been removed from all places in the Creator Hub dashboard as well. ‘Download Copy’ button is no longer present! 5 Likes studio crashes when i open a place with the preview enabled 1 Like Are you guys trying to remove QT? 1 Like Mostly because Roact is slow, not sure
about the polyfilled React 17. 3 Likes Anyone know how to save to file? or am I just blind (also my bad if such a post already exists, I have read many of the posts here, but not all of them.) 3 Likes Eventually! Studio has a lot of UI, much of which is built by the community, It's going to take a ton of time and effort before we can get everything updated.
So before we go too hard in that direction, we’d rather get feedback and iterate on the “core” Ul first. 6 Likes Personally I am not a fan of this new UI. Please allow us to choose which Ul we use, because I would not like to use this. 5 Likes We believe it’s the PluginManager():CreatePlugin() call that’s causing issues. We’re working on fixing this now
so that plugins using this continue to function as expected (as well as not causing a crash). I don’t have an exact ETA for it but it’s actively in-progress! 4 Likes this is where i feel bad for people who are using low resolution displays, there is no way enable compact mode just as the old ui it’s a simple quailty of life feature they so happen to remove?
like with this update, the ui went 5 steps forward and 10 steps backwards i know this is a beta preview, but it’s worrying on how some qoi features just got outright removed (1536x864) even on a modest resolution of 2016x1134. the prevalence of the topbar is an annoyance, especially when scripting 9 Likes Page 14 That’s quite weird, it’s there for
me Paul: I can’t begin to describe how hard this would be in the old Ul Just knowing it was in Qt is enough for me to express my condolences. I'm very firmly on the side of Roblox redoing it in Luau, even if it looked exactly the same, since it’s so much easier to work with. Plus we can all use more Roblox dogfooding their own engine. I know you guys
do it plenty with the LuaApp, but it’s still awesome to have more of it. I think it kind of flickers on and off. I do think this happened with the default layout, but instead would have a “Download a Copy” button that did the same thing. I like to keep a copy of my game on my PC in case anything happens, so I hope to find a solution or reason why it’s not
there. are there any plans to eventually combine the menu bar with the title bar like a lot of apps on windows do nowadays? 5 Likes unfortunately cannot test this beta feature out as i crash every time i open studio with the beta enabled 1 Like Thanks! Was able to launch studio with -disableL.oadUserPlugins to disable the Beta Feature. 1 Like There’s
absolutely no “re-skinning” here. The new Ul is a whole new chunk of code from the ground up, The old UI has suffered many years of fairly inconsistent Ul implementations which make it impossible to simply migrate to a design system. It will take time and coordination with other teams to migrate old UI to the new Ul frameworks. For third party
plugins, it will be on those developers to get them up to date. We will provide a combination of modern Ul components and resources to help them get moved over. But it’s a little too early for that right now while we are still just getting feedback. 24 Likes I've never tried React myself so its hard for me to make assumptions on it (since i use Fusion
v0.3). On the other hand, they’re working on improving performance. I wonder how would that work? Optimize React internals? Optimize components themselves? We’'ll see. bffr it’s a half-axed ui overhaul... 1 Like Please ensure that all users have the option to use the old ui. The new ui for me looks horrific and massively ruins a lot of the functionality
of everything being compact. The new UI makes the top left buttons smaller (File, edit, view etc.) and also separates buttons from the single ribbon to two separate ones, which is not only unnecessary, but where are there duplicate tabs for plugins in both ribbons? The last UI overhaul was awful and immensely ableist due to its reduction in colour-
coded icons for instances and the tool buttons within the ribbon dropdown. This just goes even further into making the icons more complex and poorly sized, as well as generally ruining people’s existing muscle memory. Solid colours being removed resulting in the tool icons becoming only lines massively reduces their distinction and makes it much
harder for those with vision disability to use studio, i.e. astigmatism. Strongly reconsider the mistakes in this “Next Gen” Studio UI. At the bare minimum give us a fully functional option to use the existing Ul, and don’t deprecate support for it in the future either. More options for developers is better. I already see atleast 10 other replies also asking
for the option to use the old Ul, so don’t ignore actual developers this time, Roblox staff. 3 Likes No. How do I turn it off? I never asked for my studio to be forced to look different in a way I do not like. If this new “look” is forced, I might reconsider switching to UE5 for the 23987th time. 4 Likes My only real issue with it currently is no way to
hide/show it like the old Ribbon bar. It currently just takes up too much space for me to be able to keep it enabled Sorta? On MacOS, you automatically get a search option in the Help menu. This is provided by the OS so there isn’t a windows equivalent. Where you thinking of a search bar in the Plugins menu? Tab? Both? 3 Likes Yeah I've noticed
padding taking a lot more space and no way to collapse this ribbon. Might be temporary regression. Not all of us can afford to have 1080p, 1440p or 4K (i have 1080p but yeah, takes more space compared to old) 3 Likes That’s a reasonable concern. Do you think custom tabs where you can put any combination of tools you’d like on a single tab will
help? Do you utilize shortcut keys today? 2 Likes We have discovered a crash with what appears to be older plugins that make a call to a deprecated function. Not something we could’ve caught with our testing (and we do test against popular community plugins) Hotfix is in progress. 2 Likes Hey Paul, great update! I was just wondering if you guys
will bring back collapsing the top nav like the old UI? 3 Likes Next Gen Studio Ul Preview is here! [Beta] Announcements We have discovered a crash with what appears to be older plugins that make a call to a deprecated function. Not something we could’ve caught with our testing (and we do test against popular community plugins) Hotfix is in
progress. 2 Likes Also not a big deal, but the main center nav doesn’t warp so on small screens might create some issues 4 Likes sparkl3: IMO, it’s essential for the in-game other Studio UI to be updated to align with the current design. The new UI, as it stands, doesn’t seem to match with elements like the ‘Explorer’ and ‘Properties’ etc tabs. TomoT:
This new Ul is great, but i think that the docks (like Toolbox, Explorer, ...) don’t look like the topbar, with the rounded corners and icons. There is work in progress 4 Likes Page 15 Almost certainly, yes. Ultimately we want to Studio to be flexible enough to be useable without a ribbon at all. 7 Likes I'd also like to bring up concerns about having no
access to view selector, outlines and some other features which are rather miscellaneous (outline selection, screen shot, video record, etc.). Elttob specifically mentioned screen shot missing (apparently its bound to Clear so go apple keyboard or go home? What about Quick Access? I have some plugins like light editor or load character there and I
don’t wanna spend extra clicks going to my custom toolbar just to use it. I assume all of this is under consideration, I've tried it but haven’t stumbled across major/catastrophic issues so far while testing it. Performance is better than before FFlag version too. 1 Like The New UI is very good, i hope the current font on studio will be replaced by “Builder
font” and the homepage must be redesigned to match with creator dashboard UI style 1 Like View selector is here: Some options are indeed missing though. I noticed that Reload script is not there too. 3 Likes apparently it’s due to plugins. try disabling some 1 Like This is unrelated to the TOS update. They just happened to get released around the
same time. 1 Like I don’t really like the way the buttons at the top look, they look weird to me but the icons look good and I like the idea of a new look 1 Like If you don’t like a modernized, bulky ui then buddy you’ll HATE ueb. 4 Likes can we not shrink the top bar anymore?? i hope this changes (i can’t test cause it just instacrashes) it’s actually not
good to have LESS screen real estate vertically, most monitors are wider than taller, and that’s the last place i’d want waste 2 Likes For some reason whenever I hover over any of the items on the top bar, the drop-down menu that appears when you hover over them, keeps vibrating very violently You can’t see it in this image, But I can assure you that
it definitely does shake in studio. 2 Likes honestly i agree with why people are criticizing this. i really don’t like how this is some new ui but its still blended with the “older” Qt ui, it just feels and looks weird. i honestly don’t even think this change was necessary at all, studio is fine as is. replacing the ribbon just seems useless. if you are going to
actually implement this please keep a toggle for the “legacy” gtribbon. as im sure not everyone will want to use this. 2 Likes roblox studio is NOT roblox studioing anymore (closes itself when I try to open a place) 2 Likes Is to cool but confusing because this is hard to find the things 1 Like Honestly, a blender 2.8 styled approach would be great. Saw it
in some of the concepts for this overhaul, and having the toolbar be inside of the viewport like blender would help a LOT. Honestly, blender 2.8+ is the kind of direction id love to see this go. Love the new UI so far, but I'll probably not switch to it until all of the missing features mentioned in the original post are back. Example pic: 8 Likes The only
issue I have with this is that its more confusing to navigate and find some options that were normally easy to find and use on the old UI. For example, the Device button used to be easy accessible, now its located within small button in the corner of the window. Its cool and all that this is here, its been a needed feature for so many years now, but in my
opinion the UI should still maintain the same accessibility and convinience as the old UI while also improving upon what made it bad, as opposed to a change in layout with features seemingly missing or placed somewhere only a few people would actually look. That way its easy for people who used it for many years, and or new people who just
started. In general, the Ul is mix of good things that are well done which was very much needed, and bad things that make studio more inconvinient to navigate. 2 Likes We definitely want to get back to improving the docking system but it will be independent of this work. 1 Like Seems unrelated but I'm unable to clear my custom icon dir? Every time
I right click or press it prompts me to add a new one. 1 Like It’s probably not a performance crash but likely due to a known issue with certain older plugins. The team is actively working on a fix for this. 2 Likes Paul: We will provide a combination of modern Ul components and resources to help them get moved over. Does this translate to providing
React components that match Studio’s Ul, or does it mean GUI elements that mimic their behavior? I don’t really use React for much but I do like my UI to look nice, so some clarification would be nice, haha. 2 Likes Page 16 There are features missing such as Import 3D (The one that can handle up to 20k tris) unless I'm blind. 1 Like Everything is
there, if not try the Window menu 1 Like Suggestion: add custom skins to Roblox studio so we are free to customize studio 2 Likes it def its there under File 2 Likes I do have issues with the Drop down menu, especially when you try to create a part, trying to re-open the dropdown by clicking again does nothing, you have to move your mouse to a
different button then move it back again to have the change of opening the drop down again once. Muscle memory issues on my end because you guys moved Rotate increments at the bottom and Move increments at the top, please reverse this change because traversing the menu is already difficult. And can we please get the “View” tab back? The
awful and ableist builder font should not be implemented into studio. Its readability is awful. 3 Likes Try View Menu > View Selector toggle. It’s not a very intuitive name, in my opinion but that’s what it’s always been called. We looked at the usage of the screenshot and video recording tools. They were extremely low so we assumed most creators use
the built in OS screen capture tools. Is there a reason you prefer the ones in Studio? 3 Likes It would be nice to use the ones in studio but I think we have all been conditioned to use stuff like OBS because the screen recorders in studio and the client suck And idk if this was ever changed since the last time I ever used them was 4 years ago I loaded
studio, set the Next Gen to enabled, it asked if I wanted to restart, and then it tried to restart and totally closed out. I tried to then just start studio again, and it totally closes out. Tell me, I can undo this without having to reinstall studio. You can use device emulation and Screenshot feature to generate a higher resolution photo. Or capture its the
viewport via OBS (Game Capture) to record something in 1080p or more. The usecase I've seen was recording Moon Animator playback. My usecase is getting crispier photo without upgrading my monitor (helps avoiding aliased surface GUI'’s if you scale down photo to desired resolution) It is rather specific, but it does have a use case in some
scenarios. But I expect anything rough to be smoothened out in the future. It just needs time and feedback. 2 Likes The one’s in studio are extremely useful for high quality screenshots. For example, you create a new device with 4K resolution and then set it to show as actual resolution. When you then take a screenshot with Roblox Studio’s feature,
you get an uncompressed 4K image. OS Screenshot tools are harder to use (cut out, time, resolution). Please bring it back 3 Likes my studio always crash when i try loading any place Idk if this is out of scope for the feature but it would be really useful to have sort of “layouts” of studio that you can switch between and more specifically it would be
lovely to have studio automatically switch to a specific “test layout” that you have designed. For example when playtesting my games I would like for studio to automatically close opened widgets, currently to enlarge my resolution I have to close widgets and other windows and doing this everytime I playtest does get tedious. Also, you don’t seem to
be able to make the topbar disappear? With the old UI you could click a little arrow to make the top portion of the Ul mostly disappear but it seems removed now? 2 Likes Current one is better but this new one can be way better if ux team listen to the feedback. Lets not forget what happened when they switched explorer icons, it was terrible but
eventually they got it right. I like the new icons, but why is there so much unused space? I feel like it should maximize the viewport - here’s an idea of what I think it should look like instead, which would eliminate the wasted space and would also keep the play button on the right. It could also be a good idea to put an Output button in the blank space
on the very left, since that’s something people use a lot. Accidentally sent before I talked about the modularity though - love that part of the update a lot and look forward to playing with it. 17 Likes Tell me you didn’t read the announcement notes without telling me... This screenshot you show is the goal we are working towards. More detail: We
couldn’t change the top to the darker background without it looking really weird against the rest of the UI. But we also couldn’t change the rest of the Ul to the darker background without all sorts of issues. Example would be some dev at some point used a random, hardcoded color value for a text label that’s very close to the new dark background.
So when we switched on the background color, some text “disappeared” — not impossible to resolve but will take a lot of time testing and fixing. 10 Likes Still crashing, will have to reinstall studio ... bummer There is a known issue with certain older plugins causing a crash on place open. This is the only crash we are aware of at this time. We are
working on a fix for this but in the mean time you can either disable this Beta or turn off any plugins you think may be causing the crash. You do NOT need to reinstall Studio to resolve this. I like that the new icons are color-coded for more accessibility. Reduced clutter is always welcome, too. But my brain will inevitably need a few days to associate
the new buttons/layout with their functions. Muscle memory takes time to adjust. 2 Likes Next Gen Studio UI Preview is here! [Beta] Announcements There is a known issue with certain older plugins causing a crash on place open. This is the only crash we are aware of at this time. We are working on a fix for this but in the mean time you can either
disable this Beta or turn off any plugins you think may be causing the crash. You do NOT need to reinstall Studio to resolve this. Page 17 Next Gen Studio Ul Preview is here! [Beta] Announcements There is a known issue with certain older plugins causing a crash on place open. This is the only crash we are aware of at this time. We are working on a
fix for this but in the mean time you can either disable this Beta or turn off any plugins you think may be causing the crash. You do NOT need to reinstall Studio to resolve this. Getting all of Studio moved over to the new styling is a much bigger project than you can imagine. But we do plan to do it once we have the styling more settled. 1 Like The
biggest issue I have by far with this re-design is how much more space is taken for the same amount of info. I like the compactness of the current UI, and I don’t like having big rounded buttons that pop out. 3 Likes Will minimized ribbons be possible? Yes Is there a timeline for ‘Test’ tab integration? We are integrating various parts of the old Test tab
into new areas of the UI. Multiplayer test will be in the upper left Play Test area. We just didn’t have the UI ready for it in time of this release but it will come out sooner than later. With custom tabs you are welcome to build your own “Test” tab and put whatever tools/buttons you’d like on it. No ETA yet on custom toolbars but it’s a top priority for the
team and we’re just getting started on it. Thanks for the questions and suggestions! 4 Likes Ok, that looks really good! It’s a mix of not being visually overwhelming like current studio, while being space efficient. Keeps the main design ideas of the new ui, while being compact. Good to hear! I'm glad, Sounds exciting! Step 1 is to get all of Studio using
a single “background color” value and implement background coloring in the same way That will take a while, sadly. But I do think if we do this properly, themes and deep customization becomes highly possible. 7 Likes Is a there a place I can find the source code to this ribbon (luau)? One simple question if you mind, but are we able to make custom
skins for Studio and put them on so we have custom UI we’d like to have? 1 Like Since the new Ul is being built in Luau, I feel like we could end up seeing programs to mod the look of the UI completely. I know it would be much easier, but also still complex. 1 Like Not anytime soon. Things will be under heavy development for a while and then there’s
some work to get it into “open source” shape (not just the code but the repo set up and workflow for reviewing PRs, etc.) But a definite possibility in the future! 5 Likes Hosting studio UI under GitHub would be insane, and I would 100% be making some contributions there 1 Like Just want to be sure, each window (explorer, toolbox, properties) has
their own team, right? And if that’s the case, will there be a separate announcement post when the teams update their windows? Or will you guys just update this thread? Quick question Paul, I'm guessing the current menu bar that is in the beta release is only temporary, right? Since in the RDC announcement there was a completely different looking
one On a side note: it would be really nice to see these buttons moved into the title bar like VSC does it; 10 Likes Edit * I found out how to disable the beta from the ‘new place’ screen when studio loads. So I am able to get into studio again, I still think maybe a warning might be nice. Saw this message too late, and the reinstall didn’t help any. So I
would disable plugins, except I can’t open studio to disable them. How can I disable the plugins outside of studio. Also, maybe a heads up in the original post, saying this might happen, and give instructions on how to disable plugins Thanks Sorry to ruin your day but the positives are: this is just Day 1 of a Preview release and your feedback is
consistent with a lot of other folks! Many weeks of updates coming before this becomes the default and hopefully we’ll make every day better for you. 3 Likes they may keep the OG one up for like a year or two, but I can’t see them keeping it around forever. i’'m pretty sure this new one is the direction Roblox wants to go in for Studio, plus I've heard
that it uses more updated code than the old one. having to work with 2 different versions of studio, adding features on both the OG and new one would be a nightmare for them. It’s a reason why most companies don’t give you the choice. (all those reasons, plus money!!) 3 Likes Two questions; A; Should we expect an overhaul to how we create Ul
similar to how its displayed in this photo B; I personally like the bar on the side so is that functionality on the planning board to make its way into this new UI 8 Likes Thank you! Yes I can’t stress enough that we know this initial release will likely not work well for advanced creators and we fully expect customization to fill the gaps. We won’t ship as
the default until those capabilities exist. 1-5 manipulation shortcuts are not new to this release but I'm glad you found them! I use them all the time. 7 Likes everytime i find a new change about this topbar, i cry a little. this is awful in every way. I have updated my post to include more of the points that I have come across, and have also tried to
include some of the suggestions that many other people have made. I am as excited as you are about the release of the preview! But there are just a few small changes I'd like to see before I can leave this beta enabled without switching often. Thank you for the extraordinary amount of contact to the community here. I'm glad you’re doing this! Page
18 Yeah these are brand new tooltips and I agree the timing is weird on them. 4 Likes In my very opinion, its seems not worthy to use it and must improved (like reducing margin) for me. Modern design attempts is good, but devs need ‘useablity’ instead of just design. i really like it! i actually like the padding. it easy to see where everything is at a
glance. it could be a bit less but i didn’t think there was enough in the current ui. i also like how its using luau ui 1 Like I've read the other comments in this thread (and I've also came to realize that my comment was actually read when I saw the “Roblox Staff” next to the reply in the email) I'm happy to see that you are planning to take into
consideration more advanced creators and I'm sorry for the passive aggressive comment! I often forget that these are actually read and I'm far too protective of my workflow, especially since I basically use Studio at a professional level now Wonderful day to you & thank you for being active in the community! 1 Like Theres no option to start a local
server testing anymore. 1 Like Mr Grobterm: crash It is listed in “Known Issues” that third party plugins might cause it to crash. You have to disable your plugins to avoid it. Ooh that’s cool! I'm definitely enabling this! - Riley The height of the new one is higher than the old one yep I need full customization however since u guys use Lua over Qt These
separate windows are not windows... OBS and etc. don’t even capture it. But I'd love if there would be more Qt hook to Lua... well if it wouldn’t crash Studio for using those Hooks i love react i love my ui being based on laggy lua code rather than Qt give me all the react (/j this update is pretty good actually, was playing around with it by flipping an
fflag) This looks interesting, but I'll try it when it’s out of beta. Thanks Roblox! Is there a way to disable this without being able to access the beta settings tab? I enabled this today on my laptop and now I can’t load any experience in studio including new baseplates. I have tried uninstalling studio, deleting studio temp files, and reinstalling studio. This
hasn’t resolved the issue. I have also tried closing everything before opening studio which hasn’t worked either. I have contract work I need to work on so if anyone can think of a quick solution I haven'’t yet tried, PLEASE let me know, thank you! 1 Like my studio closes instantly when I have this feature activated 1 Like i lowkey wished it used a
modern library like fusion, the react-lua codebase is just straight bloat one time I tried finding the source of a type and I had to sort through 4 modules to find the base of it Right now swapping between Geometric and Physical drag modes will cause the top bar to shift because the text is changing. It’s not too big of a deal, but it feels a bit odd to see.
//devforum-uploads.s3.dualstack.us-east-2.amazonaws.com/uploads/original/5X/f/9/b/b/f9bb8dc5e1637dcf281f13d00674a20be3e37dcf.mp4 Also, from what I've seen, there’s no way to open the Insert Basic Objects widget at the moment. Just want to make sure that one is not forgotten. One thing about the new UI is that everything is more spread out,
meaning I need to move my mouse more to accomplish what I used to do with smaller mouse movements. For example, swapping between the Select tool and the Move tool without using hotkeys. On a similar note, I also think that the plugin icons at the moment are too small. I do like that the menu bar is utilized more in this preview. 5 Likes
@MeshOfPaul Hmmm yeah idk about Qt Docs but if they allow to overwrite default window that would be very cool and Poggers because, it’s taking a whoooooole row just for these buttons What is roblox-cli analyze w/o --project thinks mdilnstance is optional alr I am starting to understand local Plugin = plugin :: Plugin local test =
Plugin:CreateQWidgetPluginGui("Ribbon2", { Panel = true, Resizable = true, Parent = "studioTopBar", InitialEnabled = true; Size = Vector2.new(640, 129); AddToParentLayout = true; MinSize = Vector2.new(640, 129); Id = "Ribbon2"; Title = "Ribbon2"; Modal = false; }) local text = Instance.new("TextLabel", test) text.Size = UDim2.new(1, 0, 1, 0)
text.Text = "Hello, I am also some type of Ribbon! :)" 2 Likes I've just now tried launching studio on my main gaming computer and it crashes as well. I really need a quick fix to this please. This has caused a great deal of stress as I can’t afford to lose money right now. Here I made a full review YouTube video that discusses in detail and at length
about the Roblox Studio New UI Update but only the Ribbon UI, not the main UI and I speak in Indonesian, if you don’t understand what I'm saying in the video, just turn on Subtitles . This is the video link: 2 Likes My studio wont let me view my game at all. How do I fix this? And yes I did reinstall it. 1 Like The UI gives a bunch of new icons for studio
and I do like that, but everything is completely wrong. Almost everything has changed for the worse. Please, make an option to change this back when it is released in the future. 1 Like Page 19 This has been answered, disable your plugins. the post says that some plugins cause crashing, y’all have to start reading the post before filling the replies I
enrolled in the beta and when I launch to edit a game on studio, it keeps crashing how do I fix this? Its in roblox studio settings I'm pretty sure, had this problem a few times. problem that im dealing with this: studio won’t properly load, and it will also close itself Omg... Never thought I would see the day that Roblox actually follows macOS Human
Interface Guidelines. Im going to try to start using this new Studio, and we will see how it goes. Im extremely curious on how writing the UI in LuaU works, like will it be possible to write our own Mac/Windows apps with LuaU in the near future? Also will it be possible to get a macOS App Icon when the new UI comes out for all? 6 Likes After turning
on the feature it crashes upon opening a place. 1 Like I have the same problem. RE-installing doesn’t help. 1 Like Please tell me this is will be an optional feature. It looks more like a ripoff of Roblox Studio than a new ‘intuitive’ design. I hope by ‘flexible Ul system’, you mean this will be optional- The old UI was perfectly fine, but adding all of these
unnecessary features honestly just overwhelms us developers. 2 Likes CallMeCrazy: Please tell me this is will be an optional feature. Supporting 2 completely different codebases would be a hassle for the engineers 4 Likes To the people having problems with the new beta, just open studio normally without opening a game, go to Beta Settings and
deselect the beta 2 Likes I think this makes studio look bloated, like me after having a lot of bread. The amount of padding around the tabs and buttons is excessive and wastes a considerable amount of space. Studio is a tool for developers. If you want the interface to look pretty at the expense of ease-of-usability, you should make this update just for
Apple like the rest of their interface. 1 Like This might be a bit hard to see because I use a widescreen monitor but I don’t like how plugins aren’t separated by dividing lines anymore, it feels really odd and feels super unorganized/cluttered to see all plugins just kind of grouped up like this. Essentially what I mean is this: Feels a lot more organized
and easy to look at. Maybe this is planned and currently unintentional, or maybe this might happen automatically when we’re able to customize our own tabs, but currently this bugs me and thought I'd mention this anyway just in case. 3 Likes I really do love how the new UI takes advantage of the macOS menu bar. Will definitely speed up my
workflow a little bit as most applications I use have menu bar buttons. 3 Likes A very cool update but im not able to open my studio using this it just crashes FloofyPlasma: I really do love how the new UI takes advantage of the macOS menu bar. Sad we didn’t get this on Windows, that topbar is really useful and is an eye candy, might consider
switching to macos because of that. Most programs don’t do this on windows, but integration would be interesting. Here’s Notepad for example: 1 Like And Roblox’s old UI has major problems 1 Like i personally don’t see any problems with it Not a fan of having more wasted space on the top bar. I prefer information dense Ul not something that looks
pretty... 5 Likes It just came out, give it time. 1 Like Page 20 Exactly, they’re problems you don’t see, problems on the codebase side. The old Ul codebase is the cause of serious problems, hence why they can’t go back. 1 Like This is caused by some plugins calling an API. Fix is forthcoming, but you can disable some plugins to try the beta, or disable
the beta and wait for the fix. 4 Likes I already like the UI a lot - but for me one thing that could be changed is that right-clicking dropdowns, such as the part button, does nothing. I think this could be changed to open the dropdown instead of having to click the triangle in the corner. I swear we were able to do this before in the old UI - but even after
going back I can’t. Does anyone else remember this or is it just me? Am I going crazy? 2 Likes Really like this! Been waiting for well over half a year! I very truly saw this while marking my notifications as read and gasped so hard xD I basically have no real muscle memory in Studio, so all reasons for complaint against this by other people are nullified
for me lol. 1 Like Sorry bro but I think you're tripping. Just saying. 2 Likes Maybe it would be a good idea to also redesign the toolbox, explorer, properties and other windows to match the style 1 Like Paul: It will take time and coordination with other teams to migrate old UI to the new UI frameworks. I'm not 100% sure, but I think this includes the
toolbox/explorer/etc... 3 Likes Oh my god my bad im so blind 2 Likes I really like this! It just needs some more spacework and organization because there’s a lot of empty space... 1 Like I read about the plugins earlier however, it wasn’t any made by other developers. Turned out to be my own and I had missed the folder when cleaning temp files and
such earlier as Roblox stores them in a separate area. Problem has been resolved now however, I will need to find a solution to my plugins when I have free time to look at them. Where is “Go to Script Error”? 3 Likes Studio keeps on crashing when loading up a baseplate 1 Like 2 Likes Next Gen Studio UI Preview is here! [Beta] Announcements This
is caused by some plugins calling an API. Fix is forthcoming, but you can disable some plugins to try the beta, or disable the beta and wait for the fix. found a little bug with the plugin dropbar, when you have too much plugins, it’s going offscreen and there’s no way to access the offscreen plugins, like you can’t scroll to the bottom of the list 3 Likes
just updated, i love this. thank you! The UI looks nice but the topbar is too big and it lacks the ability to close and resize. 2 Likes the weird tab thing looks really bulky, i do not like it. how do i start a local server test lets FREAKING GO! i've been waiting for this ever since i heard it would be a possibility some time ago, it looks really nice, as a bit of a
UI designer myself, i’ve honestly got no complaints atm. Page 21 for adding new tabs it would be awesome if you added a ui tab like the one in unreal and unity 1 Like Please tell me this will be optional, I cannot imagine using this. This new Ul is so unintuitive 2 Likes Read the thread. It’s not on by default and will not be for at least a year, you should
give feedback if you want improvement. 1 Like Yeah, it’s optional for the time being, my concern is when it comes out of beta. Roblox has a tendency to force certain updates 1 Like Of course, it will be the default and the old systems will be thrown away once the preview beta ends and it releases properly. This update is not just a new UlI, the backend
is completely rewritten from the ground up with a new framework that will allow engineers to implement new features with ease, and it will possibly speed up the process. Even if you don’t like it at the time of the release, it will still be out. That’s how updates work, something new gets created, it goes into the beta stage so feedback can be taken and
bugs can be fixed, and after the beta stage, it moves on to production. So while it’s in the beta stage, you should give feedback to engineers on the areas that you think need improvement, so we can all get something that we like and enjoy using at the end of the day. 2 Likes Is there anyone still unable to access like me? So I know this is beta but it’s
weird that it still doesn’t work. When opened the project loads but then crashes. The prospect of custom toolbars is amazing and will really benefit people, but there are issues with the new UI The amount of dropdowns in the new UI really stalls development, and it’s harder to find what you are looking for. I use unions a LOT for my models and builds
and having half the union operations be placed in dropdowns is extremely inconvenient. The amount of padding and empty space can be reduced to comfortably fit everything that’s in dropdowns 3 Likes I would say it’s a very good update and I know it’s in beta. Although I have suggestion to make the ‘+’ symbol more bigger and visible because it’s
quite hard to see and I didn’t notice until I stared for it long. 2 Likes Really appreciate all the hard work you and your team do. 1 Like How about just remove the top, it’s just useless space, Just do what FireFox is doing and make the tab space the same place that contains “File”, “Edit”, etc. This will make everything look normal and use less vertical
space. 1 Like They should make it similar to blender, the test buttons shouldn’t be there, they should be moved down so that my muscle memory doesn’t have to get readjusted to some really small icons. Roblox should keep the same vertical size for the buttons because it looks nice but move those other buttons down and style them like the buttons on
the far right. 2 Likes They should disappear as soon as I move my mouse. [ wonder which plugins are causing the crash The Ul takes up a ton less space than the main functionality. I doubt there is two different builds. few things i don’t like, way too much padding on the top, i prefer the “home, model, avatar...” on the left, the only thing that is
changed is the top bar, would be nice if everything else was changed to fit, this is probaly already the case just needs to be updated though the new ui feels oversimplified to be honest, however new tabs is a feature I can get behind, I just wonder how it’ll work or they can place a bevelled square outline around it to make it somewhat standout??
Please we NEED an option to change studio theme colors, it would be very nice 2 Likes reminder, you can still use the CTRL+SHIFT+G and CTRL+SHIFT+N and CTRL+SHIFT+I for unions negates and intersecting however i can agree that dropdowns are wayyy to excessive 1 Like on a scale on 1 to where-the-heck-is-that-button how would u rate it?
Page 22 Hey, I've been watching your yt channel for almost 2 years, you really helped me to learn how to script, thanks for providing such as a great content! Custom themes for roblox studio would be a nice feature tho 1 Like Every time I open the new studio update; studio instantly closes itself and crashes so I have not tried it yet. Looks neat
though. 1 Like There doesn’t seem to be a way of closing the ribbon. I really like the UI but the fact that I can’t close the ribbon makes developing very awkward, especially when dealing with UI! My screen size is 1366x768 and so is for many other people. I'm sure this isn’t intended and will be added back eventually but this is a dealbreaker for me,
I'm kinda disappointed I have to revert back immediately after just trying it out. Hope this’ll get fixed asap 1 Like I can’t edit any game with the beta enabled, instantly crashes and closes studio when loading any place file. Windows 10 64-bit 16GB ram Samsung SSD GTX 1660 S Ryzen 5 3600 1920x1080p 144hz 1 Like HealthyKarl: How do you



enable the Snippets button? I kinda guessed something was supposed to be there since there is an extra separator line at the end of the Script tab: None of the other tabs have this. Also, not related to the person Im replying to, but I found a bug on startup: Wow... This is amazing I've heard there’s a few bugs but I'm on holiday right now... Hopefully
when I get back in early August it’ll be all fixed 1 Like There is yet some issues sadly in the new Ul for some reason, I litterally had to hop onto an alt with no plugins to get this up and working. 1 Like Next Gen Studio Ul Preview is here! [Beta] Announcements There’s an issue with an API call and some specific plugins (mostly older). Disabling plugins
will allow you into the beta until we roll a fix. Trying to keep this at the bottom (and at the top). Also @endlessfun @Excel @mythisticnoob 2 Likes You may want to edit the post and emphasize that Roblox is aware of the crashing bug on top. Replied to the wrong person. I meant to say this to @MeshOfPaul. 3 Likes Thank you for taking the time to
provide this! 12 Likes screenshotting this so I can laugh at it later. 7 Likes Yes. Before we go full release the documentation team will need to make tons of new documents and update old ones. But it doesn’t make sense to do that until we’ve stopped making major updates and changes. That’s another reason for the 2025 estimate on full release. 2
Likes Recent files will be making a comeback. We just couldn’t get it done in time for this first release. 4 Likes Right now the only crash we are aware of is related to out of date third party plugins. Is the crash you're seeing on place open? If it’s still happening can you send us logs? 2 Likes Now that we are in Lua and stylesheet land, we have a lot
more options for “fancy” than we ever have. But it’s taken all of our effort to get everything working together and we don’t want to over invest in polish until we know all of the big, chunky elements are in a good place. 5 Likes I noticed there were no “test” tab and I couldn’t test the game with multiple players. 2 Likes I've also been experiencing
crashes when opening a place in studio, and it just closes without warning. Heres a screenshot taken from the Windows Event Viewer tool: 1 Like Yes we will eventually get everything moved over to modern and globally consistent color palettes. First we've got to get alllll of the Studio UI using color values in the same, consistent manner. You’'d be
shocked at how much work this actually is. This is why I when people keep saying “reskinned UI” — I can only dream of a Studio that can be simply reskinned! But yeah the dark theme background will only get more dark from this point. 8 Likes Page 23 Please see the OP for the latest on known crash issues. There’s only one we are aware of at this
time. 2 Likes Please note the data use policy that launched this week is completely separate from the Next Gen Preview UI. These are not connected in any way. The crash you're seeing is likely due to out of date plugins. Please see the OP for details. 1 Like Yeah it was caused by plugins, I had no idea that the post had been edited to inform the issue.
Thanks! 2 Likes I turned off all the plugins and only used the ui one, still same issue, However the “Plugins” tab is now completely blank. It is mentioned that the issue was caused by a deprecated function call, but could there be another issue where Studio is unable to add the plugins to the tab because it is possibly missing a critical Ul element?
Asuming that the old ui will no longer be accessable? 1 Like I guess but it should stay, new ui just crashes regardless how many plugins I have on. Viewport pop out came back with the updated docking release a few months ago. Simply drag it out of the Studio window. We are purposely putting out a simplified Ul in this initial release for a few
different reasons. The last thing we want to do is slow down experienced creators. This new Ul system has far more flexibility than we’ve ever had and we are excited to tap into all of these new options available to us! 3 Likes you can’t drag it, that’s the thing. I honestly hope they don’t tbh, or migrate the UI to the new framework. As I do prefer the
old one when it comes to looks. I prefer the quality mostly, I can tell new UI will be quite hard to work with. 1 Like I would be fine with a graphics change, but layout wise the old one works better. 1 Like simply drag this tab (I marked it in red). works in both the old and the new Studio UI Yeah, I really agree with ya, I must say. 2 Likes the issue is it
crahses before loading, so I cannot. Not all plugins cause the crash. You can try turning on just the ones you need and see if they work. We do have a fix ready for next week’s release. scripted wolf: you can’t drag it, that’s the thing. then don’t claim that it does not work Hey Paul, just wanted to ask, do you have an estimate time on when the Explorer
team will be able to mitiage to the new core UI? Just a little curious, that’s all. And also, will it ever get announced here? We don’t have an explicit plan to eliminate Qt completely as it does provide a lot of native interactions with the OS. But we are going to be building less and less Ul in Qt. 1 Like as I said, I turned all of the plugins off, only Ul one
was enabled, but still caused crashing. Page 24 The underlying tech, where the bulk of this effort was spent, is 1000 steps forward. I can’t begin to describe how much tech and design debt we’ve paid back here., We can build back in old and new features so much faster going forward. 3 Likes Thank you for the sympathy We actually see a not too far
off future where we share the same core UI workflow in LuaApp (player), Studio, and experiences. When we inevitably improve the tooling and capabilities, we all see the benefits. 3 Likes We looked into that and there didn’t seem to be a reliable way to do it with our Qt implementation. We saw examples but they were very hacky demos. Hey
@MeshOfPaul, I just noticed another feature your team might want to add back. We used to be able to scroll (with the mouse wheel) through the tabs. This is no longer possible, but it was quite useful. Other programs, like Word also use it, so some people (including me) might expect it to be available here too. TL;DR One used to be able to scroll
through these tabs by scrolling anywhere on the ribbon. I suggest to bring back this feature. thank you 4 Likes This is likely a crash caused by outdated plugins. A fix is coming but see the OP for the latest details. 1 Like Yeah we know about this one. We haven’t done a ton of work on responsive layout but we have so much more capability here with
Lua/Stylesheets. 1 Like Do the built in OS screen capture tools not meet your needs? Honestly we weren’t seeing a lot of usage of the screenshot and video record tools so we didn’t think they would be missed. Known issue with various third party plugins making deprecated function calls. The fix is ready for next week’s release and in the meantime
you can disable all or certain plugins. Reinstall is not required and won’t help. Next Gen Studio UI Preview is here! [Beta] Announcements Known issue with various third party plugins making deprecated function calls. The fix is ready for next week’s release and in the meantime you can disable all or certain plugins. Great to know! Thank you for the
extra detail. How do I add someone to team create??? I can’t find button. It’s a little out of scope for this specific effort but it’s still my team and something I'm very keen to do. I imagine a not far off future where custom layouts and toolbars working together to support whatever your current workflow is. We are getting all the pieces in place to do
this. New studio has a big forehead. Make the ribbon smaller please! 5 Likes The RDC sneak peek was purely a design mock up and concept (for those thinking we’ve had all of this working since back then!) We’ve gone through a couple iterations on the top level menus to get where it is today. So feel free to give us feedback on what you see there
now. 1 Like Yes! I forgot we showed some of this but it is what we are eventually building our way towards. It will be a long road but we are setting everything in place to get there. 1 Like A documented known issue in the OP. It will be there soon. Great feedback and similar to what others have said. Thank you! Yeah still a decent amount of work to
be done here. If that dropdown scrolled, would that be best vs scrolling the entire tab left/right? I'm mostly impressed you have that many plugins that aren’t causing the crash bug others are seeing. It didn’t make it in this release but it’s coming soon. Please see the OP release notes. Next Gen Studio UI Preview is here! [Beta] Announcements Known
issue with various third party plugins making deprecated function calls. The fix is ready for next week’s release and in the meantime you can disable all or certain plugins. Page 25 Tell us how you would like it to work. Shortcut keys are such an underrated capability! We do have plans to improve the UX of managing shortcuts eventually. Ribbon
show/hide option will be coming very soon. Known issue documented in the OP. Local server testing will appear sooner than later. 1 Like You still have some plugins in enabled but the plugins tab is blank? Is the Plugins menu also blank? If you can share logs that would be helpful! 1 Like Bless you guys for aiming to do a better job than Unity lol.
Unity just went and hardcoded everything into textures for exclusively two themes. 2 Likes Great call out and it seems totally doable. Thank you! 4 Likes This might be a bit off topic but it relates to your reply. If you guys do end up overhauling the UI editor with the tools to the left as shown in the images, I hope you will consider that this Ul is taking
up screen space and will hurt the overall Ul workflow, it does appear that you can move it around but this doesn’t really help if you’'re forced to temporarily move it on top of other existing UI and having to constantly move it around seems tedious. I'm sure that this will be toggleable but it might turn people away that do actually want to utilize a
feature like this. 1 Like well personally I would like the ability to add custom shortcuts like for example the ability to weld two parts together without the use of plugins (of course you would have to have the user script it) and stuff from other tabs being able to be pulled into the custom tab, you should also make it so you can hotkey the custom
shortcuts by the way I think that would be pretty useful 1 Like Team Create / Collaborator UI will be coming back to the upper right very soon. For now it’s a known issue that it’s not there. 1 Like I love this floating toolbar in other software. I would love for Studio to leave room for plugin API expansion in this space in the future. In Unity I can add
stuff to this little floating toolbar for my own custom stuff, I would love to be able to do the same with Roblox for e.g. model placing plugins, special geometry tools for mirroring, edge aligning, material flipping, etc. 5 Likes I have question , the Ul is nice but with the new UI it is more optimized than the old one? Since on my old potato pc , sometimes
I'm very laggy to dev and that very annoying 1 Like as i believe the entire backend of the Ul is being overhauled (the scripting and stuff) I think it will be optimised 1 Like I enabled the feature yesterday, put my computer on sleep mode, and woke up to this madness: Many windows were being created trying to reconnect to my place, and when I
opened my computer all the tabs opened at once and the memory peaked at 14 gb, that’s pretty insane. So this is unstable right now, enable at your own risk. 3 Likes Any plans on making this centered to better align the buttons above? 1 Like The crash on open place is a known issue (see top of thread) caused by some older plugins. We have this
solved on our side for the next release. You can disable some or all plugins to resolve, or disable the beta until the patch arrives. The windowing issues seem possibly unrelated as the ribbon beta doesn’t really dive into docking or place open code. I'd see if it continues to occur and file a separate bug if you see continual repro. 3 Likes Our approach is
to embrace “toolbars” in general. Toolbars can be ribbon tabs, anchored to the Viewport, docked somewhere in the Studio window, floating, etc... Whatever your preference. If you want to keep your Viewport completely free and clear, you should be able to do that. If you want certain toolbars to appear depending on what you’re doing or your want to
temporarily clear your Viewport, you should be able to do that too. That’s the long term goal, at least. 2 Likes We’re striving for parity at the moment performance wise, so I would not say it is more optimized. We have tested on a few “potatoes” of our own, but would be interested in hearing what your experience is as the code is new and we can only
do so much internal testing compared to the combinations of HW in the open. 1 Like Hello again, just noticed another thing while using the Preview! While editing a script or UI, the respective tabs (Ul/Script) do not open automatically anymore. Would make sense to have them open automatically to allow direct access to the specific features, for
example script formatting. Thank you! We have some exciting ideas around exactly this that I'm hoping we get to next year. Page 26 We’ve talked about this and it gets more complicated with custom tabs. For example, what if you build your own tab that works better for your Ul or scripting workflow? It would be frustrating if we kept forcing the
default versions on you. Currently we’re thinking this could be configurable with settings. But then it brings up the question of do we just have this behavior for Scripts and Ul elements or can we make it more flexible where you could set it up for any selection to highlight any tab? This sounds like the best approach to me but it will require a decent
amount of design work to figure out. Nothing is impossible, just takes time. This is the joys and fun of product management. 2 Likes also im just wondering, are you going to tie the custom tabs and keybinds to studio.exe or the account? if you tie it to studio.exe the stuff will be easily share-able (I hope so if you go down this route) whereas tying it to
the account makes it so you do not lose them if you have to reinstall studio (or if you’re using a different device) Funny enough we are also talking about this now. A major settings overhaul is in the early planning phases and one thing I would like to explore is allowing certain settings/customizations to be attached to local install, creator account,
team, and/or place. It could get REALLY confusing and tricky with the team stuff in particular so we need to dig in further. I didn’t enabled yet, due to the crash problem with plugin but if I have bad performance when enabling it , I will tell you! As long as not too many button locations change I wont really mind this update, good job. To drop my
thoughts in here: I personally really liked being able to scroll the whole ribbon left and right. The only thing that I didn’t like about the previous scrolling implementation was that it was a clunky implementation of the idea. I'm very much interested in being able to two-finger swipe on my trackpad - or use the second scroll wheel on my mouse - to pan
across options if they can’t be compressed to fit on the screen. It saves me from having to target a small hit region precisely and issue a click, then scan a vertical menu along the vertical axis of my screen that has much less available space. I wonder if others here have thoughts on that? 2 Likes While we’re at this topic, was wondering if you guys
could add a search bar on top of the Plugins Management Rn it’s annoying having to scroll through to look for a specific plugin if you have a ton 7 Likes just a question: will y’all add the recording and screenshotting features back? also i’ll probably switch my mode to dark when this feature gets forced next sping, since light mode with this feature just
looks awkward also this is like really laggy when i open a place with this new ui other than that, nice work! Paul: But then it brings up the question of do we just have this behavior for Scripts and UI elements or can we make it more flexible where you could set it up for any selection to highlight any tab? While this allows for the most customization, I
do think that this approach includes a lot of additional work for your team towards a feature that only a very small amount of people will actually use. It is possible to do that, but would require too much work. Instead of doing that, just allow for customizing the existing tabs in the ribbon as well, so that we can add our own functions to the tabs. Or
simply allow us to enable/disable the automatic opening of the Ul and Script tabs (that’s how Word does it when you are editing a diagram). 2 Likes That sounds like a great idea! 4 Likes I think it’d take too much work to maintain both of the UI’s after each update. So they probably wont. 2 Likes what the how am i supposed to edit collaborators lol (
cant wait to see whats in store... ) 1 Like (Yeah well of course it wouldn’t make sense making a brand new studio UI and then not releasing it lol) The current one top level menu template looks outdated as well it doesn’t really match the new top bar, so I made what I think would look the best for the new Studio UI; Moving the top level buttons (File,
Edit, View) up in the title bar, (like Visual Studio) would free up a lot of space, I also moved the username label, and the buttons beside it next to the window control buttons, to free up even more space and make the top bar less chunky. I made the dropdown buttons larger and used the new RDL background color There is a gitcode called
TrueFramelessWindow for implementing this in Qt for whatever reason Also there is a bug where the “Save to file” and “Save to file as” buttons disappear after loading in a place: After: 2 Likes I like this UI, but I'm guessing we can add our own tabs later on? I hope we can have the Test tab back, because I don’t want to keep pressing the play button
drop down to run a script. I may accidentally play the game. Looks nice, hope it’s not too different from the original though. I will miss the old look. i would find it pretty awesome if a section of the toolbox was added for custom tab features (however to prevent people causing mass destruction, each custom tab feature uploaded has to have the ability
to view source in browser/toolbox tab and to be free, if you have to add the ability to make it paid for then if the user doesn’t like what they paid for they get the 70% (what roblox takes) back from the purchase and to prevent people from abusing this you have to make it so its 70% of what they originally paid for not the current price) adding on, you
should most likely make it age verified only to upload, alt accounts could be a problem for an infestation of viruses (like we already have for obscure modules in toolbox) moving on, what somebody else has said you should allow for theme changes to be more accessible, to start color pickers/hex codes is a good beginning and allowing for gradients
could make for a good customisation kit but to make it so that it’s an absolute perfect setting allow for images to be set as the theme background and you should make it local to allow for images that wouldn’t get through moderation be allowed as the theme change (this is unhinged I guess however its localized, you arent uploading it to roblox and so
I do not think it can harm children in any way as they would have to already have the image saved to their computer) as well as adding the rendering features (default and pixelated, allow for pixelated to how far it goes be customisable since its not based on studs) and ImageRectOffset + the other one and finally, the options to have it
cropped,stretched,fit (maybe not this one) and tiled as well as how transparent it is and finally to have the ability to make it so that the image overlay gets the color change with gradients and have the gradients be able to be rotated. Thats all I can think of for a good range of customisation, please let me know if something cannot be accepted! My
thoughts: I've been using this new generation of UI for the last couple of hours, and while it looks much more pleasing and modernized, I have noticed some flaws that may slow down workflow for developers. Some features are missing from the buttons, and moving the view tab makes navigation more difficult. On the positive side, I really like the
new window tab for opening different windows, and adding color to the icons makes it easier to identify what I'm clicking on. Overall, I hope some major changes are made before the beta release is finished, but it’s a great start! (I also cannot find game settings nor can I find team create settings.) I would love for Studio to leave room for plugin API
expansion in this space in the future. A lot of this work has been “under the hood” in revamping a lot of the interaction architecture in Studio. The goal is to eliminate a lot of the “special case” stuff that goes on (and the Ribbon is a hub for this) such that the entirety of Studio is driven from simple APIs. Right now plugins only have a sliver of the
access that internal modules/plugins have. So a natural effect is that as we progress here it becomes much more possible to allow extensions from plugins to all points of the UI - all menus, toolbars, UI elements, etc. Of course, there’s some safety considerations etc, so these changes will lag behind the UI changes, but its certainly in our minds in
doing this and on the horizon. 5 Likes Reproduction Steps Currently, I am on the latest production version of Chrome. Recently, I have been trying to join any private servers. None of them seems to work? Here are the steps: Find a game that allows private servers Use a link of the private server No response Expected Behavior I expect my client to
join in the private instance of a server. Actual Behavior Nothing happens! The site refuses to respond. All join buttons are inactive on the page, and no prompt to open roblox shows up. Issue Area: Roblox Website Page URL: Any Impact: High Frequency: Constantly 182 Likes Same here! Even on Edge the join button doesnt work but everything else
does! 38 Likes Same, can’t join any private servers from shareable links 31 Likes Same here, have to join someone already in one. 18 Likes I'm experiencing the same issue. I've tried clearing all my cookies and using a fresh browser without any extensions, but nothing resolved the problem. However, I noticed that when I switched to another account,
private server links seemed to work. The only workaround that worked for my main account was downloading the Roblox app on my phone and accessing the shareable link through mobile. 26 Likes I found numerous users were experiencing issues when accessing private server links. Currently this seems to be the only forum people have found
explaining the issue. As of far, there is no solution, while I can’t replicate what PS2 says, I cannot access through mobile for some odd reason. I have my own suspects to the root cause, but I can’t be certain 10 Likes Yeah, alt accounts worked for me as well. Not sure why. 10 Likes I'm having the same issue as well, I can’t press play if its a private
server and I also can’t join my friends’ private servers either 4 Likes Update to the above I managed to replicate the issue over 3/10 alt accounts among testing, here’s what I found; The issue for LINKS seems to be at random, perhaps a roblox bug, I doubt this is intentional For private servers themselves, you can still join private servers. To join
private servers, you can launch them directly from the game page. To join a PS, you need to join it through the servers tab off of the experiences page. You cannot have the private-server link in the searchbar (for whatever platform you use), as this invalidates all the buttons (to play, or join) for the game you try to play. This means you can still play
with friends, or launch personal private servers. 10 Likes Okay, I'm happy that I'm not the only one going through this. For me, the links only stop working on my alts and not my main. I tried testing it on three browsers, and they're all the same issue (Client won’t open and play button doesn’t respond). 11 Likes Having the same problem here. I can
reproduce this issue every single time I attempt to join a private server via a sharable link. As to what’s causing it, I've got no clue. Attempting to reinstall the client and clearing the browser cookies had no effect. If I had to guess, this issue has something to do with authenticating the account credentials because a few of the times I've clicked on a
link to try joining the private server I was greeted with the add account screen even though I'm already logged into the account I'm attempting to join on: 24 Likes If it’s any help to anybody issue began on the 15th November for me. 9 Likes Happening here, on the doors discord it is a major problem right now and people are complaining. (so it isn’t a
isolated case) 6 Likes Cannot join private servers via links Roblox Application and Website Bugs this appears to happen only on specific accounts, I'm guessing roblox is doing some sort of A/B testing, on the image the bottom part is a functional part of the page, and the top part is the new one with Google Analytics

(RobloxLaunch. GoogleAnalyticsCallBack) that doesn’t work [image] if you want to join on an account for which vip links don’t work, open the vip link, inspect element or press f12, paste this script into the console (don’t paste if you don’t trust the script) var content = ... 4 Likes Yeah, this wasn’t the original issue I had but it has started happening. 2
Likes Thanks all for reporting. This should now be fixed, please let us know if the issue persists. 16 Likes This topic was automatically closed 14 days after the last reply. New replies are no longer allowed. I haven’t found many run/walk animations on the toolbox that look nice (no offense) so I decided to publicly share my animations for everyone to
use! Walk’s animation priority is core and the run’s animation priority is idle You may get them on the toolbox or download: movementanims.rbxm (36.7 KB) Credit isn’t required but I would appreciate it! These are what the animations look like (gifs may be laggy, I apologize): 210 Likes Looks really smooth, so thanks for sharing this! 13 Likes I'll
recommend these to some beginner developers since the animations are so good lookin’. Nice work! 4 Likes Most definitely going to use this. Thanks! Are credits needed? 7 Likes Credits are optional, but would appreciate it! 5 Likes better read the post next time god90: Credit isn’t required but I would appreciate it! credits aren’t required 7 Likes I
am blind and visually impaired on both eyes and didn’t read that. Sorry! 11 Likes I have a question mines only show the sprint but not walk how do i see walk animation 3 Likes the walk animation’s priority uses core, and the run uses idle. I think the solution your looking for is setting the run’s animation priority to core 4 Likes Might be a dumb
question but how do I * use * the animations? Do I put the keyframe things under my character or? 5 Likes It’s a keyframe packed in KeyframeSequences and not animations that is uploaded publicly, right click on it and “Save to Roblox” also designed to be used for “Animate” script which is what roblox uses to play animations in every state. 3 Likes
Select dummy, Open animation editor and then publish the animation you want, Now you will copy the ID of the animation and use it in a script, for example: -- Script in ServerScriptService game.Players.PlayerAdded:Connect(function(Player) Player.CharacterAdded:Connect(function(Character) Character.Animate.walk.WalkAnim.Animationld =
"rbxassetid://theanimationidhere" end) end) Now you have a different walking animation. 6 Likes Thank you! Seems to work now. [char] 3 Likes Have i seen these animations before?(i remember seeing these in a roblox game) 1 Like My animations are usable for everyone so its just possible they used my animations or have animations that look
similar to mine 5 Likes Will definitely be using this, thanks! 3 Likes Looks good, thank you for giving to the community. 4 Likes How would you do the running one? 2 Likes You’d need the sprinting script first then just play the animation 1 Like These animations are INSANELY good! Good work on them. 3 Likes Page 2 Nice animations man! Was
looking for idle ones for my game but stumbled upon these—highly considering replacing the ones I made for yours lol 2 Likes These look like Redbox 2 animations, But i am surprised of all the work you put in It’s just that many free modeled games will use this animation ALLOT of times, But i am considerable giving you credits. Awesome work dude!
1 Like Could you make a tutorial on your process of making animations, the types of plugins you might use, tips and tricks, etc. if you have the time? I don’t know about making a tutorial since I'm not too good at explaining how to make stuff, but all you gotta do is use Den_S’s blender animation importer/exporter — Blender rig exporter/animation
importer and just make animations over and over until you think it looks good enough. It may take a while but It’s definitely worth it if your looking to make your own animations 1 Like These are so smooth and fantastic! Although I do have a request, could you please make an idle animation and jump animation? I am not the best at animating. Thanks
either way for the animations in the first place 2 Likes Dont feel bad for something you cant really control man, thats nice for you to clarify! 1 Like Nooo this was a joke I'm sorry!!! 1 Like The animation looks awesome and its very smooth These look so good, thanks for making them public! I am not intending to utilize this content on a permanent
basis; however, I am acknowledging the source appropriately. I will use it temporarily. Thank you! Hi Creators! We are super excited to release Occlusion Culling in Studio Beta today! Occlusion Culling is an optimization that prevents the rendering of objects that are hidden behind other objects. It doesn’t require any work from you; the engine will
automatically detect which objects don’t need to be rendered. As announced at RDC24, we are testing Occlusion Culling in production on a few experiences at the moment. We are working to make it available in production for everyone as soon as we are confident in its stability. In the meantime, we want to let you preview Occlusion Culling in Studio
to get your feedback and ensure we address any issues you experience with it! Warning: Enabling this Studio Beta will only enable Occlusion Culling in Studio. It will not enable it for your users in your published experience. When profiling your experience in Studio, make sure to disable the Occlusion Culling Studio Beta (Files > Beta Features >
Occlusion Culling) if you’d like your profiling data to reflect what your users would see in production. Wireframe view of Roblox’s Modern City (Left) without Occlusion Culling (Center) and with Occlusion Culling (Right) How to use Enabling the Occlusion Culling Studio Beta is as easy as enabling the checkbox under Files > Beta Features > Occlusion
Culling. That'’s it! If everything works well for your experience, you should see no difference visually. You can confirm that Occlusion Culling is properly working for your experience by enabling the Wireframe View under View > Wireframe Rendering. The Wireframe View will give you a “see-through” view. When Occlusion Culling is enabled, objects
that are hidden behind others will not be visible. By moving your camera around, you will see objects appear as they become unoccluded. You can also compare the impact of Occlusion Culling by turning it on/off in the Beta Feature menu (requires a Studio restart). Limitations Occlusion Culling only works on meshes and parts (excluding avatars) for
now. It cannot cull the following objects at this time: Avatars Terrain Lights VFX UI These objects will be rendered as usual, even if they are hidden from the player behind other objects. We intend on extending our Occlusion Culling technology to cover more object types in the future. Performance The performance benefits of Occlusion Culling can
vary from one place to another and between different viewpoints within the same place as well. Viewpoints with a lot of occluded objects will benefit the most since we can avoid rendering these objects (eg. places with interiors or buildings where objects are often hidden behind walls). Other viewpoints may not see performance benefits because
there are not many objects to cull (eg. places with wide open areas such as an arena). Made with love by the Engine team Please let us know if you experience any issues with Occlusion Culling while testing in Studio Beta. For instance, please report if you notice your experience runs slower on test devices, if some objects don’t appear, or if you see
objects “blink” in and out. Providing example RBXL files are the most helpful to help us fix issues quickly. 973 Likes This topic was automatically opened after 10 minutes. This might truly be one of, if not the best, features added to Roblox. 247 Likes FINALLY!! very good work engine team! I cant wait to experiment with the performance increases
from this early implementation 101 Likes Very nice to see this in ROBLOX! 48 Likes When will this feature arrive for viewport frames/if it’s ever planned? 45 Likes ROBLOX THIS IS A MOMENT IN HISTORY, THE REVOLUTIONARY CHANGE OF ROBLOX!, this is THE BEST UPDATE This year, ["M SO EXCITED TO SEE WHAT ROBLOX GAMES HAS
TO OFFER AND on top of all, IM EXTREMELY EXCITED FOR THE FPS IMPROVEMENTS IN OUR FUTURE GAMES! THANK YOU ROBLOX, I MEAN IT... THANK YOU! 71 Likes THIS IS HUGE!! Can’t wait to see how much this will improve performance! 30 Likes One of the greatest moments in Roblox’s history. When will we see this fully in
production? 16 Likes Amazing! Any idea when this will start rolling out to live servers? 14 Likes Nice I use unions for all my builds, so this is going to help out a lot! Thanks. I'd would also like to see an update to Robloxs lighting engine. 16 Likes This is an amazing update! As someone who works with high-density environments often, (convention
centers, underground facilities) this is going to save both my own and my players’ sanity while exploring even more detailed environments. I am also excited for the prospect of high-density environments become more accessible to mid and low-end devices as well! Overall amazing update. You mention releasing in production as soon as you can be
sure of its stability, how long do you estimate that will take? Before 2025? 18 Likes Amazing update, much much needed! Thank you 15 Likes Places like mine where we have a LOT of cramped up fully opaque parts that is very strenous to optimise it more than it already has been, ESPECIALLY with Future Lighting. Will benefit greatly from this. My
games (in studio) have seen a 3x performance increase from this update, and I am excited to see how this transfers for mobile. I wish this was live in my games already lol 19 Likes LightBeamRays: When profiling your experience, make sure to disable the Occlusion Culling Studio Beta (Files > Beta Features > Occlusion Culling) if you’d like your
profiling data to reflect what your users would see in production. what does this mean, profling our experience? if its not enabled on the client then how could it affect profiling with it enabled or disabled? 12 Likes ive need this for so long, props to the engineering team 11 Likes Please add support for terrain. It’s a big performance hurdle. I think this
could help massively. 41 Likes Fire feature. When is the release? 14 Likes Page 2 LightBeamRays: Occlusion Culling only works on meshes and parts (excluding avatars) for now. What counts as an avatar in this context? My game uses custom characters using skinned MeshParts. Is an avatar defined based on if they are set as some player’s
Player.Character property? Or this this some special R6/R15/Humanoid edge-case where custom characters would be excluded? 19 Likes I've waited ages for this, probably one of the best optimizations in Roblox. There are so many games where tons of geometry and textures are being needlessly rendered. This will HUGELY benefit games with lots of
indoor areas, caves or busy and populated cities. This might also majorly benefit open-world games since everything that’s hidden behind a huge mountain doesn’t need to be rendered. I wonder what the performance improvements are going to be. 16 Likes This is insane. I learned how to do this in C++ last month. I'm so excited to see it used on
Roblox! 17 Likes omg this is amazing, imma test this rn 9 Likes Literally the best update on roblox 9 Likes if anybody knows just one question? when i enable the beta feature does it auotmatically enable the new update OR is there like a special property i have to change on the parts? 5 Likes Once you restart Studio, the update should automatically
be enabled. You shouldn’t have to enable a property on parts to activate the occlusion culling, since this is meant to prevent parts that aren’t visible from rendering. 6 Likes An absolutely amazing feature to have! Was wondering when this may be released since its announcement. Thank you! 6 Likes Can’t wait too see the performance improvements,
especially on large maps or games that really need the boost that this could bring! 6 Likes alright thanks i wasnt sure on it since i didnt realize when i was testing 5 Likes Before Occlusion Culling (our most dense scene): 3mil tris, depth draw count super high After Occlusion Culling: 372k tris, depth draw count super low 33 Likes And with this,
Roblox on mobile and old PCs just became a lot more playable. So for those who aren’t techs, here’s a simpler explanation: Imagine painting a scene with acrylic paint. However, you’re being told how to paint the scene blindly and have no reference art. The person describing the painting is describing every individual object in extreme detail. This
doesn’t prove a problem, but what does prove a problem is that the painter is describing details you're painting over. He’s describing furniture in a room, for example, but the viewpoint is not inside the room, you only get the barest glimpse of a couch by the time you paint the connecting wall, which hides a lot of the details you just painted. This is a
slow process, obviously. You're spending time painting things that just dissappear later. But, then Oclusion Culling happens. Suddenly, you are able to tell the person describing the painting to you, to avoid describing things you are painting over. Instead of hearing about the lovely floral design in the table next to the sofa, and each individual petal,
now you're only told about the little leaf hanging over the side of the sofa. You're completing the painting a lot faster because you no longer hear about stuff you shouldn’t need to paint. This matters more for older PCs, or smaller hardware like phones, where every draw cycle counts. It won’t make the game playable on Pentium PCs, but it will make a
lot of older Core 2 Duos able to run the game at a decent framerate once more. Especially because they aren’t painting that lovely ten thousand polygon count floral decoration that’s behind the wall. 34 Likes Will occlusion culling have the same issues streaming service has or will scripts and the physics engine still be able to address parts that are
culled? 16 Likes W, i actually cant wait for this next generation of roblox games, so much more performance will be able to open the window for more games with high quality graphics 8 Likes This is a rendering change only. Scripts and physics will have no issue. 11 Likes finally i can (hopefully) run games well on my awful computer when this fully
releases 6 Likes roblox, please delete AND DONT LISTEN TO all those angry voicemails i left on your machine. I love you baby I really mean it 14 Likes absolutely goated feature, will there be support for surfaceappearances using transparency? 16 Likes Oh, thank goodness. I often had to script mediocre occlusion culling but I'm glad to see a more
effective and convenient way to do this 6 Likes imdaros: When will this feature arrive for viewport frames/if it’s ever planned? Our top priority is to first release the current technology in a stable state to production, so that experiences can benefit from it as soon as possible. Then, we’re going to look into extending what object types can be
culled/occluders. The first objects we’d like to cover with an extension would be avatars. We’ll keep Viewport Frames in mind! We don’t have any timeline to share on extension of Occlusion Culling at this time. Lvie: Repro with special mesh blinking in and out specialmeshocclusionrepro.rbxl (55.4 KB) Thank you @LvieReal! Forwarding to our
engineering team and we’ll take a look. ANDRO: When will we see this fully in production? + @plaincamron666, @Astra X2, @evilforge We don’t have a date to share yet, but our engineers are actively working on getting it out as soon as we can and it is our top priority. gn2B: what does this mean, profling our experience? if its not enabled on the
client then how could it affect profiling with it enabled or disabled? Good catch! We meant when you’re profiling your experience in Studio. If you're profiling on Client directly, then you can disregard this warning (I will specify in the announcement). Zomebody: What counts as an avatar in this context? My game uses custom characters using skinned
MeshParts. Occlusion Culling cannot cull any objects that are Fast Clusters. Skinned MeshParts would therefore not get culled. BritishTrainspotter: will scripts and the physics engine still be able to address parts that are culled? Yes! You should not see any difference to your game’s behavior - physics and scripts should continue working as before! 27
Likes Page 3 Doesn’t seem to work on super huge maps Tried in team test and non-collab, didn’t work. Did try in a new baseplate and it seemed to have work there. 13 Likes Finally, real culling. Thank you Roblox Engineers. 8 Likes is there alot of terrain? since it only affects parts that arent visible and are being blocked i think but also remember this
is still in beta testing 3 Likes 6600+ draw total down to 600+ draw total, that is actually insane 7 Likes OH MY GOODNESS THIS IS PEAK Literally surpassed the unreliable remote event update in my eyes. 8 Likes Goated feature, thank you so much. Up next we need to be able to set custom reflection probes for the cube map interior reflections
PLEASE!! 6 Likes There are many instances where parts are not occluding parts (other neighboring parts) with no terrain in-between. We are aware from the OP’s post that terrain doesn’t get occluded, but what about parts behind the terrain? Wouldn’t those still be subjected to occlusion? Insight? @LightBeamRays 5 Likes Love you guys Game
changing right here 4 Likes Trusses are a little cooked. 31 Likes This is honestly huge! Such a W update. Do you guys have any ETA of when this would be released globally for the client as well? 3 Likes + @Seiiyo Would you be able to share a repro placefile with us, please? It can be this place you are testing with or another one in which you are able
to isolate the problem. That would be very helpful so we can dive into the issue and understand what is happening. Please feel free to share in private message if you prefer (to @LightBeamRays, @ProgramDude and @TigerRabbit2). 8 Likes Good catch! Thank you! Investigating... 7 Likes no way they’ll release this before '25, they will probably release
it in early spring or late winter hopefully 4 Likes Yes I will have our lead programmer @Seiiyo send you a message soon Thank you for the quick response. 3 Likes Seriously the greatest feature in like 4 years 4 Likes viewport frames?? how can you possibly use so many parts in a viewport 2 Likes Once terrain can occlude parts, its over. 8 Likes Nice
update but it seems like sometimes even while something is out of view it renders it. You can replicate this by creating 2 parts and just looking through one moving ur camera 3 Likes my game will certainly benefit from this as it contains dozens and dozens of meshes that often overlap from pre-gen. 5 Likes same sometimes applies to parts that are
located inside 2 Likes Page 4 funny how a feature that has been a gaming industry standard since the early 2000s getting added now but better late then never, W update thank you roblox 5 Likes I noticed that when meshparts are covering other meshparts the system breaks at around 150 studs away. However, at the same distance with a part
covering the meshpart the system works fine. Normal view with no part in the way: Wireframe at 150 studs away: Normal view with part in the way: Wireframe at 150 studs away with part in the way: Video showcasing occusion culling failing at distances past 150 studs when meshpart is covering other meshparts: //devforum-uploads.s3.dualstack.us-
east-2.amazonaws.com/uploads/original/5X/6/5/e/0/65e0788f15a8f5d2d0723f35049b4af943256715.mp4 9 Likes I've noticed the same issue but just on the baseplate seems to be a issue at certain camera anglse/positions 2 Likes There might be some small flaws that will be ironed out over time. But I do not care. Please make this available in live
servers ASAP!! 2 Likes Amazing! With this update, my laptop will no longer mimic the sound of an airplane, thank you! 6 Likes please allow certain parts and models, such as highlighted instances, to be exempt from this!!! if this is already in the works / implemented ignore this 2 Likes It’s honestly a great update! It’s nearly perfect for a city setting.
In my case, the only remaining thing this would need is culling terrain and skinned meshes (since my game’s map has large mountains and dense skinned foliage) 2 Likes TruestBlu: please allow certain parts and models, such as highlighted instances, to be exempt from this!!! What would this achieve in your case? It sounds like there’s a potential
issue you may be running into if something is culled with a highlight, that’ll be bad for things like seeing teammates (ik players aren’t culled yet) or objectives 1 Like Does the same happen with unions that have empty areas? 1 Like Objects with highlights are never culled it seems, this is actually kinda bad because it’s true weather highlights are set
to AlwaysOnTop or Occluded (It won’t cull objects with disabled highlights either). Though it probably doesn’t matter in practice because you’ll only ever have a max of 31 highlights in a scene. In general though, still an amazing update. Even in this first day of beta I've seen it work pretty much flawlessly in my scenes. This is definitely a great step
forward for Roblox! 6 Likes When will you add this? Root motion (Animation) Size bone (Animation) 3 Likes Amazing update; huge kudos to the team working on this. The amount of draw calls in the most dense scene in my game has been reduced by ~80%. It helps a lot that the majority of objects in my game are behind various walls and rooms. 2
Likes When I tried this I felt like it would have issues and stutter whenever it tries to occlude something sometimes. This is automatic occlusion though I thought this is going to be like SKIP and HINT from the Source Engine or something. Along with a property like Visible from Frames, but for EVERYTHING else 7 Likes This is a tricky limitation from
our system, but a known one Our algorithm doesn’t require any work from Creators, which means we do a number of calculations behind the scenes to identify what should be an occluder. These calculations can take time and because we don’t want Occlusion Culling to end up slowing down performance, we have included some safeguards in our
algorithm. Because of our safeguards and to avoid performance slow-downs, the wall made of many parts ends up not being considered as an occluder (we would have to identify each small parts individually as an occluder to compose the wall’s occlusion). On the other hand, the wall that is just one big part is easily caught by our algorithm well
before the safeguards kick in. This is a known limitation of our system at this time, but we are aware that it means some objects that are hidden could still get rendered at times. We are going to share more details about what are those safeguards and limitations in the future. 10 Likes As in... a new “Occluder” part property...? 7 Likes Very good!!
More optimizations allow more players and more detailed environments!! If something is culled with a highlight the highlight will still display from my testing HELL YEA, we needed this a lot, thank you so much, this and the VR Emulator are amazing updates! 1 Like Awesome. Don’t really have anything to complain. Something nice to get would be
maybe some sort of method to check whenever or not an instance is occluded. Maybe some sort of method to check if an instance would be occluded at a given CFrame from the perspective of another CFrame? Maybe im pushing my luck here a bit. Though how does this system work? Are the occlusion checks done on the CPU or GPU? And how much
time does it take to check a large scene with tons of parts? I'm asking because i wish to know if occlusion culling can end up offering no real performance benefits to even performance downgrades in CPU bottlenecked situations. I do wish there would be a way to disable it for developers (just in case it may or may not start tanking CPU performance
on low end systems). 2 Likes Page 5 lol. I love how the shadows keep rendering even if the part is hidden. 3 Likes i can not believe this is very Amazing W update roblox keep going engine team you are pushing roblox ! 1 Like With these updates, we are slowly getting to the point where we will be able to fully recreate Legacy/Voxel terrain again. 5
Likes Right behind the advanced graphics settings where they seperate render distance from shadows Or mouse side buttons being usable, whichever comes first 1 Like Absolutely beautiful. Well done, thank you. Really exciting change optimization wise, though is there going to be any sort of API related to culling. Probably gonna be left as a user-
controlled rendering setting incase it causes issues for some people My game will benefit well when terrain is used to occlude things behind it. There are many caves in the game: But is a great start! Thank you. 8 Likes This is working incredibly well in my very large game. Now testing with this on in studio uses less memory than the live game
without it. That’s literally insane. 2 Likes Decided to give this feature a try with Roblox’s space station showcase “beyond the dark”. Previously this showcase would absolutely chug / not run even on beefy PCs. I gave it a try with my mid-spec laptop, and it ran buttery smooth. Dynamic occlusion culling is insane! //devforum-uploads.s3.dualstack.us-
east-2.amazonaws.com/uploads/original/5X/b/5/3/4/b5342198f4ef9¢c9617194c47bd214940f53417ae.mp4 19 Likes I am actually surprised it took them this long to add such a simple optimization like this. Better late then never I guess. 1 Like It finally happened!!! One major question i’'ve got if you can answer, does this also mean minimum graphics
settings will be by default higher? For example at graphics level 1, further away objects would render? I love it sooooo much!!! These features will be tremendously helpful for developers who use low-spec devices! Shinray: standard since the early 2000s FxmboyStormie: I am actually surprised it took them this long This is fully dynamic and requires
no baking or work from Developers, completely different from the “standard” that’s been around for decades that was completely static and extremely approximate. Meanwhile, you can have objects cull other objects as they are moving around with this system. 14 Likes Roblox has officially peaked this is the best update since PBR 6 Likes That would
require additional checks in lighting system and just like light leaking, it would be super complicated This is fabulous, majestic, amazing, incredible; all of the adjectives I can’t even begin to list. This is the coming of a new era on Roblox where developers can create highly efficient (extremely) detailed games that don’t make people’s computers die
horribly. Hoping for the best for this beta and that it comes out soon. I know every game will benefit from this. 1 Like This is pretty massive, thank you so much! Something I found that might work for you is to put a part inside the terrain around your caves, because the terrain itself wont occlude the part inside of it, that part becomes the occluder
and can hide things. (Except the terrain itself, of course.) This is definitely hacky but as long as your game doesn’t rely on terrain destruction it should be fine I think! 3 Likes Page 6 For VR, and other camera related purposes, dual rendering in real time is a big required feature that is hard/impossible to achieve without viewport frames. 1 Like I was
creating a custom rendering system that used them, the problem was making my own Occlusion culling lol 3 Likes Insane update! This is the big one, folks. 9 Likes Woahhh this is soooo cool! I love this new feature! 1 Like This is the best roblox update, im bout to blow into confetti from how good this is, Roblox will finally run as fast as every other
engine out there, FPS will be boosted insanely high. Thank you roblox engineers who worked on this, I am gonna cry from how good this is, this is like actually the best roblox update this year and maybe in the entire history of roblox. Every single game will benefit from this, every single gamer will benefit from this, im crying. 4 Likes Fantastic, I've
seen some of the results compared to before and it’s staggering! Thanks for this! 1 Like Every people with poor devices will finally get to experience the improved performance! I hope to see this finally being added to every roblox clients including mobile. 3 Likes Will you also fix the issue someone mentioned about the shadows still appearing? A bug,
I've generated a 46x46x46 cube and this started occurring, it changes based on distance and sometimes freaks out. Well done! You've managed to confuse the Engine, haha! 1 Like LightBeamRays: the rendering of objects that are hidden behind other objects. It doesn’t require any work from you; the engine will automatically detect which objects
don’t need to be rendered. Any API methods to check if an object is rendered, can be rendered or is not rendered? 1 Like This feature is great, but it needs to give developers some options. Otherwise, after turning on this function, developers cannot decide whether the model will be eliminated, which will bring bad consequences. I don’t know how
this would be feasibly possible, though it is a Studio Beta after all. I've tested it with 16" 3 cubes before, worked perfectly, only “lag” was the generation of the cubes. Does this render only the faces that are facing your camera or does it render the entire part? 1 Like Hi there! The engine uses a heuristic to limit the number of occluders it considers.
This is what’s happening here. Hopefully, when wifeframe is disabled, everything looks correct! 4 Likes when this will get released, like future lighting performance on mid devices and low will be boosted, maybe not for ultra low end but yea Its nice to see Roblox finally implement features that should have been added years ago. This is possibly the
biggest one in terms of performance stuff 1 Like Cannot wait for this feature be rolled out for live servers! This was a much-needed change in terms of optimization especially as model quality gets higher and higher. Will this extend to Smooth Terrain too? 1 Like Truly one of the greatest cooks from the dev team 1 Like OH MY GOODNESS
GRACIOUS!! This is such a rad feature!! Excited to see some optimization like this! Page 7 Well... I guess this site ain’t completely hopeless huh? 1 Like Just from an openworld game developer! I wont have to make my own systems to deload objects:grin: Heres an issue btw. If a triangle clipping happens jt will lag out the occlusion culling really badly.
I will provide the example later. The biggest update to Roblox since Roblox Game changer 1 Like Thank you so much for this update! I will 100% use this feature throughout my games/projects. Ig Roblox finally responded after over 10 years... Not Bad, Not Bad! 5.5 mil triangles vs 570k 8 Likes This will have a huge performance boost. Thank you! 1
Like This is a feature that ever since it was announced in the roadmap, I have been waiting for. Glad to see it finally being implemented into studio. Looking forward to the full release! 1 Like Awesome! Thanks Engine team for such an amazing feature



